
User Manual
Version 4.0.10

Software
NCBridge



ii

Copyright

Copyright © 1999, 2000, 2001, 2002 by Network Computing Devices, Inc. (NCD). The information
contained in this document is subject to change without notice. Network Computing Devices, Inc. shall
not be liable for errors contained herein or for incidental or consequential damages in connection with
the furnishing, performance, or use of this material. This document contains information which is
protected by copyright. All rights are reserved. No part of this document may be photocopied,
reproduced, or translated to another language without the prior written consent of Network Computing
Devices, Inc.

Copyright © 1990, 1992, 1993, 1994, 1995, 1996 Tektronix, Inc. Wilsonville, Oregon.

Printed in the United States of America or the United Kingdom. All rights reserved. This document
may not be copied in whole or in part, or otherwise reproduced except as specifically permitted under
U.S. copyright law, without the prior written consent of Network Computing Devices, Inc., 350 North
Bernardo Avenue, Mountain View, CA 94043 USA.

Portions of the network computer source code are copyrighted © 1989 by Sun Microsystems, Inc. Sun
design patents pending in the U.S. and foreign countries. OPEN LOOK is a trademark of AT&T. Used
by written permission of the owners.

Portions of this NCBridge software copyright © 1984-95 Adobe Systems Incorporated. All rights
reserved.

Some fonts are copyrighted © 1986, 1985 by Bigelow & Holmes. Lucida is a registered trademark of
Bigelow & Holmes.

Trademarks

Network Computing Devices is a registered trademark of Network Computing Devices, Inc. WinDD,
NCBridge and Simultiple are trademarks of Network Computing Devices, Inc.

Ethernet is a trademark of Xerox Corporation; UNIX is a registered trademark of AT&T; DEC,
DECnet, DECwindows, ULTRIX, SCAMP, VMS, and VT are trademarks of Digital Equipment
Corporation; SPARCstation is a registered trademark of SPARC International, licensed exclusively to
Sun Microsystems, Inc.; Sun Microsystems, SunOS, NFS, Sun, Sun-3, Sun-4, and OpenWindows are
trademarks of Sun Microsystems, Inc.; OSF, OSF/Motif, and Motif are trademarks of Open Software
Foundation, Inc.; X and X Window System are trademarks of the Massachusetts Institute of
Technology. Hewlett-Packard, HP, and vue are trademarks of the Hewlett-Packard company. IBM and
SMIT are trademarks of International Business Machines. Silicon Graphics and IRIS are registered
trademarks and IRIX is a trademark of Silicon Graphics, Inc. OpenConnect is a registered trademark of
OpenConnect Systems, Inc. Other trade names used in this document are trademarks or registered
trademarks of the manufacturers or vendors of the associated products.

Microsoft, Windows NT and Windows95 are registered trademarks of Microsoft Corporation.

Adobe, Acrobat, Display PostScript, and ShowPS are trademarks of Adobe Systems Incorporated
which may be registered in certain jurisdictions.

Use of a term in this book should not be regarded as affecting the validity of any trademark or service
mark.



NCBridge User Manual iii

Certifications

UL 1950, CAN/CSA C22.2 No. 950, IEC 950, FCC Class A, EN55022 (class A), EN50082-1,
EN60950, C-Tick, VCCI, MPR II (monitors only), CE, Energy Star Compliant (both monitor and logic
unit).

Disclaimers

THE SOFTWARE PRODUCTS ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY
KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, NCD FURTHER
DISCLAIMS ALL WARRANTIES, INCLUDING WITHOUT LIMITATION, ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT OF THE USE OR PERFORMANCE
OF THE SOFTWARE PRODUCTS AND DOCUMENTATION REMAINS WITH THE END USER.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
NCD OR ITS SUPPLIERS BE LIABLE FOR ANY CONSEQUENTIAL, INCIDENTAL, DIRECT,
INDIRECT, SPECIAL, PUNITIVE, OR OTHER DAMAGES WHATSOEVER (INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS)
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCTS OR
DOCUMENTATION, EVEN IF NCD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION
OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE
ABOVE LIMITATION MAY NOT APPLY TO YOU.

Revisions

Revision history of this document:

Contact Information

Network Computing Devices, Inc.
301 Ravendale Drive
Mountain View, CA 94043 USA

1-800-800-9599 (USA and Canada)
1-503-431-8600
http://www.ncd.com

Part Number Revision Date Description

8800671
Production Documentation CDROM
8800673

May 5, 2000 NCBridge User Manual,
version 4.0, Rev. A.

Revised on NCD website May 15, 2002 version 4.0.10





NCBridge User Manual v

Contents 

Typographical Conventions .................................................................................................1-ix
Preface.................................................................................................................................1-ix

Network Computer Package .........................................................................................1-xi
Map to the NCBridge Documentation .................................................................................1-xii
Discontinued Software Features........................................................................................ 1-xiii

Chapter 1 A New Piece of Hardware
What is a Network Computer? ............................................................................................. 1-1
Why Use a Network Computer? .......................................................................................... 1-3
How Do You Use a Network Computer? ............................................................................. 1-4
Mouse Operations................................................................................................................ 1-5

Chapter 2 Operating the Network Computer
Powering On the Network Computer ................................................................................... 2-1
The Network Computer Boot Process ................................................................................. 2-2
Logging In to the Network Computer ................................................................................... 2-3

Logging In from the Root Weave .................................................................................. 2-4
Logging In with Client Launcher.................................................................................... 2-5
Logging In with HostMenu............................................................................................. 2-7
Logging In at a Login Prompt ...................................................................................... 2-10
Logging In with Telnet ................................................................................................. 2-12
Closing a Telnet Window ............................................................................................ 2-13
Logging In with Cterm ................................................................................................. 2-14
Closing a Cterm Window............................................................................................. 2-15
Logging In with the WinDD ICA Client ........................................................................ 2-16
Selecting a Host .......................................................................................................... 2-17
Closing a WinDD Session ........................................................................................... 2-21
Logging In with Serial Port 0 or 1 ................................................................................ 2-22
Closing a Serial Port Window...................................................................................... 2-22
Logging In with LAT .................................................................................................... 2-24
Closing a LAT Window................................................................................................ 2-25

Chapter 3 Using the Network Computer
X Window Software Components ........................................................................................ 3-2

Getting Unstuck............................................................................................................. 3-3
Window Managers ............................................................................................................... 3-5

Determining Whether a Window Manager is Running .................................................. 3-6
Starting a Window Manager.......................................................................................... 3-7
Using a Window Manager ............................................................................................. 3-8

Starting Sessions ............................................................................................................... 3-15
Running Clients.................................................................................................................. 3-16
Locking the Display............................................................................................................ 3-17
Local Floppy Manager Client for UNIX Hosts .................................................................... 3-18



Contents

vi NCBridge User Manual

Chapter 4 Local Browser Support
Launching and Exiting Local Netscape Browser ..................................................................4-1
WinDD ICA Client Plug-in for Web Browser.........................................................................4-2

Setting a Kiosk Browser to Start the WinDD Plug-in for .ica Files.................................4-3
Web Server Setup to Allow Application Launching .......................................................4-4

Creation of a Web Page Invoking a Windows Application ...................................................4-4
WinDD ICA Client Embedded Plug-in ..................................................................................4-5

Web Page......................................................................................................................4-5
ICA File..........................................................................................................................4-5
WinDD ICA Client Configuration GUI as Full-Screen Plug-In........................................4-7

Local Browser Kiosk Support .............................................................................................4-10
Browser-Related Features...........................................................................................4-10
Starting Netscape NC Navigator .................................................................................4-11
Configuring the Browser for Kiosks .............................................................................4-12
Displaying PDF Files Using the Local Browser ...........................................................4-17

Chapter 5 Using Advanced Features
Audio Player .........................................................................................................................5-3

Starting the Audio Player...............................................................................................5-4
Starting the Audio Player from the Remote Configuration File......................................5-5
Starting the Audio Player with xpsh...............................................................................5-5
Property Command Interface ........................................................................................5-7
Opening or Creating an Audio File ................................................................................5-9
Using TFTP Access.....................................................................................................5-10
Using NFS Access.......................................................................................................5-12
Using DAP Access ......................................................................................................5-14
Connecting External Audio Devices ............................................................................5-17
Audio Accessory Specifications for XP, NC200, and NC400 Series ...........................5-19
Audio Accessory Specifications for NC900 Series ......................................................5-20
Recording an Audio File ..............................................................................................5-21
Playing an Audio File...................................................................................................5-23
Audio File Information..................................................................................................5-24
Closing the Audio Player .............................................................................................5-24

Audio Mixer ........................................................................................................................5-25
Starting the Audio Mixer ..............................................................................................5-25
Using the Audio Mixer .................................................................................................5-26
Saving the Audio Mixer Level Settings ........................................................................5-27
Closing the Audio Mixer...............................................................................................5-27
Adjusting the Volume when Starting the Audio Server................................................5-27

Digital Video Player ............................................................................................................5-28
Starting the Video Player.............................................................................................5-29
Opening a Video File ...................................................................................................5-32
Using TFTP Access.....................................................................................................5-33
Using NFS Access.......................................................................................................5-34



Contents

NCBridge User Manual vii

Using DAP Access ...................................................................................................... 5-36
Playing a Video File .................................................................................................... 5-38
Fast Forwarding and Rewinding ................................................................................. 5-39
Multicast ...................................................................................................................... 5-40
Closing the Video Player............................................................................................. 5-43

Analog Video Player .......................................................................................................... 5-44
Starting the Analog Video Player ................................................................................ 5-46
Connecting the Network Computer to an Analog Video Device.................................. 5-47
Using the Analog Video Player ................................................................................... 5-48
Closing the Analog Video Player................................................................................. 5-51

WinDD ICA Client .............................................................................................................. 5-52
Starting the Local WinDD ICA Client........................................................................... 5-52
Configuring your WinDD ICA Session from the Client Screen.................................... 5-57

Font Caching...................................................................................................................... 5-62
Printing Color Hardcopies .................................................................................................. 5-62

Printing from MWM ..................................................................................................... 5-63
Printing from the Command-Line ................................................................................ 5-63

TekLogin Local Client ........................................................................................................ 5-64
Starting TekLogin............................................................................................................... 5-64

xp.cnf Commands for TekLogin .................................................................................. 5-65
Configuring TekLogin Settings .................................................................................... 5-66
Security Between TekLogin and Setup....................................................................... 5-67

PPP Support ...................................................................................................................... 5-68
Before You Begin ........................................................................................................ 5-68
Configuring the Network Computer’s Serial Port ........................................................ 5-68
Configuring the Network Computer’s Session/PPP Settings ...................................... 5-72
Session Identification .................................................................................................. 5-73
Session Authentication................................................................................................ 5-73
Session Connection .................................................................................................... 5-75
Configuring the xp.cnf File for PPP............................................................................. 5-77
Final Network Computer Configuration Considerations .............................................. 5-78

PPP Connections............................................................................................................... 5-80
Connecting Via TekLogin ............................................................................................ 5-80
Connecting Via Setup ................................................................................................. 5-80
Connecting Via xpsh ................................................................................................... 5-84
Connecting Via the xp.cnf File .................................................................................... 5-84
Terminating PPP......................................................................................................... 5-84

Screen Saver Support........................................................................................................ 5-85
Starting the Screen Saver with the xp.cnf File ............................................................ 5-86

16-Bit True Color Support .................................................................................................. 5-87
24-Bit True Color Support .................................................................................................. 5-88
Simultiple Color for the NC900 .......................................................................................... 5-88
Web-Based Administrator .................................................................................................. 5-92

Implementation............................................................................................................ 5-92



Contents

viii NCBridge User Manual

To Access the Web-Based Administrator....................................................................5-92
Password.....................................................................................................................5-92

Seriald Provides Remote COM Support for Windows NT Applications..............................5-94
XDMCP_keepalive .............................................................................................................5-95

Implementation ............................................................................................................5-95
XP.cnf Commands Associated with xdm_keepalive....................................................5-96
Other Relevant Information .........................................................................................5-96

Termctrl Client ....................................................................................................................5-96
Termctrl Client Application...........................................................................................5-97
Using the Termctrl Client with the Launcher................................................................5-97

Chapter 6 Troubleshooting
Solving Power Problems ......................................................................................................6-1
Solving Boot Problems .........................................................................................................6-1
Solving Log in Problems.......................................................................................................6-2
The Console Window ...........................................................................................................6-3

Opening the Console Window .......................................................................................6-3
Using the Console Window ...........................................................................................6-4
Closing the Console Window.........................................................................................6-4

Remote Diagnostics .............................................................................................................6-5

Appendix A Special Keyboard Characters
Keyboard Charts ................................................................................................................. A-2
Entering North American Special Characters from International Keyboards ...................... A-8

Eurokey Support......................................................................................................... A-20
Eurokey Keysym Not Displayed Correctly......................................................................... A-22
Compose and Diacritical Sequences ................................................................................ A-22

Using the Diacritical Keys........................................................................................... A-24
Using the Compose Key............................................................................................. A-27
French Canadian Keyboard........................................................................................ A-36



NCBridge User Manual ix

Preface

Typographical Conventions
This manual uses the following typographical conventions:

This symbol indicates additional or background information for the particular
section. For example, the symbol is used in Chapter 2 to refer to the specific
commands that were set by your system administrator.

This symbol indicates a Launcher Menu selection. Depending on how your
account is set up, the Launcher may already be on your screen. If that is the case,
simply use the mouse to select an option. If the Launcher is not present, press
the Setup key or key sequence for your keyboard, as shown in Table 1.

Figure 1 on the next page illustrates the typographical conventions used in this
manual.

Preface

Table 1 Setup Key and Key Sequences

Keyboard Type Press

101/102 with Setup Setup key

101/102 with Pause SHIFT-Pause

Windows 95 SHIFT-Pause

Sun keyboard ALT-GRAPH-HELP or ALT-GRAPH-SETUP

3270 keyboard Right ALT-ExSel (The left ALT key does not work)

LK401 F3 key

UNIX keyboard Alt-Graph-HELP

Launcher
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Figure 1 Typographical Conventions
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Network Computer Package

This manual assumes you have installed your network computer according to the
included pictorial instructions. Your network computer has the following
components:
• The monitor is the screen where text and graphical information is displayed for

viewing. You can position the monitor to a comfortable viewing angle by tilting
and turning the monitor on its base. You can adjust the brightness and contrast
controls according to your preference. The controls are typically located on the
front or side of the monitor.

• The logic board is the controller inside your network computer that handles all
input and output communications and local processing.

• The keyboard is used as the primary method for entering alphanumeric data.
You can open the folding legs on the back of the keyboard to adjust the
keyboard angle. There are several different keyboards available, in many
different languages.

• The mouse is a device used to position a pointer appearing on the display in
order to access or select information. It is used as the primary method to move
about in a window manager or X window application, access menus, and select
options. Information on using the mouse and the mouse buttons is in the next
section of this chapter. Trackballs, touchscreens, and tablets can also be used as
pointing devices. Contact your system administrator for more information on
these devices.

• The communication port is a connector on the back of the cabinet housing your
network computer logic board. You connect your existing network cable to this
connector. A network cable must be set up for you by your system administra-
tor. This cable must be attached to your network computer in order to run.

• The NCBridge software is the network computer operating system and support
files that your system administrator must load and configure on a host computer
so your network computer can start up. If your network computer has an
optional flash ROM-based unit, the software may not be necessary.
The software is shipped on one or more CD-ROMs (also on magnetic tape for
VMS only). The disks or tapes and the documentation CD-ROM with various
manuals are shipped with the software in a separate package from the network
computer.
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Map to the NCBridge Documentation
Table 2 presents the contents of the manuals in the NCBridge documentation
set. These manuals are included on the Documentation CD-ROM.

The following documentation is available from Prentice-Hall:

• OSF/Motif User’s Guide ISBN 0-13-640509-6
This book presents Motif fundamentals.

Table 2 Available NCBridge Documentation

Manual Title Contents

NCBridge User Manual (This manual) Provides information on using the network 
computer with NCBridge software.

NCBridge Reference Manual Provides explanation of all NCBridge, Setup Main Menu, 
and Boot Monitor commands; plus Diagnostics, SNMP, 
Tek220 and Tek340 Emulators, Printing, Keyboard, 
CSLIP, and Scripting Language setup.

3270 User Manual Provides information on using the OpenConnect 3270 
emulator.

3270E/5250 User Manual Provides information on using the TEEMX 3270E/5250 
emulators.

NCBridge for UNIX Installation
and Configuration Manual

Provides information for installing NCBridge on a UNIX 
server and explains how to configure the network 
computer to download and execute the NCBridge 
software.

NCBridge for VMS Installation
and Configuration Manual

Provides information for installing NCBridge on a VAX 
VMS server and explains how to configure the network 
computer to download and execute the NCBridge 
software.

NCBridge for Windows NT
Installation and Configuration
Manual

Provides information for installing NCBridge on a 
Microsoft Windows NT server and explains how to 
configure the network computer to download and execute 
the NCBridge software.
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Discontinued Software Features
As NCD continues to add new features to make your NC hardware more 
valuable, we are forced to discontinue support for some of the older software 
features. The following is a list of features that were supported in previous 
NCBridge software releases, but are not supported in NCBridge 4.0.10.

• Navio browser

• Serial Xpress

• Local OpenLook Window Manager

• X Blink Extension

• Local 3179G Terminal Emulator

• Sun Audio Intercept Driver for Sun OS Environments

• XIE

• SIE

• Display PostScript and Acrobat Reader

• Flash Control Console Client

• Support for XP10 X terminals

• Support for XP330 X terminals

Serial Xpress

Serial Xpress enabled a NC or X terminal to connect to a remote host and 
transmit X Windows data over an RS-232 cable, or indirectly over a phone line 
using modems. The NC can now be connected using PPP over an RS-232 
connection, or connected to a DSL or ISDN connection using the standard 
network port to provided remote access to a host replacing the need for Serial 
Xpress.
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Local OpenLook Window Manager

The local OpenLook window manager (OLWM) is a window manager for the 
X Window System that implements parts of the OPEN LOOK graphical user 
interface, original developed by Sun Microsystems, Inc. This feature was 
previously provided to allow the OLWM program to run as a local client on the 
Network Computer (NC) to help off load server resources. The OLWM 
window manager is still supported on the NC’s under X Windows by simply 
running OLWM directly from a Sun host. OLWM is one of the standard 
window managers on Sun’s Workstation products running Solaris. NC’s still 
offer Local Motif (MWM) or (XPWM) window managers to use in place of 
OLWM where a local window manager is necessary.

Local 3179G Terminal Emulator

The local 3179G Terminal Emulation is no longer included. The local IBM 
3179G Terminal Emulation included IBM3720 support along with special IBM 
Graphics functions (GDDM), including support for older IBM host graphics 
applications. The NC still offers optional support for IBM3270 Emulation.
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Chapter 1
A New Piece of Hardware

A box labeled network computer has been delivered to your desk. Maybe it is a
replacement for your current personal computer, text-only (ASCII) terminal, or
workstation. Or, maybe it is to be used with a new system or application. Either
way, what is a network computer, and how is this new piece of hardware going
to make your job easier than the piece of hardware you already have?

What is a Network Computer?
The broad definition of a network computer (NC) is an internet-capable device
that supports the following features and formats:

• Minimum screen resolution of 640x480

• Pointing device (such as a mouse)

• Text input, audio output

• TCP/IP, FTP, NFS, UDP, Telnet

• SMTP, IMAP4, POP3 (e-mail protocols)

• JPEG, GIF, WAV, AU (multimedia file formats)

• Bootp

• HTML, HTTP (web protocols)

• Java application access

This definition includes everything from internet appliances, such as set-top
boxes that provide Internet access to your television, to powerful PC servers that
meet these requirements. Obviously, not every device that meets these
minimum requirements will be useful in a business environment.
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A network computer is a device-independent, network-transparent,
multi-tasking device connected to a host computer in a distributed computing
environment. If that makes sense, skip to Chapter 2, Operating the Network
Computer. Otherwise, please read this chapter to better understand what a
network computer is and how it works when you consider the components used
in the definition.

• Distributed computing allows you, from a single network computer, to take
advantage of all the resources available on multiple host computers. For
example, from your network computer you can access multiple hosts at the
same time, perhaps to run a spreadsheet from one computer, create a
document on a second, and receive mail from a third. A
distributed-computing environment is composed of host computers joined
together by a network. Figure 1-1 shows a typical distributed-computing
environment.

Figure 1-1 Typical Distributed-Computing Environment

Host A Host B Host C

Network Computer A Network Computer B

Network
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• Device-independent means that your network computer can open a session
on any host computer accessible to you, regardless of the computer’s
operating system. With your network computer, you can even have
simultaneous sessions running on totally different operating systems.

• Network-transparent means that your network computer can log in and run
applications (called clients) on one or more host computers over the network
just as if it were running locally on the computer itself. This requires a single
network connection cable, not one direct cable for each host you need to
access.

• Multi-tasking means that a client you start up in one window continues to run
(in its window) even while you are using a different window. Also, a window
can receive output even if it is completely hidden from view. Each window
essentially functions like an individual terminal or personal computer. For
you, the advantage is that you can have many different windows all on your
network computer display.

Why Use a Network Computer?
To better understand your network computer’s capabilities and advantages,
consider something possibly more familiar, such as a personal computer (PC).

• The display, keyboard, and mouse serve the same function on your network
computer as they do on a PC.

• Both devices require software in order to boot up and run applications. Here
are some differences:

– PC software is loaded onto a (local) disk right in the PC cabinet.

– Network computer software is loaded onto a (remote) disk on a central
computer.

The network computer advantage is that there is probably far more disk
space available to the central computer than to a PC. Also, there is
typically a support staff to load software and perform back ups on a central
system.

– PC software is typically licensed for a single user on a single PC.

– X applications run on a network and are licensed for multiple users.

Sharing software across the network is usually more cost effective than
buying and maintaining separate copies for each user.
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• Both devices require logic boards and storage devices (disks) to handle
information.

– For a PC, the boards and disk drives are within the cabinet. You can only
add a limited number of peripheral devices such as extra disks, printers,
or modems.

– For your network computer, some of the boards are inside the logic
module, but your network computer takes advantage of the main
computing boards, disk drives, and peripherals located on one or more
remote computers.

This is one of the key advantages of a distributed-computing environment.
Computing power, storage, and access to peripheral devices like printers
can be shared to maximize their use, and provide users with more
flexibility. It is also far easier to share information with other users.

How Do You Use a Network Computer?
1. Unpack your network computer according to the pictorial instructions on the

network computer shipping box.

2. Connect the keyboard, mouse, cords, and cables as shown in the pictorial
physical installation guide included in the network computer box.

3. Verify with your system administrator that the software to support your
network computer has been installed on a computer. Ask your administrator
if you need specific booting information.

4. Power on your network computer and log in. Chapter 2, Operating the
Network Computer details these topics.

5. Run your applications. Chapter 3, Using the Network Computer describes
what to do to get started.
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Mouse Operations
The following list presents and explains the terms related to mouse operations
that are used in this manual.

Button (on the display) A small display box within the borders of a window,
or inside a dialog box. Generally, clicking on a button
activates a function or performs some action.

Button (on the mouse) The three buttons on the top of the mouse. Table 1-1
shows the factory configuration of the buttons.

Table 1-1 Mouse Button Configuration

Clicking Quickly pressing and releasing a mouse button (without
moving the pointer) to select an object on the display screen
or initiate a command.

Dialog Box A box where you choose options and enter information. Use
the mouse to move from field to field, click on buttons and
position the text cursor. Use the keyboard to enter
information in a dialog box.

Dragging Pressing and holding down the Select mouse button while
moving the pointer.

Moving Using a mouse to change the location of the pointer on the
display screen.

Pointer An arrow on the display screen indicating the current cursor
position for selecting or clicking.

Pointing Using a mouse to position the pointer (such as an "x" or "↑"
symbol on the screen) on an object on the display screen.

Releasing Releasing (lifting your finger) from a mouse button to
complete a dragging action.

Button Name In Manual 3-button Mouse Selection

Select Left button

Menu Middle button

Custom Right button
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Chapter 2
Operating the Network Computer

Powering On the Network Computer
The first step is to power on your network computer. For network computer
models with a separate logic module, power on both the display and the logic
module. Figure 2-1 illustrates the location of the power switch for the NC900
series base.

Figure 2-1 Power Switch Location for NC900 Series

If the network computer does not power on, refer to Chapter 6, Troubleshooting
for troubleshooting information.

Power Switch
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The Network Computer Boot Process
When your network computer is powered on, it automatically begins booting.
Booting means your network computer is locating and reading its start-up files.
The boot screen shown in Figure 2-2 appears on your display as the network
computer is booting.

Figure 2-2 Network Computer Boot Screen

During a normal boot, the network computer successfully locates and begins to
read the boot files and the Percent of File Loaded slide bar appears on the boot
screen. During a boot, pressing any key on the keyboard halts the boot process.
Do not halt the boot unless directed by your system administrator.

If the slide bar does not appear, or, if your network computer displays a BOOT>
prompt, the boot has halted. To try the boot again, type b and press Enter.

If the boot fails again, call your system administrator or refer to Chapter 6,
Troubleshooting for more information. To help troubleshoot the boot problem,
write down any messages that were displayed.

[ ] 100%0%Amount of System Loaded:

Boot Monitor V9.0 

Attempting to boot with TFTP...

Requesting file ´/tftpboot/tekxp/boot/os.900´ from IP host 128.07.60.01

IADDR=
IHOST=
IMASK=
IGATE=
BPATH=

128.07.60.30
128.07.60.01
255.255.255.0
128.07.60.100
/tftpboot/tekxp/boot/os.900

DNODE=
BMETHOD=
BDELAY=
BAFROM=

0.0
TFTP
DISABLED
NVRAM

Ethernet     00:00:A7:02:9D:59 

8049-135

40960 Kbytes memory installed
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Your network computer is attempting to boot from the network or from an
optional Flash memory or ROM board (read only memory). You can tell how
your network computer is trying to boot by looking at the Boot Method
(BMETHOD=) status line on the boot screen. Possible values are ROM, TFTP,
NFS, or MOP.

Logging In to the Network Computer
The next step depends on the way your system administrator sets up the
network computer software on the host computer. Each login method is
illustrated and described in the following sections to help you identify your
login method.

After your network computer completes the boot process, one of these should
appear on your monitor:

• Gray pattern (called the root weave) with an X cursor (shown on page 2-4)

• Client Launcher (page 2-5)

• HostMenu (page 2-7)

• Login window prompt (page 2-10)

• Telnet window (page 2-12)

• Cterm window (page 2-14)

• WinDD (page 2-16)

• Serial Port Window (page 2-22)

• LAT Window (page 2-24)

If you cannot log in, refer to Chapter 6, Troubleshooting for troubleshooting
information.

The login method is determined by the Host Connect Method command. This
command is set by the system administrator in the remote configuration file or
through Setup on the network computer.
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Logging In from the Root Weave
The root weave is a gray, patterned screen available on all network computers.
When the network computer is ready for input, an X-shaped cursor appears on
the screen. A network computer with the root weave and cursor is illustrated in
Figure 2-3.

Figure 2-3 Root Weave with X Cursor

To log in from the root weave, you need to manually start the Client Launcher.

Press Setup or a key combination, depending on the keyboard type (see
Table 1, Setup Key and Key Sequences,on page ix), to bring up the Client
Launcher. Refer to Logging In with Client Launcher on page 2-5.

X

Launcher
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Logging In with Client Launcher
The Client Launcher starts the local client you select from a menu. An arrow to
the right of an entry indicates a submenu. In Figure 2-4, selecting Host
Connections displays a submenu listing available host connections, such as
Telnet or Cterm.

Your system administrator configures the Client Launcher to include the local
clients you use most often. (Refer to your NCD NCBridge Installation and
Configuration manual for details on defining the Client Launcher menu.) The
Client Launcher on your network computer may list different clients and
submenus than those that appear in Figure 2-4.

Figure 2-4 Client Launcher Menu

Use one of these methods to start a client from the Client Launcher:

• Position the pointer on the client name and click the Select mouse button.

• Position the pointer on the option to display the submenu. Position the
pointer on the client name and click the Select mouse button.

If using Client Launcher to open a host connection, see the applicable section:

• Logging In with HostMenu on page 2-7

• Logging In with Telnet on page 2-12

• Logging In with Cterm on page 2-14

• Logging In with the WinDD ICA Client on page 2-16

• Logging In with LAT on page 2-24
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The Client Launcher appears automatically if it is specified in the remote
configuration file. The applicable command is start (set to LAUNCHER).
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Logging In with HostMenu
HostMenu is a window showing a list of host computer names and network
addresses. Figure 2-5 shows a sample HostMenu.

Notice the list buttons across the top (for example, XDMCP and VMS TDEnet).
These buttons determine which type of log in list is displayed. The button
pressed in indicates which list is currently displayed.

If there are more host names than can fit on one screen, use the mouse to scroll
through the host names. If your host does not appear on the list, try clicking the
Update button or click one of the list choice buttons to display a different list.
If it still does not appear, contact your system administrator.

Figure 2-5 Example HostMenu

To log in with HostMenu using either the mouse or the keyboard:
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• Using the mouse, position the pointer on a host computer where you have a
login account. If your host is not displayed, try the Update button or look for
your host on one of the other lists (change lists by clicking one of the list
buttons across the top).

• Click the Select button (left mouse button) to connect to the host.

• Using the keyboard, enter the host’s name or address in the Host text box and
press Enter. If connecting to a LAT host, enter the Node’s name or address
in the Node Name text box, and the Service name in the Service Name text
box. Use the keys listed in Table 2-1 to edit and move around the HostMenu.

Table 2-1 Keyboard Interface for HostMenu

After selecting a log in host, some type of screen with a Login: prompt is
displayed. If you selected the wrong host, press Ctrl–c to close the login box
without logging in to the specified host. Depending on your log-in method,
another action may be required. For example, if Telnet was the log-in method,
type exit to log out.

• At the Login: prompt, type your user name and press Enter.

• At the Password: prompt, type your user password and press Enter.

To: Press:

Clear the contents of a text box Control–u keys

Move among the text boxes Tab key

Move to the first host in the list of
hosts

Home key

Move to the last host in the list of hosts End key

Move to a specific host in the list of
hosts

The first few letters of the hostname,
or if using LAT, the first few letters
of the service name

Page up and down through the list of
hosts

PgUp and PgDn keys
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For more information, see the applicable section:

• Logging In at a Login Prompt on page 2-10

• Logging In with Telnet on page 2-12

• Logging In with Cterm on page 2-14

• Logging In with the WinDD ICA Client on page 2-16

• Logging In with Serial Port 0 or 1 on page 2-22

• Logging In with LAT on page 2-24

Continue with Chapter 3, Using the Network Computer.

HostMenu appears automatically if it is set up as the connection method
through the remote configuration file or through Setup. The applicable
commands are Host Connect Method (set to HostMenu) and Default Host
List which determines the list that is initially displayed.
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Logging In at a Login Prompt
If your system administrator has set up your network computer to directly log
in to a specific host, some type of welcome screen with a login prompt is
displayed. A welcome screen is also displayed for programs like HostMenu
after a connection is made. Sample login screens for the UNIX host oregon and
the VMS host IDAHO are illustrated in Figure 2-6 and Figure 2-7.

Figure 2-6 Example UNIX Login Screen

Figure 2-7 Example VMS Login Screen

Welcome to oregon

Login:

Password:

Start Session on IDAHO

Username

ClearOK

Password
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To log in:

1. At the Login: or Username: prompt, type your user name and press Enter.

2. At the Password: prompt, type your user password and press Enter.

Continue with Chapter 3, Using the Network Computer.

Direct connections are specified by your system administrator through the
remote configuration file or through Setup. The applicable commands for
UNIX systems are Host Connect Method (XDMCP Direct) and XDMCP
Server (set to your host). The applicable commands for VMS systems are Host
Connect Method (set to VMS), VMS Autologin Transport (set to TDEnet),
and VMS Autologin TDEnet Host (set to your host).

For additional information, refer to XDMCP_keepalive on page 5-95 of this
manual.
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Logging In with Telnet
There are two ways to log in through Telnet, depending on whether your system
administrator specified a default Telnet host for your network computer. If your
network computer displays a Telnet> prompt like Figure 2-8, a default host
has not been specified. In this case, you must open a connection before you can
log in to the host.

Figure 2-8 Telnet Window Waiting for an Open Command

To open a connection to your host computer:

1. Use the mouse to position the pointer in the Telnet window. You can type h
and press Enter to see a list of Telnet commands.

2. Type:
Telnet> open hostname

where hostname is the name or network address of the host.

Figure 2-9 Telnet Open Command

Telnet>

Telnet> open oregon
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Once a connection is made (Figure 2-10), either automatically or with the open
command, you can log in:

1. Type your user name at the login: prompt and press Enter.

2. Type your password at the password: prompt and press Enter.

Figure 2-10 Telnet Window With a Host Connection

Continue with Chapter 3, Using the Network Computer.

Telnet connection and default Telnet host are specified by the system
administrator through the remote configuration file or through Setup. The
applicable commands are Host Connect Method (set to Telnet) and Default
Telnet Host (set to your host name or address).

Closing a Telnet Window
Press Ctrl–d at the login: prompt to return to the Telnet> prompt without
logging in to the computer.

To close the Telnet window from the Telnet> prompt, type quit and press
Enter.

Connected to 128.07.60.01.
Escape character is ‘^]’

login:

Trying...
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Logging In with Cterm
There are two ways to log in through Cterm, depending on whether your system
administrator specified a default Cterm host for your network computer. If your
network computer displays an NSH> or CTERM> prompt like Figure 2-11, a
default host has not been specified. In this case, you must specify a connection
before you can log in to the host.

Figure 2-11 Cterm Window Waiting for a Set Host Command

To open a connection to your computer:

1. Use the mouse to position the pointer in the Cterm window. You can type
help and press Enter to see a list of Cterm commands.

2. Type:
CTERM> sethost hostname

where hostname is the node address of the host.

Figure 2-12 Cterm Set Host Command

CTERM>

CTERM> sethost 11.10
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Once a connection is made (Figure 2-13), either automatically or with the
sethost command, you can log in:

1. Type your user name at the Username: prompt and press Enter.

2. Type your password at the Password: prompt and press Enter.

Figure 2-13 Cterm Window With a Host Connection

Continue with Chapter 3, Using the Network Computer.

Cterm connection and default Cterm host are specified by your system
administrator through the remote configuration file or through Setup. The
applicable commands are Host Connect Method (set to Cterm) and Default
Cterm Host (set to your host address).

Closing a Cterm Window
If you are at the Username: prompt and do not want to log in to the host, wait
until the network connection times out and closes. A message appears on the
screen when the connection closes. Typically it takes 60 seconds to time out.

To close the Cterm window from the NSH> or CTERM> prompt, type quit or
exit and press Enter.

Welcome to VAX/VMS V5.5

Username:

connected to host 11.10
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Logging In with the WinDD ICA Client
The WinDD Client screen shown in Figure 2-14 has three areas for server
information:

• The Server Browsing window (a frame containing a scrolling list).

• The Application Server input field.

• The Console window.

The Server Browsing window contains a list of servers that is automatically
generated, as set up by your system administrator. You must connect to a server
before you can log in.

Figure 2-14 WinDD ICA Client Screen

Refresh
button

Clear

button
Dialog

Server

window
Browsing

Server
input field

Console
window
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There are two buttons on the WinDD ICA Client screen, a Refresh button for
the list of application servers in the top frame and the Clear Dialog button to
clear the lower frame.

Note: Additional WinDD information can be found in the topic,
WinDD ICA Client on page 5-52 of Chapter 5, Using
Advanced Features.

Logging in With the WinDD ICA Client

From the WinDD ICA Client screen (Figure 2-14) you must indicate the server
you want to connect to before you can log onto the server. There are two ways
to do this:

• By selecting one of the servers listed in the Browsing window (simply click
on its name.)

• By entering the name of the server you want in the Server Input field.

Selecting a Host
There are two ways to select a host server, through ICA broadcast browsing or
by command line entry. Select one of the multi-user Windows NT servers
(application servers) listed in the top frame of the WinDD clients window. (See
Figure 2-14.)

ICA Broadcast Browsing

The ICA Broadcast Browser automatically builds a list of the available
Windows NT servers on the user’s network. This allows you to select a server
from the list of multi-user Windows NT servers—you want a server that can
provide good performance; usually the one with the lightest load.
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Remote Configuration or Command Line Selection

Remote Configuration method. If the server you want to use is listed (this
means it has been defined for you by your system administrator), you can
simply select it from the WinDD ICA client screen.

If you want to access an application server that is not listed, enter the server’s
name or its address in the Application Server input field and press Enter.

Next, the software generates a list and places it above the current list. The top
list, called the Application Server list, is separated from the other servers in the
list by a ===== line.

Command Line Selection. If you start WinDD using xpsh, you can use
options on the command line to specify a server you want to access. There are
a number of options for this; several of them (–c, –e, –ne, and –h) are explained
here:

Use the –h option to add a named application server to the Application Server
list. For example, to add the name of a server in the list, enter:

–h BVPLAT1

(To add more than one server at a time to the list, put a space between their
names.)

Use the –c option to auto-connect to the first server in the Application Server
list. If there are no servers in this list, this option is ignored and the software
displays the client window.

Use the –e option to enable the Application Server edit field window. This
makes it possible for users to add servers to the Application Server list.

Use the –ne option to disable the Application Server edit field window. This
means users cannot add servers to the Application Server list.

The system administrator specifies the WinDD connection, default WinDD
host, and Server entries through the remote configuration file or through Setup.
The applicable commands are Host Connect Method (set to WinDD), Default
Windows NT Server Host (set to your default server address), WinDD Menu
Entry (lists Windows NT servers for HostMenu), and WinDD Host Entry
(lists additional Windows NT servers for the WinDD client screen).
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Setting the WinDD Window Size

From the WinDD ICA client screen, you can easily change your session
attributes before you connect to a multi-user Windows NT server.

The Configure button brings up the WinDD Configuration dialog illustrated in
Figure 2-15. The resolution determines the size and number of colors of the
WinDD window. The resolution must be selected prior to making a connection
to the application server and cannot be interactively changed until the
connection has been closed. The Configure button performs the same function
as the Options > Configure command in the pulldown menu.

Figure 2-15 WinDD Configuration Dialog
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Logging In

Once you have made a connection, press Ctrl-Alt-Del to bring up the log in
screen, shown below in Figure 2-16. If you want to specify a different server or
return to the Client screen for any reason, select Options > Server. The
Options > Server function switches between the Client screen and the Log in
screen after a server connection is made.

Figure 2-16 WinDD ICA Log In Screen

1. Enter your user name.

2. Use the mouse or Tab key to advance to the Password line.

3. Enter your password.

4. Press Enter or click OK.
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Closing a WinDD Session
For Windows NT 3.51 servers, close your Windows NT session as usual, by
closing each of your applications, then selecting File > Logoff from the
Program Manager.

On Windows NT 4.0 or later servers, close your Windows NT session by
closing each of your applications, then select Start > Logoff from the Program
Manager.

If auto reconnect is on, the system displays the WinDD log in screen. If auto
reconnect is off, the WinDD client screen appears. Select one of these methods
to close the WinDD session:

• Choose Options > Exit.

• Click the Exit WinDD button on the client screen.

• Hold Shift and Ctrl, then click the middle mouse button. Select Exit WinDD
from the menu. (This applies only if you still have a server connection.)

Note: Additional WinDD information can be found in the topic,
WinDD ICA Client on page 5-52, of Chapter 5, Using
Advanced Features.
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Logging In with Serial Port 0 or 1
There are several ways to connect to a host through the Serial Port window
shown in Figure 2-17. Check with your system administrator to find out which
options you can use on your particular network computer.

• Serial communications with no protocol.

Use Serial Port 0 or 1 depending on which port your serial cable is plugged into
on the back of your network computer logic module.

If you have problems establishing communications, contact your system
administrator.

Figure 2-17 Serial Port Window Waiting for Command

Closing a Serial Port Window
To close a Serial Port window without logging in, press Enter and then type ˜.
(tilde (˜.) followed by a period).
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Entering Serial Parameters with Setup

The parameters on the host computer must match the parameters of your
network computer’s serial ports in order for serial communications to work.
Your system administrator can set them up for you in the remote configuration
file, or tell you what parameters need to be set so you can enter them in Setup.

To verify or change your serial parameters:

1. Select Setup from the Client Launcher. If you need a refresher on the
terminology in these procedures, refer to Chapter 1, A New Piece of Hardware.

2. Drag on the Configuration Summaries menu and release on Peripheral Ports.

3. Determine if your cable is connected to Serial Port 0 or 1 by checking the
back of the integrated network computer or the separate logic module.

4. Verify the parameters for the port are set to the values obtained from your
system administrator. Change them if necessary.

5. Select the Return to Main Menu button.

6. Select the Save Current Settings button.

7. Select the Exit Setup button.

Serial Communications with No Protocol
From the Serial Port window pictured in Figure 2-17:

1. Position the mouse pointer in the Serial Port window.

2. If you are using a modem, type your dialing command, which is similar to
this: (Refer to your modem manual.)

atdt phone_number

3. Press Enter to bring up a Login: prompt.

4. Type your user name and press Enter to bring up the Password: prompt.

5. Type your password and press Enter.

Continue with Chapter 3, Using the Network Computer.

Serial Port connection is specified by the system administrator through the
remote configuration file or through Setup. The applicable command is Host
Connect Method (set to Serial Port 0 or 1).

Serial Communication via PPP
For communication using Point-to-Point Protocol (PPP), see the PPP support
information in PPP Support on page 5-68.

Launcher
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Logging In with LAT
If your network computer displays a LAT> prompt like Figure 2-18, you are set
up to log in through a Local Area Transport supported in a DECnet
environment. To login, you must connect to a LAT service.

Figure 2-18 LAT Window Waiting for a Connect Command

To connect to a service:

1. Use the mouse to position the pointer in the LAT window. You can type help
and press Enter to see a list of LAT commands.

2. Type:
LAT> services

to see a list of available services.

3. Type:
LAT> connect service

where service is the name of a valid service.

Figure 2-19 LAT Connect Command

LAT>

LAT> connect service
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If it is a password protected service, enter the password at the Password:
prompt. You have up to three tries to enter the password before the connection
attempt fails.

Once a connection is made (Figure 2-20) you can log in:

1. Type your user name at the Username: prompt and press Enter.

2. Type your password at the Password: prompt and press Enter.

Figure 2-20 LAT Window With a Service Connection

Continue with Chapter 3, Using the Network Computer.

LAT connection can be specified by the system administrator through the
remote configuration file or through Setup. The applicable command is Host
Connect Method (set to LAT).

Closing a LAT Window
If you are at the Username: prompt and do not want to log in to the host, wait
until the network connection times out and closes. A message appears on the
screen when the connection closes. Typically it takes 60 seconds to time out.

To close the LAT window from the LAT> prompt, type quit or exit and press
Enter.

Welcome to VAX/VMS 5.5

Username:
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Chapter 3
Using the Network Computer

What next? might be a more appropriate title for this chapter. There really is no
single answer to the What next? question. Your network computer is designed
to be as flexible as possible so it can be tailored to fit your needs and your
computing environment. This tailoring process is performed by your system
administrator, with help from the installation and reference manuals that are
included with the network computer software.

While it is not possible to explain step-by-step how to get started here, this
chapter does provide general information to help you figure out What next?
Typically, one of these scenarios occurs:

• A window manager starts automatically.

• A client starts automatically.

• Both a window manager and client start automatically.

• Nothing starts (leaving you to initiate an action).

The sections in this chapter contain information to help you identify what is
taking place on your network computer, and what choices you can make. These
topics are discussed:

• X Window Software Components

• Getting Unstuck

• Window Managers

• Sessions

• Running Clients

• Locking the Display

• Local Floppy Manager (LFM)
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X Window Software Components
Before diving into the details of the possible scenarios, an introduction to some
of the common software components and terminology will be helpful.
The X Window System is a windowing system developed to enhance the usability
of a host computer by utilizing an X server as a device independent interface
between the host computer and your network computer. This means that you can
run clients on computers made by different manufacturers, freeing you to focus
on your applications without worrying about computer differences. Another
advantage is that X is multi-tasking, so multiple applications can run
simultaneously in different windows.
The X server is the interface that translates client requests from your network
computer to the host computer. It also accepts input data from your mouse and
keyboard and generates the appropriate actions.
Windows are bounded areas displayed on your network computer screen that
determine how information is presented on the screen. They can contain text or
graphics (pictures, graphs, animated sequences) generated by your application
programs, such as word processors, or transaction processing software. The X
server controls what gets displayed inside each window. Information does not
spill over from one window to the next.
A Window Manager is a special program that runs on top of the X server and
provides an easy to use interface for you to run and work with your clients. These
items include (among others):
• Window title bars
• Scroll bars
• Manipulating windows (sizing, moving, iconifying, closing)
Those are the visible results of using a window manager. The invisible portions
may be even more important to you. These items include:
• Managing window communications to make sure the correct window

receives the correct information.
• Determining where your mouse pointer is positioned, so it correctly

interprets where you want it to read any input you generate.
Session Windows are various types of communication protocols to establish
communications between your network computer and one or more host
computers.
Clients are applications that run on an X server in a session window. Client means
that the application is typically subordinate to the window. If the window is
closed, the client also closes.
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Getting Unstuck
Occasionally something may go wrong and your network computer or a client
may get stuck or hang. Hang means the network computer or the client is not
responding to any input coming from you or being transmitted from the host.
This is often due to a busy network. There are three recommended ways to
attempt to restore communications:

• Reset the X Server.

• Reboot the network computer.

• If the keyboard is also locked up, power off on the network computer.

Resetting the X Server

This is the first method to try:

1. Select Setup from the Client Launcher.

2. Click the Reset Server button.

3. When prompted that this closes existing connections, click the OK
button.

The screen is blanked when the reset occurs. It may take a minute or two for the
server to reset. Be patient and wait. When the root weave or your login method
appears, log back in as usual. Refer to Chapter 2, Operating the Network
Computer if you need information on logging in to the computer.

Rebooting the Network Computer

Sometimes rebooting is necessary, even though it adds to the network load. Try
Resetting the X server before you reboot.

If Setup does not come up, or if resetting the server did not work, try rebooting
the network computer. Press the key sequence: Ctrl-Alt-Delete to reboot the
network computer. If the reboot is successful, the boot screen is displayed while
your network computer boots. Refer to Chapter 2, Operating the Network
Computer for more information on booting.

Powering Off the Logic Module (Base)

Note: Turning off the power is the last-resort method. Try the other
methods first, or call your system administrator for
assistance.

Launcher
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If neither resetting the server nor rebooting the network computer works, turn
the power off, then on with the power switch on your network computer logic
module.
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Window Managers
There are many different window managers available, but the concepts are
similar. Several examples of window managers are:

• Motif (also called MWM)

• HP VUE (for Hewlett-Packard hosts)

• DECWindows (DEC hosts)

• XpressWare Window Manager (XPWM)

Your system administrator sets up and configures your window manager.
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Determining Whether a Window Manager is Running
You can tell if a window manager is running by looking at the borders on an
open window. If you do not have an open window, select Setup from the Client
Launcher to display the Setup window. If a window manager is running, there
is a border around the window, along with a title bar and usually some
command buttons. Figure 3-1 illustrates a Telnet window with and without a
window manager running.

Figure 3-1 Determining Whether a Window Manager is Running

telnet>
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Starting a Window Manager
If your system administrator configured your environment to automatically
start a window manager, skip to the next section, Using a Window Manager.

Your system administrator must configure the window manager on your host
computer before it can be used. If your network computer has the local MWM
option, you can start it from Client Launcher. If the option does not appear, your
network computer does not have it. Contact your system administrator.

To start the local MWM or XPWM from the default Client Launcher:

1. Open the Window Managers submenu.

2. Select MWM or XPWM.

Note: If MWM is not available, or if you use another window
manager, call your system administrator. The command for
starting a window manager is specific to your host and
configuration.

Launcher
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Using a Window Manager
The examples in this section are based on Motif, a host independent window
manager included with your network computer software. Host independent
means that it runs on hosts from different operating systems, rather than a
proprietary manager such as HP VUE which is intended only for
Hewlett-Packard systems. Your windows may look and operate differently
from those described here because you are using a different window manager
or because your system administrator has customized your MWM settings.
Refer to your window manager documentation for more information.

Figure 3-2 shows a typical window and its standard elements. A window
usually has command buttons for menu access, and to minimize and maximize
the window. Try the various buttons displayed with your windows.

In addition to the window menu and buttons, there are typically pop-up menus
that you can access outside of a window. These menus are controlled by various
system files. To see if you have these pop-up menus:

1. Position the pointer outside of all windows.

2. Try pressing either the Select or Custom mouse buttons to see if a menu
appears. Information on the menu choices would be included in your window
manager or host documentation.
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Figure 3-2 Elements of a Window

These window manipulations (actions) are described in this section:

• Moving a window

• Resizing a window

• Raising a window

• Lowering a window

• Maximizing a window

• Iconifying a window

• Restoring an icon

• Moving an icon

Sample Window

Icon

Title BarWindow Menu Button

Maximize
Button

Minimize
Button

Window
Border

8049-126

Setup

Root Window
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Figure 3-3 shows how to move a window.

Figure 3-3 Moving a Window

You can move windows from one location to another on the display.

1. Position the pointer within the title bar or border of the window.

2. Drag the pointer. When you begin moving the window, the pointer changes
to a cross-arrow pointer and a window outline appears. As you move the
pointer, the outline tracks the movement. A small rectangle appears in the
center of the screen and displays the x and y coordinates of the window as
the window moves.

3. Once the window is in the desired location, release the mouse button. The
window appears in the new location and becomes the active window.

Figure 3-4 shows an alternate method for moving or resizing a window: Drag
on the Window Menu, release on Move, position the window outline (by
moving the mouse), and click a mouse button.

Figure 3-4 Resizing a Window



NCBridge User Manual 3-11

Many windows can be resized. The corners of the window border let you resize
the window in two directions, while the horizontal borders and vertical borders
let you resize the window in a single direction.

1. Position the pointer on the window border or resize corner controlling the
window side(s) you want to resize. The pointer changes to either an arrow
with a corner (for resizing two sides) or to an arrow with a perpendicular bar
(for resizing in one direction).

2. Drag the corner or window border in the direction desired. As you resize the
window, an image of the moving border(s) tracks the pointer movement.

3. Release the mouse button. The window appears in the new size.

Alternate method: Drag on the Window Menu, release on Size, position the
window outline (by moving the mouse), and click a mouse button.

Figure 3-5 shows how to raise a window to the foreground.

Figure 3-5 Raising a Window: Displaying a Window in Foreground

When you want to raise a window; that is, display the window in front of other
overlapping windows so you can see the entire window, follow these steps:

1. Position the pointer (cursor) anywhere in the window (except on a command
button).

2. Click the Select mouse button. Raising a window automatically makes that
window active. Windows cannot be raised from the Window Menu.

Note: There is an X feature called autoraise. If this feature is
configured for your window manager, windows are
automatically raised as soon as you position your mouse
pointer in the window.

Icons

X

Sample Window 1

Sample Window

Icons

X

Sample Window

Sample Window 1
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Figure 3-6 shows how to lower a window to the background.

Figure 3-6 Lowering a Window

To place a window behind overlapping windows:

1. Drag on the Window Menu in the window to lower.

2. Release on Lower.

Figure 3-7 shows how to maximize a window.

Figure 3-7 Maximizing a Window

A window can be maximized to take up the entire size of the display. Some clients
do not support maximized windows.

1. Click the Maximize button in the window you want to maximize.

2. To return the window to its original size, click the Maximize button again.

Alternate method: Drag on the Window Menu and release on Maximize.

Icons

X

Sample Window 1

Sample Window

Icons

X

Sample Window

Sample Window 1

Sample WindowIcons

X

Sample Window
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Figure 3-8 shows how to collapse a window down to an icon.

Figure 3-8 Iconifying a Window

Iconifying a window means to collapse it down to an icon, a small graphic
representation of the window. This helps you keep multiple windows organized
and easy to access. To iconify a window:

Click the Minimize button in the window you want to iconify.

Alternate method: Drag the Window Menu and release on Minimize.

MWM has a client called Icons. If this client is available, it provides a box to
hold and sort all of your icons.

Figure 3-9 illustrates how to restore an icon to a window.

Figure 3-9 Restoring an Icon

You can change an icon into a window whenever you want to view the window
contents or work in the window. To restore an icon:

Double-click the Select button on the icon you want to restore.

Alternate method: Click the icon once to display a pull-down menu, and then
click Restore.

Icons

X

Sample Window

Icons

X

Icons

X

Sample Window

Icons

X
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Figure 3-10 demonstrates how to move an icon.

Figure 3-10 Moving an Icon

To move an icon from one location on the display to another:

1. Drag the pointer on the icon you want to move. When you begin moving the
icon, the pointer changes to a cross-arrow and an icon outline appears.

As you move the pointer, the outline tracks the movement.

2. Once the icon is in the desired location, release the mouse button. The icon
appears in the new location.

Alternate method: Click the icon once to display a pull-down menu, click
Move, position the icon outline (by moving the mouse), and click a mouse
button.

Icons

X

Icons

X
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Starting Sessions
As presented in Logging In to the Network Computer in Chapter 2, there are
many different ways to establish communications with one or more host
computers. With a network computer you can have multiple sessions open and
running simultaneously. For example, you might open a word processor, copy
some text from a file, and paste it into window where you are composing some
electronic mail. Or, you might open a session into another host to check if a
customer order has been shipped. You can do all these kinds of tasks without
having to exit any open applications.

Before you start a session, you typically need to know the name or address of
the remote host. You can find this out by calling your system administrator.

There are different types of addresses based on the network protocol used at
your site. Internet protocol (IP) addresses (128.06.70.01 for example) are used
for networks running a protocol called TCP/IP. This is the most common
network for hosts running a UNIX operating system. Node numbers (11.10:: for
example) are used for networks running a protocol called DECnet. This is the
most common network for hosts running a VMS operating system.

There are two easy ways to start a new session from Client Launcher. If you
need a refresher on the terminology used in these procedures, refer back to
Chapter 1, A New Piece of Hardware. Use one of these methods:

1. Select HostMenu. When the HostMenu client appears, use the mouse to
select your host. Refer to Logging In to the Network Computer on page 2-3
for details.

Note: If you logged in with XDMCP, the XDMCP list is not
available on HostMenu. Only one XDMCP session can be
running.

2. Select a session from the Host Connections submenu:
Telnet (refer to Logging In with Telnet on page 2-12)
Console (refer to The Console Window on page 6-3)
Cterm (refer to Logging In with Cterm on page 2-14)
WinDD (refer to Logging In with the WinDD ICA Client on

page 2-16)
Serial Port 0 or 1 (refer to Logging In with Serial Port 0 or 1 on page 2-22)
LAT (refer to Logging In with LAT on page 2-24)
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Note: Grayed text indicates an option that is not enabled for your
particular network computer. If an option is not listed, it is not
available for your network computer model.

Running Clients
Clients refer to applications that your network computer accesses across the
network, such as a desktop publishing system, a computer-aided design
program, or an on-line transaction processing system. Your network computer
can access multiple clients simultaneously.

Your system administrator can set up your login files to automatically start one
or more clients each time you login. The other alternative is for you to start the
clients you need.

Typically you start clients from a session window or a command menu:

• From a session window, type the command to start your particular client and
press Enter. Instructions for starting clients are included with your
application documentation.

• If your host computer or window manager has command menus available,
there may be menu choices available to automatically start your applications.
If so:

– Position the pointer outside of a window.

– For MWM, you would press the Select mouse button and click on your
client. For other window managers, follow the instructions for menu and
item selection and select the client you want to run.

Refer to the documentation that came with your application for
application-specific operation and information.
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Locking the Display
You can lock your display and all open windows so that while away from your
desk, an unauthorized user cannot access the information on your display. The
xlock local client locks the keyboard only, or the keyboard and the display. You
can combine xlock with xautolock to lock your display after a specified time
idle. Xautolock uses the Xidel server extension to determine the time since
input last occurred. When that time reaches the specified “lockTime” then
xlock is invoked. If no “lockTime” is specified, the default is 5 minutes.

1. xlock can be started from the Client Launcher (select Lock Screen) or with
xpsh from the command prompt, as shown here:
xpsh –display nc_address:0 xlock –mode n

To determine the network computer address, select Setup from the Client
Launcher. Drag on Configuration Summaries and release on TCP/IP (for a
UNIX host) or TDEnet (for a VMS host). The address displays as the
network computer IP Address or the TDEnet Address.

The –mode n setting is optional. If set to –mode 1, xlock locks the keyboard
only. If set to –mode 0, xlock locks the keyboard and the screen. If a –mode
setting is not given, xlock locks the keyboard and the screen by default. If
you receive a “Command not found” message, have your system
administrator add xpsh to your path environment variable and try the xpsh
command again.

When xlock is started, the xlock window appears, asking for a password and
confirmation. Upon entering the password, a blank screen with a floating
lock appears. Pressing a key will prompt for a password. Only the correct
password re-activates the screen.

2. At the Password prompt, enter a password and press Enter.

3. At the Retype prompt, enter the password again and press Enter. This
verifies you have entered the password correctly. xlock remains in effect
until you re-enter the password. The password is valid until you reboot the
network computer or reset the server.

4. To unlock the display or keyboard, press any key for the xlock window. At
the Password prompt, enter the password.

Note: If you forget your password, you must reboot the network
computer or reset the server to unlock the display or
keyboard.
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Local Floppy Manager Client for UNIX Hosts
The Local Floppy Manager (LFM) client provides a Graphical User Interface
(GUI) for copying files between the local floppy drive attached to the network
computer via the parallel interface and a UNIX host server. The GUI provides
a point and click operation. The LFM client is available with NCBridge version
3.2 or higher.

The LFM client is compatible with both the current network computer product
and earlier NCs and X terminals. The compatible platforms are XP117C,
XP119C, XP119M, XP200, XP350, XP400, NC200, NC400, and NC900 series
products.

To start the LFM on a network computer, ensure that the floppy drive is
connected to the parallel port of the network computer and powered up. Once
done, then type these commands at the command-line prompt for an NC900
series product:

xpsh -display <ipaddr>:0 lfm.900

Example: xpsh -display 134.6.5.12:0 lfm.900

To start the LFM client on an XP series unit, type the following:
xpsh -display <ipaddr>:0 lfm.350

Example: xpsh -display 134.6.7.14:0 lfm.350

Once the client is properly executed, the local NC console window should
indicate that the following files, lfm.xxx and fdDrv.xxx, have been loaded. The
file name extensions (.xxx) vary according to the NC model, as shown in Table
3-1.

When the local floppy is first displayed, it has access to the local floppy drive
only. You must click on one of the A drive buttons and select NET. A window
displays as show in Figure 3-11. Each of the four entries (Host, User, Password,

Table 3-1 File Extensions For NC Models

Platform File Name Extension (.xxx)

NC900 series .900

NC200 and NC400 series .500

XP100, 200, 350, 400 .350
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Account) must be terminated with a carriage return at the end of the entry. The
account entry represents the path. If not entered, the user’s home path entry is
used.

Figure 3-11 Local Floppy Manager Screen
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The LFM Client Screen is shown in Figure 3-12.

Figure 3-12 Local Floppy Manager Client Screen

For more information, see the floppy disk section in the Field Kit Installation
Guide.
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Chapter 4
Local Browser Support

The NC Series network computer supports a local Netscape NC Navigator
browser. There are two versions of Netscape NC Navigator 4.06 provided on the
NCBridge media:

• Netscape

• Netscape_lite

The NCD version of Netscape 4.06 includes all features of the Netscape
Navigator 4 Solaris version. It requires a minimum of 48MB of memory to run
on the network computer. A total of 80MB is recommended for most Netscape
Navigator 4 applications, especially when Java applets are executed. The
Netscape_lite binary version of the browser includes all Netscape 4.06 features
except email and news.

Launching and Exiting Local Netscape Browser
The following feature is available for users of Netscape who start the browser
using the xpsh command.

To prevent file corruption in the event a user powers down the network
computer too quickly during a browser exit, a window pops up to remind the
user to wait until Netscape has finished saving files. The popup window appears
only if the environment variable PAUSE_FOR_EXIT has been set. This variable
can be set from xpsh using one of the following commands, depending on the
browser used:

xpsh -display NC_NAME:0 -xpenv “PAUSE_FOR_EXIT=1” -access xpsh netscape_lite

or

xpsh -display NC_NAME:0 -xpenv “PAUSE_FOR_EXIT=1” -access xpsh netscape

Even if this environment variable is not set, the browser saves files before
destroying the windows. Consequently, with NCBridge 3.2 or higher, the
windows will remain longer upon exit than in previous versions.
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WinDD ICA Client Plug-in for Web Browser 
The Netscape browser supports an ICA plug-in. This allows users to create a
web page that uses the WinDD ICA client to run Windows applications directly
within the browser.

For example, suppose your group of users on mixed UNIX and PC workstations
uses Microsoft Word to create and update documents. You might wish to have
a web page that lists all the documents created or supported by your group,
allowing the user to select a document and edit that document within the
browser. The user could create a web page that provides a Navigator or other
list of your documents, supports selection of a document, and initiates the
WinDD ICA client plug-in to open that document in Microsoft Word.

Netscape NC Navigator (4.06) is the supported browser.

Using the WinDD ICA client plug-in in a web page requires:

• Installation of NCBridge 4.1 (or higher) onto a UNIX host or NT PC (system
administrator).

• Web server setup to allow application launching based on file type (system
administrator).

• Creation of a web page invoking the WinDD ICA client and a Windows
application (user).

Installation of NCBridge on a UNIX or NT Server

The installation of NCBridge onto a UNIX or Windows NT host automatically
installs the Netscape NC Navigator browsers. Each browser is configured at
this time to define a MIME type/sub-type, application/x-ica which is
associated with the WinDD ICA client plug-in client provided with this release.
This association ensures that the browser knows to invoke the WinDD ICA
client upon trying to read a file of MIME type/sub-type application/x-ica.

Typically, to run the local browser from your network computer, the network
computer must be connected to the UNIX or Windows NT host on which
NCBridge was installed and the network computer must be authorized. Once
you are running the browser, you can check that the WinDD ICA client plug-in
is installed in the browser's plug-in table.
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Setting a Kiosk Browser to Start the WinDD Plug-in for .ica 
Files

To set a kiosk browser so it can initiate the WinDD plug-in for .ica files:

1. Use Options > GeneralPreferences > Helpers to bring up the table and
look for the plug-in listing.

2. Go to your internet browser and make the setting shown here:

3. Set the disk cache folder to /mem/cache as shown in the figure.

Note: Files will be saved to memory, but are lost when you exit the
browser.
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Web Server Setup to Allow Application Launching 
Note: This step is only required if you are creating a web page that

uses the WinDD ICA client plug-in as an embedded plug-in
(see the next section).

Basically, using the WinDD ICA client as an embedded plug-in of a web page
requires that you specify to the browser the data stream on which the WinDD
ICA client is to act (the ICA input file which specifies the Windows NT
Terminal Server host starting parameters).

The browser must be configured so that files with file extension ica are handled
by the WinDD ICA client plug-in. This is done by associating the file extension
ica with the MIME type/sub-type application/x-ica, which the browser already
knows (from install) will be handled by the WinDD ICA client plug-in.

This is done by including the following line in the UNIX browser setup file,
(usually named mime.types—your system administrator will know the location
and name of the mime.types file on your server):

application/x-ica ica

Creation of a Web Page Invoking a Windows 
Application 

Browser plug-ins can be “embedded” plug-ins, meaning that they appear as
visible, rectangular windows integrated into your web page, or they can be
“full-screen” plug-ins, which take over the entire current browser window to
display the plug-in contents.

Both the following methods of invoking the WinDD ICA client plug-in from a
web page for the local browser requires that you create a web page and an ICA
file from which the WinDD ICA client will take its starting parameters. Two
different methods to do this are described in the following sections.
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WinDD ICA Client Embedded Plug-in 
Web Page 

Specifying an embedded plug-in requires including the EMBED html tag in the
html source for the web page. An example follows:

<EMBED SRC=“http://www.NCD.com/word.ica” HEIGHT=640 WIDTH=480>

In this example, the EMBED tag format uses the keywords “EMBED”,
“SRC=”, “HEIGHT=”, and “WIDTH=”. The “SRC=” tag specifies the URL for
the file which is to be read as input to the WinDD ICA client plug-in. In this
example, the file word.ica is located in the web server's public root directory.
The “HEIGHT=” and “WIDTH=” parameters specify the dimensions of the
embedded application, in this case, the WinDD ICA client window dimensions.

ICA File
The data in the ICA file tells the WinDD ICA client which Windows NT
terminal server to connect to and which application to launch when connected
(for example, Microsoft Word). Make sure that the application you want to run
is installed on your Windows NT server.

You can use a simple text editor such as Notepad to create the ICA file. Put the
following information into the ICA file:

• The IP address or DNS name of the Windows NT server.

• The full path name of the program to be run in your WinDD ICA client
session. This information is optional. If you leave this information out of
your ICA file, a full WinDD client session will start Program Manager.

• The working directory (optional).

• The logon user name and password (optional).
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The following is an example ICA file. Lines preceded with “;” are comments to
explain the contents. Lines encased in “[ ]” are section headers.

-------------Sample ICA file--------------------

[ApplicationServers]

; The [ApplicationServers] section must contain as its value the name
; of the application server entry used to describe the connection. The
; entry is simply the name of the next section (the application section)
; followed by an equal sign.

; The value /name given (in this example, Access) will appear in the
; titlebar of the client window.

Access=

[Access]

; The [Application] section describes the attributes of the Access
; application entry.

; The application name in the square brackets must match the name
; given as the value to the [ApplicationServers] section above.

TransportDriver= TCP/IP

; This value must be “TCP/IP”

Address=206.103.132.12

; The Address value is the TCP/IP address of the Windows NT server.
; It can be either a DNS name or an IP address.

WinStationDriver=ICA 3.0

; This value must be “ICA3.0”

Username=JOE SCHUMAN

Domain=ABC

Password=000100

; The Username, Domain, and Password fields are optional. The
; Username is the user name of a valid WinDD ICA client user. The
; Domain is the Windows NT domain the user belongs to, and the
; Password is the logon password for the user. The password, if used,
; must be encrypted.

; To enter an encrypted password into the ICA file, use the WinFrame
; Client Remote Application Manager New Entry Wizard to create a
; remote application entry. When you are prompted for the username and
; password, enter the password that you want to use in the ICA file.
; Finish the New Entry wizard.

; Open the file APPSRV. INI in the Windows directory and locate the
; entry you just created. Copy the password value and paste it into
; your ICA file. Note that the APPSRV.INI file looks a lot like the ICA
; file you are creating.

; The ICA file is, in fact, a subset of the
; APPSRV.INI file. You can use the entries in this file to help you
; create new ICA files.
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InitialProgram=d:\word\msword.exe

;The InitialProgram value specifies the path, on the Windows NT server,
; of the application to be automatically launched when the
; connection is made. Include any command-line options.

WorkDirectory=d:\word

; The WorkDirectory is the directory that the application should use for
; its default directory.

ScreenPercent=75

; The ScreenPercent sets the horizontal and vertical pixel resolution
; based on client desktop size.

DesiredHRES=640

DesiredVRES=480

; Alternately, use either ScreenPercent or DesiredHRES and DesiredVRES
; to specify the size of the client window in pixel resolution.
; NOTE: If both ScreenPercent and DesiredHRES and DesiredVRES
; are specified, only ScreenPercent is used. ScreenPercent is not
; available with the WinFrame 1.6 Client, only the Web Client.

DesiredColor=2

; DesiredColor sets the color palette depth. Use “1” for 16-color and
; “2” for 256-color. The default is 2 (256-color).

[WFClient]

Version=2

; The WFClient section describes the WinFrame Client. Enter as shown.

----------------End sample ICA file-------------

WinDD ICA Client Configuration GUI as Full-Screen Plug-In 
NCD provides an HTML form and CGI script (Bourne shell) with the WinDD
ICA client plug-in binary. This example shows you a way to create a web page
such that the entire web page contents are a GUI form that configures a WinDD
ICA client session and brings up a user-specified Windows application using
the WinDD ICA client plug-in.

The form includes input areas for the Windows NT host name, user name,
domain, password, initial program path, and working directory path. Some, all,
or none of the input fields can be entered. The input fields correspond to the
WinDD ICA client command-line arguments. Input in a GUI field is the same
as starting the WinDD ICA client with that command-line parameter. An input
field with no input is the same as not using the command-line argument.

The form also contains a button to start the WinDD ICA client. This button
creates an ICA file whose contents are determined by the values you set in the
input fields of the form.



Chapter 4 Local Browser Support

4-8 NCBridge User Manual

The HTML form and CGI script can be found after Netscape installation at:
.../tekxp/examples/plugins/(windd.bsh, windd.htm)

Copy the CGI script to a CGI script directory on the web server host (example
path: X/Y/Z). Use the HTML form as the source for your web page. Open that
source and change the value of the ACTION field to be the path to the new
location X/Y/Z of the CGI script.

You could use the web page you just created to give your users an automatic
method of invoking Microsoft Word by specifying Word as the default initial
program in the HTML form.

Here is the HTML code for the WinDD ICA client configuration form:
-------------Sample HTML Code-------------------

<HTML>
<HEAD>
< TITLE>WinDD ICA client Configuration</TITLE>
<HEAD>
<BODY>
<H2>WinDD ICA client Configurationc/H2>
<! change the path below to your directory structure >
<FORM METHOD=“POST” ACTION=“/cgi-bin/windd.bsh”>
<PRE> WinDD host: <INPUT TYPE=“TEXT” NAME=“Address” SIZE=40>
Login username: <INPUT TYPE=“TEXT” NAME =“Username” SIZE=40>
Domain Name: <INPUT TYPE=“TEXT” NAME =“Domain” SIZE =40>
Password: <INPUT TYPE=“password” NAME =“Password” SIZE =40>
Initial Program: <INPUT TYPE=“TEXT” NAME=“InitialProgram”SIZE=40>
Work Directory:<INPUT TYPE=“TEXT” NAME =“Workdirectory” SIZE=40>
<P>
<INPUT TYPE=“submit” VALUE=“Start WinDD”>
<INPUT TYPE=“reset” VALUE=“CLEAR”>
<PRE>
<FORM>
<BODY>
<HTML>

----------End sample HTML-----------------------
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Here is the Bourne shell script that creates an ICA file for the WinDD ICA client to
read:
---------------Sample script--------------------

#!/bin/sh
#
# Use this script to see what comes back from a FORM submission
# with method=“GETf“
#
read my_data

echo Content-type: application/x-ica
#echo Content-type: text/plain
echo
my_data=`echo $my_data | tr '\015' \&`

my_data=`echo $my_data | sed -e 's/Address=&//g'`
my_data=`echo $my_data | sed -e 's/Domain=&//g'`
my_data=`echo $my_data | sed -e 's/Password=&//g'`
my_data=`echo $my_data | sed -e 's/InitialProgram=&//g'`
my_data=`echo $my_data | sed -e 's/Workdirectory=&//g'`
my_data=`echo $my_data | sed -e 's/Username=&//g'`
my_data=`echo $my_data | tr \+ '\ '`
my_data=`echo $my_data | sed -e 's/\%3A/:/g'`
my_data=`echo $my_data | sed -e 's/\%5C/\\\\/g'`

echo $my_data | awk -F\& '{ for( i=1; i < NF+1; ++i) print $i }'
echo

-------------End sample script------------------
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Local Browser Kiosk Support
The local browser kiosk mode provides:

• Simpler methods of launching the local browser.

• Local browser support in VAX VMS boot host environments.

• Support for a 16MB flash memory option on the NC200, NC400, and NC900
series.

Local browser kiosk support applies to all network computers that can run the
browser, including:

• XP100, XP200, XP300V, XP350, NC200, NC400, and NC900.

The browser is not available for:

• XP10, XP10T, XP20, XP100D, or XP330.

Although this section applies primarily to NC200, NC400, and NC900 network
computers with either the 12MB or 16MB flash card, you can still take
advantage of most of these features with older network computer models.

Browser-Related Features
Prior to the NCBridge 3.1 release, the only way to launch the browser was to
use the xpsh command from a host login account, using xpsh’s file access
mechanism to read and write browser preference settings and history data into
the user’s home directory. While this might remain the preferred method for
many users, there are some circumstances—for example, using a network
computer as an information kiosk—where it is either impossible or undesirable
to log in to launch a browser. To support using the browser in such an
environment, there are two other methods of launching the browser.

Due to xpsh limitations in VAX VMS environments, the browser would not run
when the network computer booted from a VMS host. With NCBridge 3.1 or
higher, it is possible to boot a network computer from a VMS host using the
MOP boot protocol and start the browser with the Launcher or the xp.cnf file.
When operating this way, the browser will use DAP file access to read the
configuration files from the .netscape directory for Netscape or Netscape_Lite
under the boot directory.
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The 12MB flash memory option in the NC200 and NC400 allows you to store
all the Netscape_Lite browser files in flash memory so that the network
computer can operate as a stand-alone kiosk. The 16MB flash memory option
allows you to store all of the full Netscape browser files in flash memory so that
the network computer can operate as a stand-alone kiosk. With the browser in
flash, the network computer doesn’t need a boot host, and users don’t need
login accounts. The network computer can be configured to start the browser
upon power-up and immediately connect to a web server home page.

Starting Netscape NC Navigator
Prior to the NCBridge 3.1 release, the only way to start the local browser was
with the xpsh command:

xpsh -access xpsh netscape_lite

With NCBridge 3.1 or higher, there are two other methods for starting the local
browser, the simplest being through the Launcher, as shown in Figure 4-1. A
default menu item for the Netscape_lite browser has been added at the top of
Launcher’s Host Connections pull-down menu. (See the NCBridge
Installation Manual for instructions on how to modify this menu.)

Figure 4-1 Starting the Netscape_lite Browser with a Launcher Pull-down Menu
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Another way to start the browser is to add a start command to your xp.cnf file.
The following are two example start commands that may be used to start the
two different binary versions of the browser:

start NETSCAPE YES

start NETSCAPE_LITE YES

Note: Only one version of the browser may be run at one time.

It is also possible to pass command-line parameters and environment variable
settings with this command. The following examples start the browser with a
default geometry and override the proxy auto configuration URL with a
different one:

start NETSCAPE YES -args “-geometry 860x900+80+60” -envs
“AUTOCONF_URL=http://proxy.mydomain.com”

start NETSCAPE_LITE YES -args “-geometry 860x900+80+60” -envs
“AUTOCONF_URL=http://proxy.mydomain.com”

Note that all the parameters must be specified on the same line in the xp.cnf file.

Configuring the Browser for Kiosks
An easy way to configure the browser for kiosk operation is to invoke it in
non-kiosk mode (with the xpsh command) and then make changes with the
Preferences menu. Once the browser is configured, copy the essential
configuration files from the .netscape for Netscape/Netscape_Lite created in
your home directory to the .netscape directory for Netscape/Netscape_Lite
under the boot directory. (Use the configuration files listed in Table 4-1,
Netscape Browser Configuration Files, on page 4-13 as a guide.) If you choose
this method to configure the browser, be aware that you may have to modify
some of the entries in the files, to remove references to .signature, .mailcap, or
other personal files. Sometimes you can make the necessary changes by editing
the configuration files directly, although these database files are not generally
editable.

Note: Netscape writes preferences to the preferences.js file, a
Javascipt file.
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Table 4-1 lists the Netscape browser configuration files and their purposes.

Because kiosk administrators don’t want their carefully configured browser
environments altered by casual users, browser configuration files in kiosk
mode, by default, are not writable. So users can change browser settings in the
Preferences menu, but the changes will not be saved. The same restriction
applies to bookmarks and history data. While this behavior may be desirable
when operating a kiosk, it means you’ll have an extra step when setting up the
browser for kiosk operation.

Table 4-1 Netscape Browser Configuration Files

File Description

config/plugins.tbl list of plug-ins to support

.netscape/bookmarks.html defaults for the “Bookmarks” menu

.netscape/cert7.db default SSL certificates database

.netscape/cookies default cookie database

.netscape/history.db default history menu database

.netscape/key3.db default encryption key database

.netscape/mailcap default helper applications

.netscape/mime.types default mime file extension/application bindings

.netscape/preferences.js default browser configuration preferences

usascii/app-defaults/Netscape X resource defaults for Netscape
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Environment Variables Used by the Browser

The Netscape browser uses certain environment variables for setting certain
parameters (see Table 4-2). The -envs parameter of the xp.cnf preload and
start commands can be used to alter the value of environment variables passed
into the browser..

Table 4-2 Browser Environment Variables

Environment variable Description

AUTOCONF_URL Sets the URL for obtaining the proxy auto
configuration file.

HOME Locates the .netscape configuration directory if
NULL kiosk mode settings are used.

NNTPSERVER Sets the default news server.

WWW_HOME Sets the default web page.
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Preferences File Entries

For Netscape browsers, it is generally best to create a .netscape/preferences file
by running the browser in non-kiosk mode and using the Preferences menu to
make changes. The resulting .netscape/preferences in your home directory can
then be copied to the .netscape directory in the boot directory. Sometimes it is
only necessary to make a minor change, in which case you might want to edit
the preferences file directly. Table 4-3 explains a few commonly edited items
in the preferences file.

Netscape browsers keep configuration information in a Javascript file called
preferences.js. This file is modified by the Netscape browser preference menu,
accessed after launching Netscape.

Note: To get updated browser configuration files onto flash, you’ll need
to reflash. See “Flashing the Local Browser into Memory” in
Chapter 2 of the NCBridge Reference Manual.

Table 4-3 Navigator Preferences

Preference name Description

HOME_DOCUMENT Sets the default document visited when the browser is
started.

PROXY_MODE Determines how proxy info is configured:

0: Proxies are not used.

1: Proxies are manually configured
(HTTP_PROXY, FTP_PROXY, etc.

2: Proxy autoconfig script is loaded from an
HTTP server.

PROXY_URL URL used for PROXY_MODE 2.

SHOW_MENUBAR Another item that can be used to limit what kiosk
users can do. When set to False, kiosk users
won’t be able to exit the browser.

SHOW_TOOLBAR When set to False, it turns off the icon buttons
along the top of the browser. This is useful for
restricting what users can do in a kiosk.
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Proxy Host Configuration

By default, the Netscape NC Navigator browser is configured to use the boot
host as an HTTP server that provides the proxy autoconfiguration file. (This is
the same file format used to configure standard Netscape browsers.) If you
receive an error pop-up when the browser is started in kiosk mode, it will be
necessary to change the proxy autoconfiguration setting.

When running in kiosk mode, the browser reads configuration files from the
.netscape directory under the boot directory. By default the .netscape directory
contains a preferences file with entries configured to get proxy configuration
information automatically from the boot host using this URL:

http://xp_boothost

With this configuration, the browser expects an HTTP server on the boot host
to return a proxy autoconfiguration file with an “application/
x-ns-proxy-autoconfig” MIME type, which is typically found on Netscape
HTTP servers.

The proxy host configuration can be changed by setting the AUTOCONF_URL
environment variable in the preload or start command –envs parameter, or by
editing the preferences file. (See Table 4-3, Navigator Preferences, on
page 4-15 for descriptions of the appropriate parameters.) Again, you may want
to generate the preferences file first by using the browser in non-kiosk mode,
then edit it directly with a text editor.

Forcing Kiosk Mode Operation

When started, the browser looks up the value of the HOME environment
variable to determine the path to its .netscape directory for Netscape. If the
HOME variable is not set, the browser assumes it has not been started with xpsh
and immediately enters kiosk mode, using the kiosk mode configuration
parameters to determine where to find a .netscape directory.

It is sometimes desirable to operate the browser in kiosk mode even when it is
started with xpsh. Add this line to your xp.cnf file to force the browser to
operate in kiosk mode:

parameter browser_kiosk_enable YES

Replacing YESwith NO does not force non-kiosk mode operation; rather, it tells
the browser to check the HOME environment variable to determine kiosk mode
operation.
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Displaying PDF Files Using the Local Browser
You can set up the local browser as a “helper application” so that when a user
clicks on a PDF file within the browser window, the file is displayed on the NC
screen using a host-based Adobe Acrobat Reader. To do this:

1. Load the Acrobat acroread binary on the host computer.

2. Place this line in the user’s .mailcap file in their home directory:
application/pdf; acread %s

When the browser gets a PDF file from a web server, it starts up the acroread
program on the host computer and feeds the PDF file to it. The PDF file is
displayed in a window on the NC screen.

The user also set up the “helper application” by starting the browser, as follows:

1. Navigate to the Edit > Preferences > Navigator > Application menu.

2. Click New.

3. Enter acrobat in the Description window.

4. Enter application/pdf in the MIME type window.

5. Enter pdf in the Suffixes window.

6. Click on application in the Handled by window.

7. Enter acroread at the prompt.

Note: Use the xpsh command from the user’s login session to start
the local browser. Otherwise, the local browser will not know
where the Acrobat Reader resides.
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Chapter 5
Using Advanced Features

This chapter provides information about these advanced NCBridge software
features:

• Audio Player for recording and playing audio files on the network computer.

• Audio Mixer for controlling the audio volume for the line in and microphone
on the network computer.

• Digital Video Player for playing NTSC or PAL video sources on the network
computer.

• Analog Video Player for playing analog video sources on the network
computer.

• WinDD to run Windows NT applications on a PC server.

• Font Caching for storing fonts in your network computer’s memory.

• Printing Color Hardcopies from your network computer.

• TekLogin Local Client to simplify login and application access.

• PPP Support for network connections via serial lines (phone lines).

• Screen Saver Support that enables you to display .gif images.

• 16-Bit Plane True Color Support for better visual effects.

• 24-Bit Plane True Color Support for better visual effects.

• Simultiple Color

• Web-Based Administrator

• Seriald for Remote COM Support from Windows NT Applications.

• XDMCP_keepalive

• Termctrl Client

Table 5-1 shows the advanced features provided on the XP, NC200, NC400, and
NC900 NCBridge models.
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Table 5-1 compares the features on each platform:

*Requires 4MB of video memory.

Table 5-1 Features by Model Chart

Feature XP
NC200/
NC400 NC900

Audio Player ♦ ♦ ♦

Audio Mixer ♦ ♦ ♦

Digital Video Player XP400 ♦

Analog Video Player X317CVJ

WinDD ♦ ♦ ♦

Font Caching ♦ ♦ ♦

Printing Color Hardcopies ♦ ♦ ♦

TekLogin Local Client ♦ ♦ ♦

PPP Support ♦ ♦ ♦

Screen Saver Support ♦ ♦ ♦

16-Bit Plane True Color Support ♦ ∗ ♦

24-Bit Plane True Color Support ♦

Web-based Administrator ♦ ♦ ♦

Seriald ♦ ♦ ♦

Simultiple Color ♦

xdmcp_keepalive ♦ ♦ ♦

termctrl Client ♦ ♦ ♦
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Audio Player
The Audio Player plays and records digital audio files. When started, the Audio
Player displays as shown in Figure 5-1.

Figure 5-1 Audio Player

The player can play files that have these extensions:

.au Sun file type

.wav Microsoft file type

.voc Sound Blaster file type (play only)

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header
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If a file does not have an extension, the player attempts to read its header
information. If there is no header information, the player plays it as a headerless
file (.raw).

The Audio Player supports the file formats 8-bit linear, 8-bit uLaw, 8-bit aLaw,
and 16-bit linear (LSB & MSB).

The following topics present information about using the Audio Player:

• Starting the Audio Player on page 5-4 provides information about the
various ways to start the Audio Player

• Opening or Creating an Audio File on page 5-9 provides information about
opening and creating audio files

• Connecting External Audio Devices on page 5-17 provides information
about the types of external devices that can be used with recording audio files

• Recording an Audio File on page 5-21 provides the steps for recording an
audio file

• Playing an Audio File on page 5-23 provides the steps for playing an existing
audio file

• Audio File Information on page 5-24 provides information about obtaining
original audio file recording information

Starting the Audio Player
The Audio Player can be started from the Client Launcher, from the remote
configuration file, or with the xpsh command.

>>> CAUTION Before connecting any audio device to the network computer
(such as microphones or headsets), close all clients, remote connections, and
power down the network computer. Connecting devices to the network
computer’s audio connectors with power applied could result in a loss of data.
After the devices are connected, start the Audio Player.

Starting the Audio Player from the Client Launcher

From the Multimedia submenu, select Audio Player. Figure 5-1 shows the
Audio Player.
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Starting the Audio Player from the Remote Configuration File
The start AUDIO_PLAYER command in the remote configuration file
(xp.cnf) automatically downloads and starts the Audio Player when the network
computer boots. Refer to the start command in Chapter 2 of the NCBridge
Reference Manual for details.

Starting the Audio Player with xpsh
xpsh can start the Audio Player client, shown in Figure 5-1, or can simply play
an audio file without opening the Audio Player. To start the Audio Player with
xpsh, enter:

xpsh –display nc_name:0 aplay

The following options can be set on the xpsh command-line:

–h host specifies the host name or address on which the audio file resides. The
host must be entered in the network computer’s Internet Host Table in
Setup. This host displays in the Audio Player’s File Information area.

–f filename and path specifies the audio file name and its entire path. This file
displays in the Audio Player’s File Information area.

–a access method specifies the access method used to access the audio file.
Available access methods are tftp, nfs, and dap.

–v volume level specifies the volume level to use when playing the audio file.
Specify a number between 0 and 100, with 0 indicating no volume, and 100
indicating the loudest volume setting.

–p when used with the –h, –f, –a, and –v options, the specified file plays
without opening the Audio Player. The entire file plays and cannot be
interrupted.

–propcmd enables the “property command” interface, which allows other
clients to send command strings to control the aplay client remotely. (See
the examples that follow.)

–title “string” assigns a title for the aplay window.

Examples

This example starts the Audio Player on the network computer named sierra:
xpsh –display sierra:0 aplay
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This example starts the Audio Player with the host portland and the audio file
/usr/adam/story.au preloaded in the Audio Player’s File Information Area:

xpsh –display sierra:0 aplay –h portland –f /usr/adam/story.au

This example plays the audio file /usr/adam/story.au (located on the host
portland) on the network computer without opening the Audio Player:

xpsh –display sierra:0 aplay –h portland –f /usr/adam/story.au –a tftp –p

Example 1-1. Aplay examples

xpsh -display sierra:0 aplay

xpsh -display sierra:0 aplay -h eugene -f /usr/adam/story.au

xpsh -display sierra:0 aplay -h eugene -f /usr/adam/story.au -a tftp -p

The first xpsh example above starts the aplay client on a network computer
named sierra; the second starts the Audio Player with the host eugene and the
audio file /usr/adam/story.au preloaded in the Audio Player’s File Information
Area; and the third example plays the audio file /usr/adam/story.au (located on
the host eugene) on the network computer without opening the Audio Player.
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Property Command Interface
The property command interface lets other clients remotely control the
command-line version of the aplay client by allowing these other clients access
to four “properties” created by the aplay client on the X server. (See Table 5-1,
Audio Player Properties.) If the aplay client is executed with the -propcmd
option, atoms (which uniquely identify each property) are created and become
associated with these character strings. The aplay client’s shell window ID is
then assigned to the _TEK_APLAY_WID property.

To use these properties to control the aplay client, get the value of
_TEK_APLAY_WID. You will need to know the client’s window ID when
setting the value of _TEK_APLAY_CMD, getting the value of
_TEK_APLAY_REPLY, and finding the status of _TEK_APLAY_STATUS.

Commands that can be sent to the aplay client via the _TEK_APLAY_CMD
are of two types: value-free and valued.

Value-free commands. A value-free command is simply a request for an
action to be performed. Value-free commands include: PLAY, STOP, PAUSE,
REWIND, and MUTE.

Valued commands. A valued command sends a command and a value to be
used in the performance of that command. Valued commands include: FILE,
VOLUME, ACCESS, and HOST. Valued commands can be used to set a value,
or to query the client for a value.

The format for setting a value is:
<command>:<value>

Table 5-2 Audio Player Properties

Property name Description

_TEK_APLAY_WID Gets the ID of the aplay shell window

_TEK_APLAY_CMD Passes commands to the aplay client

_TEK_APLAY_REPLY Sends replies to the client issuing the commands

_TEK_APLAY_STATUS Returns the status of the aplay client
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There is no white space separating the command, colon, or value. The value is
different depending on the command. The FILE command requires a full
absolute path to a file.

FILE:/usr/audio/speech.au

Valued commands can also be used to query a particular value. This is done by
sending the command and getting the string associated with the
_TEK_APLAY_REPLY property. If the command string FILE is loaded into
the _TEK_APLAY_CMD property, the current file name is stored in the
_TEK_APLAY_REPLY property. If the command string VOLUME is loaded
into the _TEK_APLAY_CMD property, the current volume level is stored into
the reply property.

• User puts FILE in _TEK_APLAY_CMD

• aplay puts /usr/audio/speech.au into _TEK_APLAY_REPLY

Once the aplay client gets notification that the _TEK_APLAY_CMD property
has changed, it gets the command string associated with it and deletes the
property value. This is an acknowledgment that the aplay client has handled the
property command.

To find the status of the aplay client, simply check the string associated with
the _TEK_APLAY_STATUS property. The value of status is either
STARTED, PAUSED, or EOF.
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Opening or Creating an Audio File
The Open command on the File menu creates a new file to record, or opens an
existing file.

1. Select the Open command from the File menu. The File Selection window
appears as shown in Figure 5-2.

2. To select the access method to use, position the mouse pointer on the NFS
button and click. A drop down menu displays the available methods: TFTP,
NFS, or DAP. The File Selection window changes to reflect the chosen
access method.

Figure 5-2 File Selection
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Using TFTP Access
The TFTP File Selection window shown in Figure 5-3 displays when TFTP is
the access method:

Figure 5-3 Aplay TFTP File Selection Window

Note: Use TFTP as the access method only if NFS is not available.
NFS provides better and more accurate data transfer rates
required to maintain continuous audio stream.

If using TFTP as the access method, the Audio Player cannot
play a file that is greater than 16MB. If you attempt to play a
file larger than 16MB, the player will ignore the file.
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Creating a New Audio File Using TFTP Access

When creating a new audio file using TFTP as the file access, the file must exist
and have world-write permissions before the audio data can be written to it. In
addition, only the .au, and .raw file extensions can be used with TFTP.

1. Create the new audio file and give it world-read and -write permissions.

2. Enter the Host name or address on which the file will be stored in the Host
field.

3. Enter the filename, path, and extension in the Path field. Use only the .au
(Sun file type) or .raw (no header) file extensions.

4. Click on OK to open the file. The Host and file names display in the File
Information Area.

Opening an Existing Audio File Using TFTP Access

1. Enter the name or address of the Host on which the file is located in the Host
field.

2. Enter the file’s path, filename, and extension in the Path field. Files with the
following extensions can be played on the Audio Player:

.au Sun file type

.wav Microsoft file type

.voc Sound Blaster file type

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header

If no extension is given, the player attempts to read the file’s header
information. If the file does not have a header, the player plays it as a
headerless file (.raw).

3. Click OK. The Host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the
file’s original recording information. Refer to the Info command later in this
chapter for more information.
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Using NFS Access
Figure 5-4 displays the NFS File Selection Window when NFS is the access
method.

Figure 5-4 Aplay NFS File Selection Window

Creating a New Audio File Using NFS Access

When using NFS as the file access, an NFS mount must be established to the
Host on which the file resides and must have world-read and -write access.

1. Enter the local NFS mount point to the network computer in the Filter field.
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2. Enter the full path, filename, and extension in the Selection field. The
following file extensions are available:

.au Sun file type

.wav Microsoft file type

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header

If no extension is given, the file is recorded as a headerless file (.raw).

3. Click OK. The Host and file names display in the File Information Area.

Opening an Existing Audio File Using NFS Access

1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

3. To view files in a different directory, click on the directory name in the
Directories area, and then click on the Apply Filter button. The files in that
directory are listed in the Files area.

4. Select the file you want in the Files area. The full path and filename prefills
in the Selection field. Enter one of these file extensions:

.au Sun file type

.wav Microsoft file type

.voc Sound Blaster file type

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header

If no extension is given, the player attempts to read the file’s header
information. If the file does not have a header, the player plays it as a
headerless file (.raw).

5. Click OK. The Host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the
file’s original recording information. Refer to the Info command later in this
chapter for more information.
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Using DAP Access
The following File Selection window displays when DAP is the access method.

Figure 5-5 Aplay DAP File Selection Window

Creating a New Audio File Using DAP Access

1. Enter the node name or address in the Node field. This is the node on which
the file will be stored.
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2. Enter the full path, filename, and extension in the Selection field. The
following file extensions are available:

.au Sun file type

.wav Microsoft file type

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header

If no extension is given, the file is recorded as a headerless file (.raw).

3. Click OK. The Host and file names display in the File Information Area.

Opening an Existing Audio File Using DAP Access

1. Enter the node name or address in the Node field. This is the node on which
the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

4. To view files in a different directory, click on the directory name in the
Directories area, and then click on the Apply Filter button. The files in that
directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and filename prefills
in the Selection field. Enter one of the following file extensions:

.au Sun file type

.wav Microsoft file type

.voc Sound Blaster file type

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header

If no extension is given, the player attempts to read the file’s header
information. If the file does not have a header, the player plays it as a
headerless file (.raw).
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6. Click OK. The Host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the
file’s original recording information. Refer to the Info command later in this
chapter for more information.
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Connecting External Audio Devices
• Figure 5-6 shows the audio input and output connectors for the XP, NC200,

and NC400 series. All of the jacks accept a 3.5 mm phone plug.

Figure 5-6 Input and Output Jacks for XP, NC200, and NC400

The NC900 provides two 3.5 mm audio connectors, one for microphone in and
one for speaker out as shown in Figure 5-7.

Figure 5-7 NC900 Audio Jacks

>>> CAUTION: Before connecting any audio device to the network computer,
close all clients, remote connections, and power down the network computer.
Connecting devices to the network computer’s audio connectors with power
applied could result in a loss of data.

Mic Line
In

Line
Out

Head-
phones

Mic/Line In Speaker/Headphones
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• If you are using a microphone for audio input, plug it into the Mic input jack.

Notes: The commonly available PC99-compatible microphone works
with the NC900, but not with the earlier XP, NC200, or
NC400 series. This microphone requires a bias voltage,
sometimes referred to as “phantom-power”. The connector
plug of a PC99-type microphone has three conductors (tip,
ring, and shaft). On this type of plug, the middle conductor
(ring) provides DC power for the microphone.

The XP, NC200, or NC400 series require a dynamic or
self-biased microphone that has a two conductor plug (tip and
shaft). The audio option design of these earlier models
predates the PC99 specification, so they do not support
PC99-type microphones.

Self-biased microphones such as an electret condenser
microphone have an internal battery and a two conductor
plug. These are compatible with the XP, NC200, NC400, and
NC900 series.

The NC900 supports dynamic, electret condenser (self-biased),
and the newer PC99-type microphones.

• A line level signal from a stereo audio source such as an audio mixer,
pre-amplifier, compact disc player, or tape player, plugs into the line-in jack.
NC900 models use the symbol to identify the line-in/microphone jack,
while XP, NC200, and NC400 models employ the symbol to show the
line-in jack.

• The line-out jack provides a line-level stereo signal for use by a mixer,
pre-amplifier, tape player, or other equipment that can accept a line level
input. This output provides the highest quality audio. NC900 models use the

symbol to denote the line-out/headphone jack, while XP, NC200, and
NC400 models use the symbol to indicate the line-out jack.

• The headphone jacks on NC200, NC400, and NC900 models work with
stereo headphones and 32 Ω powered stereo speaker sets. The XP series
supports 8 Ω unpowered and powered speaker sets. Inserting the headphone
plug into this jack disables the internal monitor speaker.
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Audio Accessory Specifications for XP, NC200, and NC400 
Series

The following specifications can assist you when choosing accessories to use
with the Audio board.

Microphone Specifications
Microphone Type • Dynamic

• Electret (or condenser) with integrated battery

Impedance Medium to High (600 to 1000 Ω at 1 kHz)

Sensitivity –55 to –70 db (at 1 kHz)

Frequency Range 50 Hz to 16 kHz

Cord Length 6 feet or longer (for ergonomic reasons)

Plug 3.5 mm monaural phone plug

Line Input Specifications
Signal Level 0.775 Vrms nominal

Input Impedance High (greater than 20 KΩ)

Plug 3.5 mm stereo phone plug

Line Output Specifications
Signal Level 0.775 Vrms into a 600 Ω load

Plug 3.5 mm stereo phone plug

Speaker/Headphone Specifications
Impedance 8 Ω (minimum) on XP only

32 Ω (minimum) on NC200, NC400)

Plug 3.5 mm stereo phone plug
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Audio Accessory Specifications for NC900 Series
The following specifications can assist you when choosing accessories to use
with the Audio board.

Microphone Specifications
Microphone Type • Dynamic

• Electret (or condenser) with integrated battery
• PC99-compatible

Impedance Medium to High (600 to 1000 Ω at 1 kHz)

Sensitivity –55 to –70 db (at 1 kHz)

Frequency Range 50 Hz to 16 kHz

Cord Length 6 feet or longer (for ergonomic reasons)

Plug 3.5 mm monaural phone plug

Line Input Specifications (same jack as microphone)
Signal Level 0.775 Vrms nominal

Input Impedance High (greater than 20 KΩ)

Plug 3.5 mm stereo phone plug

Line Output Speaker/Headphone Specifications
Signal Level 0.775 Vrms into a 600 Ω load

Plug 3.5 mm stereo phone plug

Impedance 32 Ω (minimum)
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Recording an Audio File
The Audio Player works much like a home stereo. It has a Record button, a
Stop button, and a Play button. It also has a number of recording settings you
can adjust so that the audio file is recorded for the type of device on which it
will be played. Audio files can be played on almost any computer that has audio
capabilities, including network computers, personal computers, and
workstations.

When a new file is created, the default file settings reflect the device on which
it will be recorded, in this case, the network computer.

If an existing file is opened, the settings displayed in the Audio Player reflect
the settings at which the file was recorded if the network computer can support
the settings. If not, the Audio Player adjusts the settings to best match the
network computer’s capabilities. To see the exact settings at which the audio
file was recorded, select the Info command in the File menu.

Before recording, attach any external audio devices. Refer to the Connecting
External Audio Devices topic on page 5-17.

Before recording, set the recording options listed here:

Frequency Select a sampling frequency. The higher the frequency, the
clearer the recording. The available frequency settings are
limited to the network computer hardware. You cannot
record at a frequency higher than the network computer
supports. If you try to record at an unsupported frequency,
a warning displays.

File Format Select a file format. The File Format determines how the
audio file is stored.

Input Source Select the input source of the audio data: microphone,
stereo line, video line, or a mix of multiple sources. Refer to
the Audio Mixer for information about mixing input
sources. Refer to the Using the Audio Mixer topic on
page 5-26 for details about the Audio Mixer.

Stereo This option toggles the stereo option. Select this option to
record in Stereo, or de-select it to record in mono.

Mic Boost This option toggles the Microphone boost option. Select
this option to increase the sensitivity of the microphone.
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Recording Levels Sets and shows the recording level. Slide the recording level
indicator to the right to increase the levels. The Left and
Right feedback area shows the decibel levels during
recording. If the levels reach the “red area”, indicated by red
bars, the recording may be at too high a level. Slide the
recording indicator to the left to reduce the recording level.

Recording Length Sets a maximum recording time limit (up to 999999
seconds). Use this option if you want to control the length
of the recording. When the recording reaches the time limit,
the player automatically stops recording.

After setting the recording options, you are ready to record:

1. Use the Open command to open an existing file, or to create a new file.

2. Click on the Record button. The recorder starts and continues to record until
you click on the Stop button.

3. To stop recording, click on the Stop button.

4. To rewind to the audio file, click on the Rewind button. The file rewinds to
the beginning.

5. To play the audio file, click on the Play button.

6. To adjust the volume, slide the volume controller to the right to increase the
volume, or to the left to decrease the volume. Be sure the Sound button is on,
or pushed in. The Sound button acts as a mute toggle; when it is pushed in,
you can hear the sound, when it is off, the sound is muted.

To make recording adjustments, change any of the recording options and go
back to Step 2. Repeat this procedure as needed.

Note: When you use TFTP to access files, some versions of TFTP
overwrite the file’s contents after the file is recorded when the
file’s header information is added. If this occurs, use NFS as
the file access method.
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Playing an Audio File
The Audio Player can play files that have these extensions:

.au Sun file type

.wav Microsoft file type

.voc Sound Blaster file type

.aiff Macintosh file type

.snd Macintosh file type

.raw no file header

Files that do not have an extension are played as raw files.

To play an audio file:

1. Use the Open command on the File menu to open the audio file. When the
file is opened, use the Info command on the File menu to view the recording
settings. These settings may differ from the settings displayed on the Audio
Player. The Audio Player settings reflect the current hardware capabilities.
The original recording settings may not be available on the hardware, so the
Audio Player automatically adjusts the settings to best match those that are
available with the hardware.

2. Click the Play button.

3. To adjust the volume, slide the volume controller to the right to increase the
volume, or to the left to decrease the volume. Be sure the Sound button is on,
or pushed in. The Sound button acts as a mute toggle; when it is pushed in,
you can hear the sound, when it is off, the sound is muted.

4. To stop playing the file, click the Stop button. To restart the file from where
it stopped, click the Play button.

5. To rewind the audio file to the beginning, click the Rewind button.
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Audio File Information
After opening a file that already exists, use the Info command on the File menu
to display a window with the file’s original recording information. Figure 5-8
shows how the filename, frequency, format, channel, and duration information
are displayed.

Figure 5-8 File Information Window

When opening an existing file, the options displayed on the Audio Player reflect
the current hardware capabilities. The original recording settings may not be
available on the hardware, so the Audio Player automatically adjusts the
settings to best match those that are available with the hardware.

To close the File Information window, click the CANCEL button.

Closing the Audio Player
To close the Audio Player, select the Quit command from the File menu. Any
open file information is saved and the player exits.

CANCEL

Filename: /u8/paul/Temp/au.au
Frequency: 8000 Hz
Format: 8-bit u-law
Channels: 1
Duration: 60 seconds
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Audio Mixer
The Audio Mixer allows you to control the hardware volume for line in,
microphone, and prerecorded (digital) sources. You are not required to use the
Audio Mixer when recording or playing audio or video files. When started, the
Audio Mixer displays as shown here:

Figure 5-9 Audio Mixer

The Audio Mixer is like a master volume control, much like the volume control
on a home stereo receiver. The volume control on the stereo receiver controls
the output volume for all the stereo components, such as the tape player and the
CD player. Likewise, the mixer controls the input and output gain for the Line
In, Digital, and Microphone sources.

Note: The Bell Gain control is available on NC900 models only.

Each volume control has a toggle Sound button. When clicked on, the sound is
heard. When off, the sound is muted until it is selected again. This allows you
to quickly mute the sound and then to resume.

Starting the Audio Mixer
The Audio Mixer can be started from the Client Launcher, from the remote
configuration file, or with the xpsh command.

Starting the Audio Mixer from the Client Launcher

From the Multimedia submenu, select Audio Mixer. The software displays the
Audio Mixer as shown in Figure 5-9.
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Starting the Audio Mixer from the Remote Configuration File

The start AUDIO_MIXER command in the remote configuration file (xp.cnf)
can be used to automatically download and start the Audio Mixer when the
network computer boots. Refer to the start command in Chapter 2 of the
NCBridge Reference Manual for details.

Starting the Audio Mixer with xpsh

xpsh can open the Audio Mixer client, as shown in Figure 5-9. To open the
Audio Mixer with xpsh, enter this command:

xpsh –display nc_name:0 mixer

Using the Audio Mixer
To use the Audio Mixer to monitor input, adjust the volume levels of the Line
In Gain, Digital Gain, and the Microphone Gain, depending on what you are
using as the input source(s).

• When playing an audio file, the Audio Mixer sets the output levels for each
of the input sources relative to each other.

• When recording an audio file, the Audio Mixer sets the recording levels of
the input sources relative to all of the input sources. The combined input
sources, except the microphone input, are then recorded as a single source
(mixed).

Examples of Using the Audio Mixer

Below are some common examples of using the Audio Mixer.

• You can play a compact disc through the network computer’s speaker (Line
In) and use the Audio Mixer to control the volume.

• When recording an audio file using the Audio Player, you can open the
Audio Mixer client and adjust the Line In Gain volume so that you can
monitor the file as it records. (Note, you are not required to use the Audio
Mixer when recording an audio file.)

• To selectively record specific segments of an audio source, adjust the Audio
Player so that it is ready to record, open the Audio Mixer, and begin playing
the audio source. When a segment plays that you want, start recording. When
finished, stop the recording while still listening to the audio source. When
another segment starts that you want to record, begin recording again. This
allows you to selectively record only what you want without having to start
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and stop the audio source.

• To record multiple inputs on NC200 and NC400 models, set the input source
on the Audio Player to Mixed. The Audio Mixer controls the recording
volume of each of the input sources. For example, to record sound from
several input sources to go with a presentation, such as the Digital Video
Player and a CD player, set the Line In Gain to a lower level than the Digital
Video. (The Line In Gain controls the CD volume and the Digital Video gain
controls the recording volume of video soundtracks.) Set the recording
settings on the Audio Player, start recording the music, start the Vplay client,
and then adjust its volume level. When finished, stop the recording and play
back the audio file. If necessary, readjust the levels on the Audio Mixer and
re-record until the relative gains are correctly set.

• NC900 models employ one input jack for both line-in and microphone gain,
so it is not possible to record multiple inputs on NC900 models. If you click
the Microphone Mute control, the Line In Gain control is no longer
available; it is automatically muted. Conversely, clicking the Line Gain
control on the Audio Mixer dialog toggles you to the Line Gain control and
the Microphone Gain control is muted.

Keep in mind that after the relative gains for the input sources are set with the
Audio Mixer, you can then use the Recording Level feature on the Audio Player
to adjust the multiple sources as a single source at a higher or lower level.

Saving the Audio Mixer Level Settings
To save the level settings from one Audio Mixer session to another, note the dB
values for the Line In Gain, Digital Gain, and Microphone Gain and add them
to the start AUDIO_SERVER command in the xp.cnf remote configuration
file. The next time the Audio Mixer starts, the dB values are preset.

Closing the Audio Mixer
To close the Audio Mixer, select the Quit command from the File menu.

Adjusting the Volume when Starting the Audio Server
The default volume (or gain) for the audio server may be adjusted when the
audio server is first executed. The following xp.cnf command gives an example
of how to reduce the volume for the audio server at start up.

start AUDIO_SERVER -args “dgain -10”
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Digital Video Player
The Digital Video player allows you to play video files in a video window on
your network computer. An optional digital video coprocessor card, available
only on the XP400, NC200, and NC400, is required to support this feature. The
video file must be in MPEG1 file format. When started, the Video Player
displays as shown in Figure 5-10.

Figure 5-10 Video Player

The following information about the Video Player is available:

• Starting the Video Player provides information about the various ways of
starting the Video Player.

• Opening a Video File provides information about opening video files.

• Using the Video Player provides the steps for playing video files.

• Multicast provides information about sending packets from a single point to
multiple receivers.

File
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Black/White

4X

Brightness:

Contrast:

0

0

Volume: 50

Hostname:
Filename:

00:00:00Position:

Size and Color Controls

Volume Control

Control Buttons

File Menu File Information Area

Time Code Window

Position Slider
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Starting the Video Player
The video player can be started from the Client Launcher, from the remote
configuration file, or with xpsh.

Starting the Video Player from the Client Launcher

From the Multimedia submenu, select Digital Video. The Video Player displays
as shown in Figure 5-10.

Starting the Video Player from the Remote Configuration File

The start DIGITAL_VIDEO command in the xp.cnf remote configuration file
can be used to automatically download and start the Video Player when the
network computer boots. Refer to the start command in Chapter 2 of the
NCBridge Reference Manual for details.

Starting the Video Player with xpsh

xpsh can start the Video Player client, as shown in Figure 5-10. To open the
Video Player with xpsh, enter this command:

xpsh –display nc_name:0 vplay

The following vplay options can be set on the xpsh command-line:

–h (Host) specifies the Host name or address on which the video file resides.
The Host must be entered in the network computer’s Internet Host Table
in Setup. This host displays in the Video Player’s File Information area.

–f (Filename and path) specifies the video file name and its entire path. This
file displays in the Video Player’s File Information area.

–a (Access method) specifies the access method used to access the video file.
Available access methods are tftp, nfs, dap and multicast. NFS is the
preferred file access method for faster and more accurate data transfer
rates required by the player. In addition, there is a 16MB limit on files
transferred with TFTP.

–v (Volume level) specifies the volume level to use when playing the video
file. Specify a number between 0 and 100, with 0 indicating no volume,
and 100 indicating the loudest volume setting.

–m (Mute) specifies that the video file plays with no sound.

–c (Color) specifies that the video file displays in color (used only if the
video was recorded in color).

–nc (No Color) specifies that the video file displays in greyscale images.
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–b (Big) specifies that the video file displays in a frame four times the
size of the original file.

–p (Play only) When used with the –h, –f, –a, and –v options, the
specified file plays without showing the Video Player. The entire file
plays and cannot be interrupted.

–all (Play All; software player only) plays all frames in a video file. Frame
scheduling is ignored and the audio will not be in sync.

–title “string” assigns a title for the vplay windows.

–propcmd creates properties that allow other clients to send command
strings to the Video Player. These properties can be used to
control the Video Player from another client. For details
about the properties, see the vplay man page.

–brightness n sets the brightness level of the video file. Specify a number
between –50 and +50.

–contrast n sets the contrast level of the video file. Specify a number
between –50 and +50.

–BUFSIZE n (Hardware player only) specifies the size of the Video
Player’s memory buffer (in kilobytes). The value defaults to
1024 and can not be set lower than 1kilobyte. If the value
specified is greater than available memory when trying to
play a file, the Video Player reduces its buffer to the available
memory.

–CHKSIZE n (Hardware player only) specifies that the Video Player’s
memory buffer is divided into “chunks”, measured in
kilobytes. The network fills the chunks, and the Video Player
empties them as they are accessed. The default is 32, which
divides the buffer into 32 kilobyte chunks. If the chunk size
is set to a number larger than the buffer size, the chunk size
will be truncated to one half the buffer size. The chunk size
cannot be set less than 1 kilobyte.

–CHKDELAY n (Hardware player only) specifies the time delay (in
milliseconds) that the Video Player waits following each read
request that fills a chunk.
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Examples

This example opens the Video Player on the network computer named sierra:
xpsh –display sierra:0 vplay

This example opens the Video Player with the host portland and the video file
/usr/adam/scene.mpg preloaded in the Video Player’s File Information Area:

xpsh –display sierra:0 vplay –h portland –f /usr/adam/scene.mpg –a tftp

This example plays the video file /usr/adam/scene.mpg (located on the host
portland) in color and with no sound on the network computer without
showing the Video Player:

xpsh –display sierra:0 vplay –h portland –f /usr/adam/scene.mpg –a tftp \–c –m –p
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Opening a Video File
The Open command on the File menu opens and displays an existing video file.
Video files must be in MPEG file format only.

1. Select the Open command from the File menu. The File Selection window
appears as shown in Figure 5-11

Figure 5-11 File Selection Window

2. To select the access method to use, position the mouse pointer on the NFS
button and click. A drop down menu displays the available methods: TFTP,
NFS, or DAP. The File Selection window changes to reflect the chosen
access method.
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Using TFTP Access
The File Selection window in Figure 5-12 displays when TFTP is the access
method.

Figure 5-12 TFTP File Selection Window

Notes: Use TFTP as the access method only if NFS is not available.
NFS provides better and more accurate data transfer rates
required to maintain continuous audio and video stream.
If using TFTP as the access method, and you attempt to play a file
that is greater than 16MB of MPEG data, the Digital Video Player
ignores the remaining data after 16MB has been reached.
In addition, inherent limitations in TFTP prevent fast
forward and fast rewind from being supported.

File Selection

Host

TFTP

Path

OK CANCEL

134.62.18.81

/u8/paul/Temp/au.au
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1. Enter the name or address of the Host on which the file is located in the Host
field.

2. Enter the file’s path, filename, and extension in the Path field. The file must
be an MPEG file.

3. Click OK. The Host and file names display in the File Information Area.

Using NFS Access
The File Selection window displays when NFS is the access method.

Figure 5-13 File Selection Window when NFS is the Access Method
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To use the File Selection window when NFS is the access method:

1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

3. To view files in a different directory, click on the directory name in the
Directories area, and then click on the Apply Filter button. The files in that
directory are listed in the Files area.

4. Select the file you want in the Files area. The full path and filename prefills
in the Selection field. The file must be an MPEG file.

5. Click OK. The Host and file names display in the File Information Area.
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Using DAP Access
The File Selection window shown here displays when DAP is the access
method.

Figure 5-14 File Selection Window When DAP is the Access Method

1. Enter the node name or address in the Node field. This is the node on which
the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.
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4. To view files in a different directory, click on the directory name in the
Directories area, and then click on the Apply Filter button. The files in that
directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and file name prefills
in the Selection field. The file must be an MPEG file.

6. Click OK. The Host and file names display in the File Information Area.
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Playing a Video File
After opening the video file using the Open command, use the Control Buttons
to play the file:

1. Click on the Play button to start playing the specified file. The video player
plays MPEG files only.

Note: If the file does not play, check the Console for messages. If the
file is not an MPEG file format, the console displays the
following message: <FileName> is not an mpeg file!

If the video file includes audio, the Audio Player must be set
to a sample frequency rate of 8000Hz. Otherwise, the audio
will not play.

2. To stop playing the file, click on the Stop button.

3. To rewind the video file to the beginning of the file, click on the Rewind
button.

4. To advance one frame at a time, click on the Forward button. This button is
not available if using TFTP as the file access method.

5. To fast forward through the file, click and hold the Fast Forward button.
Release the button when you want to stop. Refer to the Fast Forwarding and
Rewinding topic on page 5-39 for more information.

6. To fast rewind through the file, click and hold the Fast Rewind button.
Release the button when you want to stop. Refer to the Fast Forwarding and
Rewinding topic on page 5-39 for more information.

7. To adjust the volume, slide the volume controller to the right to increase the
volume, or to the left to decrease the volume. Be sure the Sound button is on,
or pushed in. The Sound button acts as a mute toggle; when it is pushed in,
you can hear the sound, when it is off, the sound is muted.
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While playing the video file, use the following controls to adjust the size and
color of the video file.

Size Plays the video in the size it was recorded (1X), or in a video
window four times the size it was recorded (4X).

Black/White Plays the video in color, or in greyscale. Turn this option on to
play the file in black and white, or off to play the file in color.

Contrast Sets the contrast level. Slide the level indicator to the left to
decrease contrast levels, or to the right to increase the contrast
levels.

Brightness Sets brightness level. Slide the level indicator to the left to
decrease brightness levels, or to the right to increase the
brightness levels.

Fast Forwarding and Rewinding
The Fast Forward and Fast Rewind functions allow you to directly access any
part of a video file. By using the Video Player’s fast forward and fast rewind
buttons or position slider, you can start playback from any location in a file, or
replay a portion of a file any number of times, without having to start at the
beginning.

Note: The Fast Forward, Fast Rewind, and Position Slider are not
available if using TFTP as the file access method.

The slider (NFS only) and time-code window let you see how much of a file has
already played. The slider represents a time index corresponding to the time
code embedded in the MPEG stream. If the stream begins at zero, the time code
acts as a simple timer of how long the video is. Whether you use the buttons or
slider, the time-code window displays the time code of the current frame
location in hours, minutes, and seconds. Both the slider and window are
updated dynamically during playback.

To fast forward or fast rewind using the position slider, do the following:

1. Using any mouse button, grab and drag the slider to the right to fast forward
or to the left to rewind.

2. Release the button when you reach the desired location.
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To fast forward or rewind using the Video Player’s buttons, do the following:

1. Using any mouse button, press and hold the fast forward or fast rewind
button.

2. Release the button when you reach the desired location.

As you drag the slider or press the fast forward or fast rewind button, the video
window is updated, displaying intermediate video portions. When you release
the slider or button, the video player returns to its previous state. For example,
if a video was playing when you repositioned the slider or pressed the button,
the video restarts when you release it. If a video was on pause, it remains on
pause.

As mentioned, you can use any mouse button to drag the slider. However, if you
click on the first mouse button when the mouse is within the position slider
track (but not on the slider button), the slider moves a tiny bit to that side of the
slider button, no matter where in the track you place it. Essentially, the video is
repositioned to the nearest MPEG Group of Pictures (GOP) boundary
(generally about 1/2 second). If you press the second mouse button when it is
in the slider track, the file is positioned at that location.

Multicast
Multicast is a way to send packets from a single point to multiple receivers. The
receivers can determine when and if they receive the Multicasted packets.
Multicast video takes advantage of networks that support Multicasting to
decrease network bandwidth and provide a means of easily accessing video
information.

The Digital Video player allows you to play video files in a video window on
your network computer using Multicast. The video file must be in MPEG file
format.

Note: Multicast is only available on XP400, NC200, and NC400
network computers.

Channels

Channel changing is an interface that maps “channel” numbers to Multicast
addresses. This mapping is made in the xp.cnf remote configuration file and
remains fixed until the network computer is rebooted.
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Selection of a channel causes the client to cease reception on any current
channel and attempt to join a transmission in progress on the selected channel.
The client begins reading data from the Multicast IP address. When it reads
sufficient data to properly set up the window size, the view window resets its
size. A default sized window is started before this happens.

Choosing Multicast Channels

1. Edit the video_multicast_entry command-line in the xp.cnf remote
configuration file to set your Multicast channel options. (Refer to the
video_multicast_entry command in Chapter 2 of the NCBridge Reference
Manual.) These channels display on the Video Player’s Multicast menu
option. If you omit this step, the Video Player does not display the Multicast
menu.

2. In the Video Player, click on the Multicast menu to display the available
channels.

3. Select the channel from the Multicast menu. The Video Player starts as soon
as something is received on that channel.
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Multicast Options

The following Multicast options can be added to the xpsh command-line when
starting the Digital Video Player:

Note: Where indicated, the following vplay options apply to both
broadcast and Multicast, though in different ways. Only
information relevant to Multicasting is included below.

–h host specifies the Multicast IP address. This address must be the same as the
address being used by the Multicast server. See your system administrator
for valid choices.The address displays in the Video Player’s Addr/Port
Information Area.

–f filename specifies the Multicast port number. This port number must be the
same as the port number being used by the Multicast server. See your
system administrator for valid choices. The port number displays in the
Video Player’s Addr/Port Information Area.

–chan n specifies an index into an array of available Multicast channels. (Refer
to the Channels topic on page 5-40 and video_multicast_entry in Chapter 2
of the NCBridge Reference Manual.) Do not use with the –h, –f, –a, or –
text options.

–text “string” specifies the channel string displayed by the Video Player. Do
not use with the –chan option.

–a access method specifies the access method used to access the video file. Use
Multicast when Multicasting.

Example

This example starts the Video Player and plays the video being Multicast on IP
address 224.200.50.1, port 3000. The Video Player displays the text “The Blues
Channel”.

xpsh –display twinkle:0 vplay –h 224.200.50.1 –f 3000
\–a MULTICAST –text “The Blues Channel”
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The Video Player opens displaying the Multicast menu as shown in
Figure 5-15.

Figure 5-15 Video Player with Multicast Menu

When viewing a Multicast video, the Forward, Fast Forward, Rewind, and
Fast Rewind buttons are not operational. However, the time index (displayed
in the Time Code Window) shows the current time code within the current
video segment of the Multicast video. You can note the video segment number
and load it at a later time as a file, reposition to a specific location, and review
a segment of the video previously seen during a Multicast session.

Closing the Video Player
To close the Video Player, select the Quit command from the File menu. Any
open file information is saved and the player exits.
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Analog Video Player
The Analog Video Player enables you to view NTSC (National Television
System Committee) or PAL (Phase Alternation Line-rate) sources in a window
on the network computer’s display (XP300V or X317CVJ only). Common
NTSC and PAL video sources are VCR’s, video disc players, video cameras,
and television tuners. When viewing a video on the network computer, you can
control the volume, window size and placement, and color settings. When
started the Analog Video Player displays as shown in Figure 5-16.

Figure 5-16 Analog Video Player

The Analog Video player requires the analog hardware. Not all network
computer models have the analog hardware.

Before using the Analog Video Player, the xv server extension must be enabled.
If the analog hardware is present, the xv server downloads automatically when
the network computer boots. If for some reason the xv server extension is
disabled, use the enable_xv command in the remote configuration file to enable
it. Refer to Chapter 2, Remote Configuration in the NCBridge Reference
Manual for details.
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The following information about the Analog Video Player is available:

• The Starting the Analog Video Player topic on page 5-46 provides
information about the various ways of starting the Analog Video Player.

• The Connecting the Network Computer to an Analog Video Device topic on
page 5-47 provides information about the ports on the network computer and
connecting the video device.

• The Using the Analog Video Player topic on page 5-48 provides the steps for
viewing analog video sources.
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Starting the Analog Video Player
The Analog Video Player can be started from the Client Launcher, from the
remote configuration file, or with xpsh.

Starting the Analog Video Player from the Client Launcher

From the Multimedia submenu, select Analog Video. The Analog Video Player
displays as shown in Figure 5-16.

Starting the Analog Video Player from the Remote Configuration File

The start ANALOG_VIDEO command in the xp.cnf remote configuration file
can be used to automatically download and start the Analog Video Player when
the network computer boots. Refer to the start command in Chapter 2 of the
NCBridge Reference Manual for details.

Starting the Analog Video Player with xpsh

xpsh can start the Analog Video Player client, as shown in Figure 5-16. To
open the Video Player with xpsh, enter the following:

xpsh –display nc_name:0 xpvideo

The following options can be set on the xpsh command-line:

–encode specifies the encoding format. Specify either NTSC, which is
commonly used in the United States; or PAL, commonly used in
Europe.

–source specifies the video source to which the video device is connected.
Specify either COMPOSITE_1, COMPOSITE_2 or SVIDEO1.

–color specifies the color intensity of the video being played. Specify a
number from –1000 to 1000. 0 is the default.

–bright specifies the color brightness intensity of the video being played.
Specify a number from –1000 to 1000. 0 is the default.

–contrast specifies the color contrast intensity of the video being played.
Specify a number from –1000 to 1000. 0 is the default.

–tint specifies the color tint of the video being player. Specify a
number from –1000 to 1000. 0 is the default.
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Connecting the Network Computer to an Analog Video Device
To use the Analog Video Player, first connect the video device to the network
computer. The Analog Video Player plays NTSC and PAL video encoded
sources.

Note: Refer to your video source user manual for cabling and
encoding information.

There are several ports on the back panel of the network computer used for
analog video. Connect composite sources to the Port 1 Composite, Port 2
Composite, or Port 1 SVideo ports. Refer to Figure 5-17 for the location of the
video ports.

Figure 5-17 Back Panel Showing Audio and Video Ports

Note: You cannot have two video devices connected to Port 1
Composite and Port 1 SVideo at the same time.

Right and Left
audio ports

SVIDEO port

Composite 1 and 2 video ports
(1 is on the bottom)
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Using the Analog Video Player
When the audio device is connected, you are ready to view the video on the
network computer. When started, the Analog Video Player displays the video
options as shown in Figure 5-18. (The Video button on the player is depressed.)

Figure 5-18 Analog Video Player Video Options

To play a video on the network computer:

1. Connect the video source to the network computer. Refer to the Connecting
the Network Computer to an Analog Video Device topic on page 5-47.

2. Click on the Play button. A separate XPVIDEO window displays which is
used to view the video. (This does not affect the video source. You must start
the video source with its own play function.) The icon below the File menu
changes to include a viewer window. If the viewer window is obstructed by
other windows, clicking on this icon brings the viewer window to the top.

3. To adjust the volume, slide the volume controller to the right to increase the
volume, or to the left to decrease the volume. Be sure the Sound button is on,
or pushed in. The Sound button acts as a mute toggle; when it is pushed in,
you can hear the sound, when it is off, the sound is muted.

File

XPVideo

Restore

Tint(Hue):

Contrast:

0

0

Volume: 0

View

Video Tuner Settings

Color:

Brightness:

0

0
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4. To freeze a frame, click on the Pause button. This displays the frame in the
viewer window; however, it has no effect on the video source which
continues to play. Click on the Play button to resume viewing the video
source.

5. To stop viewing the video, click on the Stop button. This has no effect on the
video source and it continues to play.

While viewing a video, you can control the following window attributes:

Brightness Sets the brightness level. Slide the level indicator to the left
to decrease brightness levels, or to the right to increase the
brightness levels.

Color Sets the color level, or intensity. Slide the level indicator to
the left to decrease color intensity, or to the right to increase
the color intensity.

Contrast Sets the contrast level. Slide the level indicator to the left to
decrease contrast levels, or to the right to increase the
contrast levels.

Tint/Hue Sets the tint, or hue, levels. Slide the level indicator to the
left to decrease the tint/hue levels, or to the right to increase
the tint/hue levels.

Restore Restores the video player options to the default settings.

View Menu The View Menu contains the ResetSize command. This
command returns the viewer window to its default size.
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Clicking on the Settings button displays the Settings options as shown in
Figure 5-19.

Figure 5-19 Analog Video Player Settings Options

You can change these settings:

Source specifies the video source to use: Port 1 Composite,
Port 2 Composite, or Port 1 SVideo.

Encoding specifies the encoding format. Specify either NTSC,
which is commonly used in the United States; or PAL,
commonly used in Europe.

Black/White specifies whether the image in the viewing window
displays in color or in black and white.

Auto Gain Control specifies the Automatic Gain Control setting. When
turned ON, the video signal is automatically
amplified for best picture quality.

Note: The Tuner options are not available at this time.

File

XPVideo

DisabledPort 1 - Composite

Vertical:

Horizontal:

Volume: 0

View

Video Tuner Settings

Misc:
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Black/White
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Aspect Ratio specifies the window sizing attributes. Aspect ratio refers
to the relative proportion of the video window’s width
and height. If you want to maintain this ratio when
resizing a window, specify ON for this setting. Then
when you change a window size, it is automatically
adjusted to preserve the aspect ratio. If OFF, you can
resize the window to any size and the aspect ratio is not
maintained.

Overscan specifies whether the image in the viewer window is in
overscan mode. If ON, the full image displays. If OFF,
the image is reduced by 10% to match the viewing area
of typical consumer television screens.

Field Duplicate specifies whether the Analog Video Player uses field
duplication. Field duplication is used primarily to
eliminate blurred images when viewing fast motion
videos or images generated by graphics systems such as
video games. AUTO specifies that the player determines
whether to use field duplication based on the video
window size.

Horizontal positions the contents of the view window horizontally.
Slide the indicator to the left or right to move the contents
of the viewer window left and right.

Vertical positions the contents of the view window vertically.
Slide the indicator to the left or right to move the contents
of the viewer window up and down.

View Menu The View Menu contains the ResetSize command. This
command returns the viewer window to its default size.

Closing the Analog Video Player
To close the Analog Video Player, select the Quit command from the File
menu.
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WinDD ICA Client
The WinDD ICA client provides access to PC servers running Microsoft’s
Windows NT Terminal Server Edition and Citrix Metaframe software. Once
you are logged in to the PC server, you can run Windows NT and DOS based
applications.

Note: DOS graphics applications are not supported (even if started
from the DOS Command Prompt in the Main folder). DOS
applications can only be run in character (text) mode. Refer
to each application for startup options to invoke the
application in this mode. If you try to run a DOS graphics
application, an error is generated and the application
terminates.

Starting the Local WinDD ICA Client
The WinDD ICA client can be started using the Client Launcher, TekHostMenu,
the remote configuration file, or from the command-line with xpsh.

Starting WinDD from the Client Launcher

From the Host Connections submenu, select WinDD. The WinDD local client
is illustrated in Figure 2-14 on page 2-16.

Starting WinDD from TekHostMenu

Click the WinDD button (if necessary) to access the WinDD list. Click on a
server, or enter the server name or address in the Application Server box.
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Starting WinDD with xp.cnf

The start WINDD command in the xp.cnf remote configuration file
automatically downloads and starts WinDD when the network computer boots.
Refer to the start command in Chapter 2 of the NCBridge Reference Manual
for details. Related WinDD remote configuration commands include:

host_connect_method default_host_list
windd_menu_entry windd_auto_connect
windd_auto_reconnect windd_size
default_windd_host windd_host_entry
windd_menubar windd_entrybox
start preload
flash_feature windd_auto_numlock
windd_keysym_only windd_exit_on_logout

Starting WinDD with xpsh

xpsh starts the WinDD local client as needed. Enter the following (where
nc_name is the name or address of your network computer):

xpsh –display nc_name:0 windd [options]

The following options can be set on the xpsh command-line. If an option is not
specified, the default setting is used.

–display nc:0
specifies the network computer (nc) name or address to display the
WinDD local client.

–c means auto-connect to the first application server in the application
server list. If there are no application servers in the list, this option is
ignored and the client window is displayed.

–nc means do not auto-connect to an application server. (Default)

–d displays the menu bar and the internal borders. (Default)

–nd says do not display the menu bar or the internal borders. For example,
this allows a 1280x1024 WinDD window to fully display on a
1280x1024 monitor (minus windows manager decorations).

–e enables the Application Server edit field window so that users can add
application servers to the application server list. (Default)

–ne disables the Application Server edit field window so that users are not
allowed to add application servers to the application server list.
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–floppy
allows supported host versions of WinDD to use its local floppy drive
as a network connected drive for the application server. Only the first
host client to specify this option will be allowed to use the floppy
device. NOTE: For host clients (with local floppy drive) only.

–no_floppy_cache
disables use of local floppy write cache. This is a fail-safe option to
ensure the entire file has been updated in the event a user suddenly
ejects a disk mechanically (when disks are ejected via the GUI button,
that process flushes the cache so no information is lost).

–geometry <geometry>
means use the standard X11 geometry option, <WidthxHeight+X+Y>.

–h <application server>
adds the named application server(s) to the application server list.
Multiple application servers can be added to the list by listing them
separated by spaces.

–help
displays a brief help list on the available WinDD command-line
options.

–initprog <prog> [–initdir <dir>]
specifies the application to execute upon application server login. The
login session is terminated when the application is terminated.

Prog specifies the application and can also specify its path (up to 259
characters) and parameters. The program path and name are written
consecutively (and not separated by a space) when they are both
specified in prog. A space separates the program name and its
parameters. These parameters are program specific and can specify
program settings or data files to invoke on execution.

Dir specifies the path of the executable program.

–keysym_only
specifies that all NCD network computer keyboards are supported with
keysym translations within WinDD.

–local_numlock
specifies that WinDD manages the state of the Num_Lock independent
of any Xserver support.
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–no_auto_numlock
specifies that WinDD does not control the Num_Lock setting.

–login <username> [–pass <passwd>] [–domain <domainname>]
specifies the application server user account login name, login
password, and domain. These values will be used for user account
verification.

When using a WinDD client and connecting to an application server,
your username, password, domain, initial program, and initial directory
are encrypted as they are sent across the network.

Username, password, domainname, dir, and prog are not viewable or
changeable from the WinDD configuration window.

–r means reconnect to the application server after log off.

–nr says do not reconnect to the application server after log off. (Default)

–version
displays the WinDD version in use. (If the license is 8019, this option
also prints For evaluation purposes only.)

–x exits the WinDD client upon logging out of, or disconnecting from, the
application server.

–nx means do not exit the WinDD client upon logging out of, or
disconnecting from, the application server. (Default)
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–force_xcursor
specifies that monochrome pointers within the WinDD desktop are to be
implemented using X cursors. Some monochrome pointers are xor’d
with the underlying desktop. When this switch is specified, it is no
longer xor’d, as X cursors do not support that mode.

Note: The force_xcursor feature is intended to compensate for
workstations that do not have a particularly high
performance X server. Consider using this option if the
pointer flashes when move, or poor performance is observed
entering text in dialog boxes. Using this switch improves user
interactivity. The only side effect is the pointer is displayed in
a single color.

–compress
enables compression of ICA network data to and from the WinDD
client.

–no_compress
disables compression of ICA network data to and from the WinDD
client.

–max_compress_disable
disables compression for n number of outgoing ICA commands from
the WinDD client. The default is 0, which enables all compression. A
count setting of 0 might “compress” client data larger than its original
size during start of login session. Settings larger than 0 restrict
expansion of the client data.

–a published_app
allows an ICA session to connect to any published application on a
WinFrame/MetaFrame-based server. The argument published_app is
the name of the published application.

-no_cm_req_notification
disables the colormap dialog that comes up at startup when a new
colormap needs to be allocated.
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Configuring your WinDD ICA Session from the Client Screen
From the WinDD ICA client screen shown in Figure 5-20, you can easily
change your session attributes before you log in to a server.

Figure 5-20 WinDD Client Screen
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The Configure button brings up the WinDD Configuration dialog illustrated in
Figure 5-21. The resolution determines the size of the WinDD window. The
resolution must be selected prior to making a connection to the application
server and cannot be interactively changed until the connection has been closed.
The Configure button performs the same function as the Options > Configure
pull down menu choice.

Figure 5-21 WinDD Configuration Dialog

The Reconnect After Logoff button enables automatic reconnection to the
application server after you have logged off of a WinDD session. If this button
is on, then the WinDD log in screen (see Figure 2-16 on page 2-20) appears
when you select File > Logoff from a Windows NT 3.51 session or Start >
Logoff on a Windows NT 4.0 or later session. If this button is off, the WinDD
client screen is displayed when you log off a session.
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WinDD messages about connection status, error conditions, or other necessary
user feedback appear in the message console area. All message are also sent to
the network computer system console so that the information is available even
if WinDD has been terminated. Use the Clear Console button to clear
messages.

When configuration is complete, select the application server for your session.

Selecting an Application Server

The WinDD ICA client screen displays a list of application servers your system
administration defined for you. Use the mouse to select one of the servers from
the list. If the application server you want to access is not on the list, enter the
name or address in the Application Server: field and press Enter. WinDD log-
in information is in Chapter 2, Operating the Network Computer.

WinDD Local Client Options Menu
There are two ways to access the local client Options menu:

1. Select Options from the local client menu bar shown in Figure 5-22.

Figure 5-22 Local Client Options Pull Down Menu
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2. Hold down Shift and Ctrl and click the middle mouse button shown in
Figure 5-23. This method is only available after you have a server
connection.

Figure 5-23 Local Client Options Menu

Log On

Toggles between the WinDD session window and the WinDD ICA client
screen. This is only available after you have a server connection. The Cancel
button on the client screen returns you to the session window.
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Configure

Brings up the WinDD Configuration dialog shown in Figure 5-21. This is only
available before you have a server connection.

Exit

Closes the WinDD client.

WinDD Help Menu

The WinDD Help Menu presents WinDD copyright and version information.

Figure 5-24 WinDD Help Menu
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Font Caching
The font caching feature stores fonts in memory for later use. This eliminates
the need to download a font each time the application using the font is executed.
For example, if you open and close your word processor, then open it again, the
fonts are still available if your network computer’s memory. This is a more
efficient use of resources, since fonts are cached once, instead of duplicated for
each occurrence or downloaded over a busy network.

You can specify the amount of memory to allocate or you can flush cached fonts
at any time. It is recommended that cache be flushed whenever new fonts (with
a font path change) are added, to insure that the proper paths are cached.
Flushing does not affect the current applications.

To set a Font Cache Limit:

1. Select Setup from the Client Launcher.

2. Check the amount of memory in your network computer by dragging on
Statistics and releasing on Memory.

3. Drag on Configuration Summaries and release on X Environment.

4. Set Font Cache Limit to the amount of memory in kilobytes to allow for
font caching. Do not exceed the total memory for your network computer.

To empty the Font Cache and free up network computer memory:

1. Select Setup from the Client Launcher.

2. Drag on Configuration Summaries Menu and release on X Environment.

3. Click the Empty Font Cache button.

Printing Color Hardcopies
This section explains how to print a hardcopy by using the MWM pop-up menu
item or by entering a command on the command-line. Information in this
section is specific to the MWM. If you are using another window manager, refer
to the documentation you received with that window manager for more
information about printing a hardcopy.

Note: The host computer must have the appropriate software
installed before you can use these hardcopy commands. If you
cannot print a hardcopy, contact your system administrator.

Launcher

Launcher
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Printing from MWM
You can use a pop-up menu to make a hardcopy of a window or a hardcopy of
the entire screen.

Making a Hardcopy of a Window

1. Move the pointer outside of all windows and drag the Custom mouse button
to display the pull-down menu.

2. Release on Hardcopy to display another pull-down menu.

3. Click the Custom mouse button on Window to change the pointer shape into
a cross.

4. Move the pointer into the window you want to copy.

5. Click the Select mouse button. A single beep indicates the window is being
copied. A double beep indicates the copying process is complete.

Making a Hardcopy of the Screen

1. Move the pointer outside of all windows and drag the custom mouse button
to display the pull-down menu.

2. Release on Hardcopy to display another pull-down menu.

3. Click the custom mouse button on Screen. A single beep indicates the screen
is being copied. A double beep indicates the copying process is complete.

Printing from the Command-Line
Here is a general procedure for printing a hardcopy of a window:

1. Move the pointer into an X window and click the Select mouse button to
activate the window.

2. Press the PrintScreen key. This key must be defined by your system
administrator. Contact your administrator to find out which key to press and
which printer your network computer is configured to use.
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TekLogin Local Client
Many customers want to present their end-users a simplified environment with
simple login methods and easy access to applications. The new TekLogin local
client adds one more piece to that end, streamlining the login process and
allowing system administrators to decide how much or how little control to
offer their end-users.

The TekLogin local client is commonly used with the PPP support feature
(refer to the PPP Support topic on page 5-68) to provide remote users access to
host servers.

Starting TekLogin
There are several ways to launch the TekLogin client. You can launch it with:

• the Setup client

• the Launcher

• the xpsh command

• the xp.cnf remote configuration file

As noted in the previous section, you can choose TekLogin as your Host
Connect Method in Setup’s Configuration Summaries > X Environment
menu. After a successful boot, the network computer will display the TekLogin
client, as seen in Figure 5-25 on page 5-65.

Another method is to set Launcher to display and launch the TekLogin client.
You can manually edit your system.launcher file to do this or set this line in
your xp.cnf file to YES as shown here:

teklogin_show_sessions_in_launcher YES

This will automatically display all eight of your pre-configured sessions in a
pull-down menu in the Launcher.

A third way to start TekLogin is with the xpsh command:
xpsh -display <displayname>:0 teklogin &

Finally, you can have TekLogin start automatically with the xp.cnf file by
un-commenting and altering this line in your xp.cnf file:

START TEKLOGIN NO#[YES|NO]
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Change the value for this line to YES.

Figure 5-25 TekLogin Client

xp.cnf Commands for TekLogin
You can add these commands to your xp.cnf file to affect the TekLogin client.
Refer to your NCBridge Reference Manual for details about these commands.

teklogin_show_sessions_in_launcher [YES|NO]

teklogin_force_fullscreen_windd [YES|NO]

teklogin_timeout [SECONDS]

teklogin_require_login [YES|NO]

teklogin_save_passwords [YES|NO]

teklogin_default_session [1–8]

teklogin_close_on_connect [YES|NO]
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The first two commands listed are notable in that they are not configurable with
the TekLogin client itself, as most of the others are. The
teklogin_show_sessions_in_launcher command will display the configured
sessions in the Launcher client as pull-down selections. The
teklogin_force_fullscreen_windd command forces the WinDD ICA client
launched by TekLogin to take up the whole screen (rather than a 640x480
window, the default).

Configuring TekLogin Settings
In the File pull-down menu, you can select Save Settings, Restore Settings, or
Exit.

Save Settings This saves the current user name, password, phone number,
and session settings such that the next time the TekLogin
client is launched, these settings will display.

Restore Settings Restores the last saved settings.

In the View pull-down menu, you can select Setup or Options. Both of these
selections will require a password if you set password restriction in the Setup
main menu.

Setup This launches the Setup client. System administrators can disable
this feature if they do not wish end-users to have access to the
Setup client. (See the Security Between TekLogin and Setup topic
on page 5-67 for details.)

Options Autologin Timeout. The default timeout is 30 seconds, after
which, if the user does not click the Cancel button, TekLogin will
attempt to make the connection described by the session name. If
the user cancels the autologin, he can then choose one of the other
configured sessions in TekLogin by its session name. The
autologin defaults to the last session connected to via TekLogin.

Interactive Login Required. This requires the user to enter his
username and password after the PPP authentication has occurred.
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Close on Connect. If TekLogin is not configured to close on
connect (default), it will remain on the user’s screen, allowing the
user a simple method of disconnecting from one session and
reconnecting to another. Some system administrators may wish to
disable this functionality, forcing the network computer to connect
using only session configuration.

Figure 5-26 TekLogin options

Security Between TekLogin and Setup
System administrators can set the security mechanism for a network computer
in Setup’s main menu so that no user can tamper with the network computer’s
configuration without the password. The security is activated whenever a user
enters something in Setup or presses a button. Some of the fields, however—
such as username and password for both authentication and account login
purposes—need to be alterable to end-users. With security activated on the
Setup client, users will be able to enter their own user names and passwords,
but will not be able to change the session names or other configuration
parameters.

If security is enabled, the TekLogin client will not launch the Setup client, so
system administrators can effectively “hide” Setup from novice users.
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PPP Support
PPP is a reliable transparent Internet Protocol (IP) that allows network
computers to make network connections via serial lines to remote devices.
NCBridge’s PPP passes TCP/IP information over the phone line in such a way
that it appears as though your network computer has an Ethernet connection.

PPP support is available for the following devices:

• XP100, XP200, XP300V, XP350, NC200, NC400, and NC900.

It is not available for:

• XP10, XP10T, XP20, XP100D, or XP330.

Before You Begin
To run PPP successfully, you will need both the local PPP client process that
runs on the network computer and the PPP server that runs on the remote host
computer. NCBridge version 3.1 or higher software provides the PPP client;
you will need to get the appropriate PPP server software from your host vendor.

There are several different ways you can connect your network computer via
PPP to a remote host, but before you begin, you must first configure:

• The network computer’s serial port

• The network computer’s PPP settings

• The xp.cnf file (if you want PPP to start automatically after boot)

• Several other settings

Configuring the Network Computer’s Serial Port
Before you can connect via PPP, you must configure one of your network
computer’s serial ports for your modem.

First, select a port on the rear panel of your network computer. Since many
users may already have tablets or other peripheral devices connected to port 0,
and since port 1 allows higher transmission rates (115.2K), we recommend you
use port 1 for your modem connection, especially if you are using ISDN lines.
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On the NCD network computers, port 1 is the upper port; port 0 is the lower.
Connect your modem’s 9-pin female cable to the desired port. (All examples in
this section assume port 1 has been configured for PPP.)

Figure 5-27 RS-232 Serial Ports on an NC900

After you have connected the modem cable to your serial port, you must
configure the serial port for modem transmission. In Setup, go to
Configuration Summaries > Peripheral Ports. (See Figure 5-28 on
page 5-70.)

The fields in the lower half of this menu (from Network-to-Port Process
down) do not affect your modem, so we will ignore them here. We are
concerned with one of the two columns at the top, depending on the port you
have chosen. For our example, this is Serial Port 1, on the right.

Serial port 0 (up to 57.6K baud rate)

Serial port 1 (up to 115.2K baud rate)
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The “8”, “1”, and “None” default settings for the first three fields (Data Bits, Stop
Bits, and Parity) will be correct for virtually all current production modems. (Check
your modem user documentation to be sure.) The Flow Control and Baud Rate
settings are really the only two you will need to configure.

Figure 5-28 Peripheral Ports Configuration Menu
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Flow Control. This field determines what kind of PPP “handshake” passes
between the network computer and the server: None, XON/XOFF, or CTS/
RTS.

– “None” tells the network computer to pass data through the modem
without acknowledging transmission or reception of the data packets.

– “XON/XOFF” is a software handshake.

– “CTS/RTS” (recommended) is a hardware handshake. (Check your
modem user documentation for the best handshake method.)

Baud Rate. This refers to your modem’s transmission speed. We recommend
setting this field to at least 57,600 to avoid starving the modem of data. Port 0
supports a maximum of 57,600 baud rate; Port 1 supports up to 115,200.

Note: Due to the complexity of the baud rate programming, port 0
cannot be used if port 1 is in use at 115,200 baud. If port 1 is
in use at lower baud rates, port 0 is available for use with any
appropriate device.
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Configuring the Network Computer’s Session/PPP Settings
Next, you will have to configure your network computer’s session and/or PPP
settings. In Setup, go to Configuration Summaries > Session. This menu
allows you to configure the network computer for PPP sessions and for Ethernet
sessions.

Figure 5-29 Session Manager Configuration Menu

As you can see in Figure 5-29, the Session Manager Configuration Menu is
divided into four areas, known as identification, authentication, connection, and
status.
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Session Identification
In this area, identify each of up to eight session configurations.

Session. You can specify one of eight sessions in this field. For each session,
you will configure the settings in the other fields listed below. When you select
one of the eight sessions with this button, the settings you configure in the other
fields described below will appear.

Session Name. Give each of your eight sessions a distinguishing name that will
help users identify the correct session for their needs.

Session Authentication
The session authentication area is for authentication purposes. Each session
requires some form of authentication to make the session connection.

User Name. You must provide a valid user name.

Password. You must provide a valid password. Your password will appear as
asterisks as you type it in; the field itself will appear blank after you press
Enter. These two authentication parameters (User Name and Password) are
saved in NVRAM when you click the Save Settings to NVRAM button.

Connection Method. There are four choices: Dial Out, Direct, Manual, Script.

Dial Out The dial out method—probably the most common—
can only be used to connect to RAS servers (or servers
emulating the RAS interface). Dial Out assumes PPP
is already running on the Host.

Direct This refers to a true direct serial cable connection from
one device (your network computer) to another (an NT
server, for example), in which the baud rate on the two
devices’ serial ports must be the same. We recommend
you use this method only when you have a
null-modem serial cable connecting your network
computer directly to a server.

Manual This selection automatically brings up a TIP window
and forces the user to enter his/her username and
password. If the PPP daemon is not running on the
Host, the user will also have to start it manually.
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Script This allows you to specify a script to automate the
authentication process.

Port Select Serial Port 0 (PPP), Serial Port 1 (PPP), or
Ethernet.

Serial Port 0 (PPP) Select this if you have configured Serial Port 0 for PPP
(up to a maximum of 57,600 baud rate).

Serial Port 1 (PPP) Select this if you have configured Serial Port 1 for PPP
(up to a maximum of 115,200 baud rate).

Ethernet This selection disables all the PPP settings you may
have configured in the Session Configuration Menu
and connects directly through the network computer’s
Ethernet cable.

Local IP. By default, this field is disabled. Any attempt by the user to add an
IP address or other string will be ignored. In the rare case when you wish to use
this field, you will have to uncomment this line in your xp.cnf file and add an
IP address value:

ppp_local_ip_addr [IP_ADDRESS]

If you do this, be sure to enter a valid unassigned IP address on the same subnet
as your server in the Local IP field; if you enter an invalid address, the Host
will not allow you to log in.

The remaining fields in the session authentication area may or may not appear,
depending on the Connection Method you select. For example, if you choose
Direct, you will not need to provide values for the next four fields.

– Phone Number. You must provide a valid phone number for the network
computer to dial out to if you select Dial Out, Script, or Manual. This field
will not appear if you select Direct as your connection method.

– Script. If you leave this field empty, it will remain blank but will default
to one of the supplied scripts. You can also specify another script or one
of your own. Enter the name of the script in this field. This field will not
appear if you select Direct, Dial Out, or Manual as your connection
method.
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– Connect String. You must provide a connect string only if you select
Dial Out. This field will not appear if you select Direct, Script, or Manual
as your connection method. This string is modem vendor-dependent. The
default value (shown in Figure 5-29 on page 5-72) works with all
Hayes-compatible modems. If you wish to alter the default string, or if it
conflicts with your modem, consult your modem user manual for details.

– Disconnect String. (Same information as for the Connect String above.)

Session Connection
The session connection area is for your login connection after you have
successfully passed PPP authentication.

Connection Type. There are several connection types you can choose from.

None (Default.) None means that after the network computer
has made the connection and been authenticated, the
user will have to start his own session, launch clients
manually, etc.

ICA Host This selection will connect you to a WinDD/Windows
NT host over an ICA connection. If you select ICA
Host, you must specify a WinDD/Windows NT host
(name or IP address) in the Host/Application field.
Unless you specify an alternate configuration in your
xp.cnf file, the default WinDD window (640x480, 16
colors) will appear. (Also, see the note below.)

ICA Application This yields a result similar to the ICA Host connection
type, except that the user, instead of getting an entire
Windows NT session, will only get access to the
specified application. If you select ICA Application,
you must specify a (case-sensitive) application name
in the Host/Application field. This application name
is the name a master ICA browser broadcasts over the
network to ICA clients. When you select ICA
Application, the master ICA browser will connect you
to the Windows NT host that can best serve you that
application, based on the server’s resources, number
of users currently logged in, etc. (Also, see note
below.)
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TekHostMenu This will launch the TekHostMenu client, allowing
the user to choose amongst the various protocol/host
combinations to make a post-authentication
connection.

XDM Direct This sends an XDMCP login from a specific host to
the user’s display immediately after PPP
authentication.

Telnet This launches a Telnet session to the selected Host.

Navio This selection is not supported at this time.

Note: ICA (WinDD) connections WILL NOT work in 16-bit
TrueColor environments. If you choose ICA Host or ICA
Application as a connection type, be sure that your Default
Visual and Root Depth settings are set to “PseudoColor” and
“8” respectively. (See the PPP Support topic on page 5-68 for
more details.)

Host/Application. This field is for one of two values: You can enter the IP
address (or server name) of the ICA host to which the user will login; or the
specific published application name. The published application name defaults
to the local subnet, but you can optionally prepend the published name with a
Windows NT server name or IP address, or with the subnet mask that points to
a specific Application Master Browser location as shown, for example, in this
entry:

192.168.15.255 notepad

This points to an Application Master Browser on the subnet 192.168.15.255. In
such a case, the Application Master Browser selects the Notepad application
from among the Hosts on the subnet based on server load.

User Name. Optional. This user name differs from the user name required in
the session authentication area of this menu. This user name refers to the actual
account the user must have on the server on which he wishes to login; the
former user name is for authentication only. If this field is left empty, the user
will have to manually login to the server after the session has been authenticated
and established.

Password. Optional. This too differs from the password required in the session
authentication area. If this field is left empty, the user will have to manually
enter his/her password to login.
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Domain. Optional. This is only for Windows NT environments. If you have
entered a user name and password in the two previous fields, you might also
want to specify a Windows NT domain on the login Host. Otherwise, the user
will have to manually select a domain at the Windows NT login prompt.

Session status

The session status area is where you make and break session connections. It
also displays information about your connection.

Connect/Disconnect. Use this button to make and break your session
connections. (See the PPP Connections topic on page 5-80.)

Status. This gives PPP connection status information (terminated, connecting,
connected, etc.). If you have selected Ethernet as your Port, Status will display
“Connection Down.”

Local IP. Local IP refers to the IP address the PPP server allocates to your
network computer after the PPP connection has been established. If you have
selected Ethernet as your Port, Local IP will display “Not Connected.”

Remote IP. Remote IP refers to the IP address of the PPP server you are
connected to. If you have selected Ethernet as your Port, Remote IP will
display “Not Connected.”

Configuring the xp.cnf File for PPP
Configuring the xp.cnf file will allow remote users to make PPP connections
automatically, after they boot their network computers. You will need to
complete the previous Setup configurations for each network computer you
want to connect automatically. You will also need to uncomment and alter this
line in your xp.cnf file:

START PPP NO #[YES | NO]

Change the value for this line to YES.
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Final Network Computer Configuration Considerations
There are three other menu items in Setup that you should check before you are
ready to make a PPP connection.

First, verify that your network computer has an Internet Host name. In Setup,
go to Configuration Summaries > TCP/IP. If the first field on this menu is
blank, enter a network computer name. If your network computer does not have
a name, PPP will generate a unique name for you—based on your network
computer’s Ethernet address—so it is not critical that you enter one here; it is
merely good practice.

Second, there are a few settings in Configuration Summaries >
X Environment you should check. If you plan to use either the ICA Host or
ICA Application connection type described in the previous section, make sure
the Default Visual is set to “PseudoColor” and the Root Depth is set to “8”.
Also, with NCBridge 3.2 (or higher), there are additional methods (under Host
Connect Method) you can use to connect to a Host computer (see Figure 5-30
on page 5-79).
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TekLogin, a new local client which allows a simple connection automatically
or with a single button-click, is explained in more detail in the TekLogin Local
Client topic on page 5-64. You may want to change this setting for your
network computer(s).

Figure 5-30 X Environment Configuration

Finally, you might want to save your settings so that you won’t have to go
through these procedures again the next time you reboot. To do this, click the
Return to Main Menu button, then click the Save Settings to NVRAM button
on the bottom left of the Setup main menu.



Chapter 5 Using Advanced Features

5-80 NCBridge User Manual

PPP Connections
After you have configured your network computer’s serial port, PPP, and other
settings, and have attached a modem to one of your network computer’s serial
ports, you can connect to a remote Host via PPP by using:

• The TekLogin client

• The Connect/Disconnect button in Setup’s Session Manager
Configuration Menu

• xpsh on a command-line; or

• Booting the network computer and automatically connecting via PPP with
the xp.cnf remote configuration file.

Connecting Via TekLogin
TekLogin is a new local client that simplifies the connection process, not just
for PPP connections, but for other Host connections as well. This method is
recommended, especially in environments where the system administrator
wishes to simplify the login procedure for inexperienced users. See the
TekLogin Local Client topic on page 5-64 for more information.

Connecting Via Setup
Another way to start PPP is from Setup where the user can see the PPP status
and, in case PPP exits, the reason for the connection failure. When PPP comes
up, the user will see the IP address for the connection on the network computer
(if the remote is assigning IP addresses) and the remote IP address.

For each of the following methods, in Setup, go to
Configuration Summaries > PPP and click the Connect/Disconnect button
to make your PPP authentication connection, then follow the rest of these
procedures below.

Dial out and Direct

For a properly configured Dial Out or Direct session, no other steps are
necessary to connect.
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Manual

When you click the Connect button for a Manual session, one of the provided
scripts (start_man) will start, launching a TIP window and dialing the number
specified in the Session Manager Configuration Menu. The start_man script
prompts you for your username and password. If the PPP daemon is not running
on the Host, you will have to start it manually. The TIP window closes
automatically as soon as the script detects that PPP is running on the Host.
Otherwise, the TIP window remains open for 30 minutes before closing.

Connected
atdt95039000
CONNECT 28800/ARQ/V34/LAPM.V42BIS

t1999ba line 26

User Access Verification

Username: roberta
Password:

IP Modem Pool>251.8.17.60
Trying 251.8.17.60 ... Open

SunOS 5.6

login: roberta
Password
Last login: Tues Jul 1 14:24:07 from t1999ba.ens.ncd
Sun Microsystems Inc. SunOS 5.6 Generic May 2000
You have mail.
roberta>_
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Figure 5-31 Connecting Manually via a TIP window

When your connection has been fully established, the remote device assigns
you a remote IP address and displays it in the Remote IP field in Setup’s
Session Manager Configuration Menu.

Script

When you choose to connect via a script, the value you enter in the Script field
names the parameter listed in Setup’s Network Tables and Utilities > Script
Parameters. (See Figure 5-32 on page 5-83.) NCBridge 3.2 (or higher) ships
with three sample scripts (start_ppp, start_man, and start_isp) found in the /
tekxp/boot/config/script directory. The first of these is the default script when
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you select Script as your connection method in the Session Manager
Configuration Menu; the second starts when you select Manual; the third is
included only as an example. You may use these scripts or create your own.

Figure 5-32 Script Parameters Configuration Table
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Connecting Via xpsh
While it might not make sense to connect via PPP through the xpsh command
(which requires you to be connected to another server in the first place), it is still
possible to do so with this command:

xpsh -display <display_name>:0 pppd <parameters>

Connecting Via the xp.cnf File
If the system administrator has set up the PPP parameters in the xp.cnf file for
remote network computer users, the PPP session starts automatically after the
network computer boot.

Terminating PPP
With TekLogin, click the Disconnect button on the main menu. In Setup, go
to Configuration Summaries > PPP and click Disconnect.

Note: When clicking the Disconnect button, PPP does not send the
disconnect string to the serial port to reset the modem. When
this occurs, turn off/on your modem to reset the modem.
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Screen Saver Support
Kiosk administrators can use the screen saver support feature. NCBridge version
3.1 or higher provides a local client ssadvt that allows a customer to display a
series of gif images as a screen saver on the network computer. Rather than having
the network computer screen simply blank after a specified period of inactivity,
system administrators can now display advertisements, corporate-endorsed
images, and other images of general interest on inactive network computers. In
non-kiosk systems, system administrators can implement the screen saver over an
entire network, so that all network computers display the same images.

Note: “Screen savers” do not prolong the life of a monitor. At best,
a screen saver turns off the video information; this prevents
images from being burned into the phosphor. Screen savers
do not turn off the filaments that heat the cathode, which is
what generally wears out in a monitor first. A better way to
“save” your screen is to select “PowerSave” in the Screen
Saver field in Setup’s main menu. This automatically saves
the screen, the cathode, the CRT, and electrical energy.

You can use xp.cnf or the xpsh command to start the screen saver local client
ssadvt. Once started for a network computer, you cannot kill or override the
process without rebooting the network computer.
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Starting the Screen Saver with the xp.cnf File
To start the ssadvt client using xp.cnf, add a line similar to this one to your
xp.cnf file:

start SSADVT YES –args " –t 600 –c 60 –f /home/ssadvt.list"
#<[ON | OFF]>

…where –t indicates the timeout in seconds, –c indicates the cycle time in
seconds, and –f indicates the NFS-mounted file with the list of gif images to be
displayed.

In this example, when the network computer has been inactive for a period
equal to ten minutes (600 seconds), the screen saver displays the first image in
the file /home/ssadvt.list. After a minute, the next image in the file is displayed,
and so on until the end of the file is reached, then it loops to the beginning and
starts over. If a user “interrupts” the stream of screen saver images, for example
by moving the mouse, the screen saver resumes with the next image in the list
during a subsequent ten-minute period of inactivity.

Example 1-2. Screen Saver List of GIFs (ssadvt.list)

!Do not delete this line.
/local/GIFS/dilbert11.gif
/local/GIFS/subliminal3.gif
/local/GIFS/csun.gif
/local/GIFS/xena17.gif
/local/GIFS/brainwash.gif
/local/GIFS/pointy-hair.gif

The images in the ssadvt.list file must be .gif files; no other image format is
supported. If you include a non-.gif image in the file, that image does not
display. The console should mention the status of opening the file ssadvt.list
and start displaying a different gif every minute.

Starting the Screen Saver with the xpsh Command

To start the ssadvt client using xpsh, enter this command:

xpsh –access <method> ssadvt –t <timeout> –c <cycle> –f <filename>

The default method value is nfs, and since no other method is available at this
time, the –access argument can be omitted entirely; the default timeout value is
ten minutes (–t 600) with a minimum value of 20 seconds; the default cycle time
is one minute (–c 60).
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16-Bit True Color Support
Note: 16-bit true color support is available only on NC200, NC400,

and NC900 models.

NC200 and NC400 network computers with option V2 (or field kit NCFV2)
provides a total of 4MB of video memory. With 4MB of video memory, these
units can take advantage of NCBridge’s 16-bit plane true color support. The
NC900 comes standard with 4MB of video RAM to support 16-bit true color.

When a network computer is configured to operate in 16-bit plane mode, its X
server exports a 16-bit plane TrueColor or DirectColor visual, so your
application can display 65,536 colors instead of only 256 colors in 8-bit plane
mode. That means you will see markedly better visual effects on applications
that can take advantage of 16-bit color depth. Running your network computer
in 16-bit plane mode will also eliminate irksome color flashes that occur when
multiple color-intensive applications run simultaneously.

Configuration

You can configure a NC200, NC400, or NC900 network computer to operate
in this mode either through the Setup client or through the remote configuration
xp.cnf file.

In the Setup client, go to the Configuration Summaries > X Environment
menu and select “16” for the Root Depth field. Then go back to the main menu
and reset the X server by clicking on the Reset Server button. Once the server
is reset, it will operate in16-bit plane mode. If you decide to go back to the 8-bit
plane mode, reset the Root Depth field to “8” and click the Reset Server button
again for 8-bit plane PseudoColor. If you want the network computer to retain
the new root depth settings the next time it is booted, click the Save Settings to
NVRAM button in Setup’s main menu.

To configure the X server to operate either in 8-bit plane or 16-bit plane mode
remotely, add this line to your xp.cnf file:

root_depth 16 # [8 | 16]
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Limitations

There are some limitations with 16-bit plane mode. For one, the WinDD ICA
client requires 8-bit PseudoColor and cannot be used in 16-bit plane mode. If
you try to launch a WinDD ICA client in 16-bit plane mode, the ICA client
writes a message to the console stating that it “cannot find the PseudoColor
visual” and then exits.

Another limitation is that the digital video player vplay cannot be used in 16-bit
mode, due to the fact that current software reserves a color index from the
PseudoColor table for the chromakey that makes vplay work.

All local clients except WinDD ICA and vplay work in 16-bit mode.

24-Bit True Color Support
With NCBridge 4.0.8 or higher, the NC900 series supports a high resolution
(1280x1024) 24-bit true color mode to display high-resolution images. This
mode may be specified using the local Setup, Web-based Administrator or the
remote configuration xp.cnf file.

To configure the NC900 X server to operate in 24-bit mode from the remote
configuration file, add the following line to the xp.cnf file.

root_depth 24 #[8 | 16 | 24]

The Simultiple Color mode also supports a 24-bit true color mode; however, the
NC900 resolution is limited to 1024x768 when it is in Simultiple Color mode.

Limitations

Some X Clients, such as the WinDD ICA client, will only run when 8-bit planes
are allocated for Pseudo Color. Hence, the WinDD ICA client will not run in
24-bit true color mode. See Simultiple Color for additional bit plane capability
that will allow the WinDD ICA client to run on the NC900.

Simultiple Color for the NC900
The NCD NC900 Series offers Simultiple Color, which supports simultaneous
multiple color depths. With Simultiple Color, X11 applications, such as either
a local or host-based Netscape Navigator browser, can be displayed in 24-bit
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color while 8-bit color applications are simultaneously displayed on the same
screen. The following figure provides a graphical representation of how
Simultiple Color works.

With NCBridge 4.0.4 or higher, the NC900 offers three new root depth
parameters for supporting Simultiple Color:

• 8 & 16-bit

• 16 & 8-bit

• 24 & 8-bit

Any of these three new root depth parameters may be specified from the NC
remote configuration file, Web-based administrator or the local Setup menu.

In order to specify one of the new root depth parameters using the local Setup
menu, select Configuration Summaries, then select X Environment and finally
select the desired Root Depth.

8 & 16-bit Mode

In the 8 & 16-bit mode, the root window is defined to be 8-bits deep. This mode
allows both 8-bit and 16-bit color applications to be displayed simultaneously.
Either the local or host-based Netscape Navigator browser will automatically
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be displayed in 16-bit color. The colors used by the browser will remain stable
and not change when the user selects other application windows. Also, the
browser colors will not interfere with the 8-bit color applications.

8 & 16-bit Mode Limitations

Color flashing may occur between multiple 8-bit color applications that define
their own colormap. Therefore, the preferred mode for eliminating color
flashing is either the 16 & 8-bit mode or the 24 & 8-bit mode. Both of these
other modes are designed to further reduce color flashing by displaying the X11
applications with more colors.

The maximum resolution supported in 8 & 16-bit mode is 1280 x 1024.

Note that in 8 & 16-bit mode, the Default Root Visual should be set to
PseudoColor, which would apply to the 8-bit root window.

16 & 8-bit Mode

In the 16 & 8-bit mode, the root window is defined to be 16-bits deep. This
mode is preferred to the 8 & 16-bit mode for eliminating color flashing between
applications since most X11 applications can be displayed in 16-bit color. The
local ICA client has been tuned to display its window in the secondary 8-bit
color mode.

16 & 8-bit Mode Limitations

Some X11 applications may only be displayable when the root window is 8-bits
deep. Such applications are not intelligent enough to identify the second 8-bit
color mode. Therefore, for these 8-bit color applications, the NC900 offers the
8 & 16-bit mode described above, which defines the root depth to be 8-bits.

In 16 & 8-bit mode, some color flashing may occur between multiple 8-bit color
applications, such as two local ICA clients. However, there is likely to be less
color flashing in the 16 & 8-bit mode than the 8 & 16-bit mode since most X11
applications will display their applications in the 16-bit color, which prevents
color flashing.

The maximum resolution supported in 16 & 8-bit mode is 1280 x 1024.

Note that in 16 & 8-bit mode, the Default Root Visual is always TrueColor.
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24 & 8-bit Mode

In the 24 & 8-bit mode, the root window is defined to be 24-bits deep. This
mode provides the best color fidelity for displaying X11 applications while also
providing 8-bit color for displaying ICA-based PC applications. Either the local
or host-based Netscape Navigator browser will be automatically displayed in
24-bit color. Color flashing will not occur between the 24-bit color applications.

24 & 8-bit Mode Limitations

Some X11 applications may not be displayable when the root window is not
8-bits deep. Such applications are not intelligent enough to identify the second
8-bit color mode. Therefore, for these 8-bit color applications, the NC900
offers the 8 & 16-bit mode described above, which defines the root depth to be
8-bits.

In 24 & 8-bit mode, some color flashing may occur if multiple 8-bit color
applications are displayed, such as with two local ICA clients. However, there
is likely to be less color flashing in the 24 & 8-bit mode than with the 8 & 16-bit
color depth parameter since most X11 applications can display their
applications in the 24-bit color mode, which prevents color flashing.

The maximum resolution supported in 24 & 8-bit mode is 1024 x 768.

Note that in 24 & 8-bit mode, the Default Root Visual is always TrueColor

Note that when using the local Setup menu to select the Root Depth, the user
must select Save Settings to NVRAM and then select Reset Server before the
new root depth is activated. These two button selections are located on the main
Setup menu.
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Web-Based Administrator
The Web-based Administrator allows a system administrator the ability to view
a network computer’s setup parameters using a standard Internet browser, like
Netscape Navigator. If a network computer parameter is set incorrectly, the
administrator can identify the problem from his own desktop and change the
parameter to the appropriate value without having to visit the user’s desk.

Implementation
Using the start command in the xp.cnf file, start the network computer’s local
HTTP server. Here is an example:

start http YES

After you put this command in the xp.cnf file, reboot the terminal for it to take
effect.

When a browser points to the network computer’s IP address, the network
computer provides its setup parameters.

Note: A password may be defined for security reasons in the xp.cnf
file so that other users may not view or change a network
computer’s setup parameters.

To Access the Web-Based Administrator
1. Bring up Netscape Navigator.

2. Go to the File > Open menu.

3. Type in the IP address of your network computer. For example, if your
network computer’s IP address is 192.1.2.3, you would type in:
http://192.1.2.3/

4. This should bring up the NC Setup menu within your browser.

Password
If a password is set in the NC, then when the brower connects to the NC, a login
window displays to request username and password. You may ignore the
username, but you must enter the password.

Note: Click Apply to activate your changes.
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Figure 5-33 NC Parameters Viewed with the Web-based Administrator
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Seriald Provides Remote COM Support for 
Windows NT Applications

Seriald is a local daemon that executes on the network computer. It provides the
ability for a Windows NT application to transmit and receive data to and from
a peripheral device connected to a remote network computer serial port. Typical
peripheral devices include printers, credit card readers, and PalmPilots.
Figure 5-34 shows how peripheral devices, Windows NT servers running NCD
ThinPATH Plus, and network computers running Seriald are connected.

Figure 5-34 How Seriald Redirects Data to a Peripheral Device

Seriald interacts with the ThinPATH Plus software, which runs under Windows
NT 4.0, Terminal Server Edition (TSE). ThinPATH Plus adds suppport for
peripheral devices such as local printers.

For example, as an NT application transmits data to a standard COM port,
ThinPATH Plus intercepts the data and redirects it to the network computer
located on the network. Upon receiving the data, the Seriald daemon passes the
data on to the network computer serial port where the peripheral device is
connected.

Seriald provides several benefits. For example, Seriald makes it possible for an
unmodified NT application to interact with a peripheral device connected to a
remote network computer serial port. Seriald also provides the ability to
synchronize the data on a PalmPilot with an application executing on an NT
server.
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By default, Seriald automatically starts when the network computer boots
(restarts). You can use these two xp.cnf commands to control the Seriald
daemon:

start SERIALD NO # [YES | NO]

preload SERIALD PERM # [NO | TEMP | PERM]

Refer to the NCBridge Reference Manual for details on how the xp.cnf
commands work.

Note: ThinPATH Plus also supports redirection of audio and LPT
data from an NT application to either a PC or a ThinSTAR
Windows-based terminal; however, these features are not
supported on the network computer at this time.

For more information about the ThinPATH Plus software, see the Network
Computing Devices, Inc. (NCD) website, www.ncd.com, under Products.

XDMCP_keepalive
When the NC uses the XDMCP protocol to connect to a host computer, the
xdmcp_keepalive feature is available for automatically checking to see if the
host session is still communicating with the NC. This feature is designed to
close all windows should the NC determine that communication has ceased
between the NC and the XDM session. The windows are closed to notify the
user that the session has terminated. The absence of communication may be due
to a network failure.

Implementation
With xdmcp_keepalive enabled, the NC will wait for a predefined time interval
to expire and if no communication has taken place, the NC will send a message
to the XDM session and wait for a response. For example, the default timeout
interval is 3 minutes. If no communication occurs for three minutes, the NC
will send a message to the XDM session. If the session does not respond, the
NC will try to send two more messages. If the XDM session still does not
respond, the NC will close all windows on the screen. The NC closes all
windows in order to notify the user that the host is no longer responding.



Chapter 5 Using Advanced Features

5-96 NCBridge User Manual

One other note regarding the xdmcp_keepalive feature is that when the host
XDM session fails to respond and the NC closes all windows, the NC may also
automatically redisplay the HostMenu with the list of available xdm hosts,
provided:

1. The NC has flash memory.

2. The HostMenu binary is stored in the flash memory.

3. The NC is set up to display the HostMenu using the
Host_Connect_Method parameter.

XP.cnf Commands Associated with xdm_keepalive
1. xdmcp_keepalive: enable or disables the feature, parameter range: on or off

2. xdmcp_keepalive_timeout: defines interval of no activity before the NC will
send a message to xdm session, parameter range: 1-255 minutes, default 3
minutes

3. xdmcp_keepalive_wait_timeout: length of interval before the NC will send
a follow-up message to the XDM session after the previous message was not
answered, parameter range: 1-255 seconds, default 20 seconds

Other Relevant Information
If either the console or the launcher clients (or both) are displayed, the session
won't ever time out. Both console and launcher constantly do XSync's which
cause messages to go between themselves and the X server and that causes the
X server to think that host xdm session is still alive. The NC X server doesn't
distinguish local clients from host-based clients.

Termctrl Client
The termctrl client can be used from a remote host to:

• Reboot the NC

• Reset the NC’s X server

• Restart the NC’s local MWM client
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The following are three different examples as to how to use the termctrl client
from a host computer in order to cause an action on an NC located on the
network:

xpsh –display nc_ip_address:0 termctrl –reboot
xpsh –display nc_ip_address:0 termctrl –reset
xpsh –display nc_ip_address:0 termctrl –mwm

Note: For security reasons, the termctrl command does not work on
an NC that has a password defined.

Termctrl Client Application
The termctrl command can be used to reboot numerous NCs on a network by
placing the command in a UNIX script and issuing the command repeatedly
while only changing the display variable value. This type of application would
be useful when the system administrator has loaded a new version of NCBridge
on the boot host and wants to reboot all of the NCs on the network so that the
NCs are running the latest software. The script can be set to run at midnight
when no users are working with their NCs.

Using the Termctrl Client with the Launcher
The termctrl client may be used from the local Launcher menu, such as to restart
the local MWM client. The following describes how to add a selection to the
Launcher menu that would allow the user to restart the local MWM.

The contents of the menu items in the Launcher menu are defined in the
system.launcher file, which is located in the following directory:

/<NCBridge install directory>/tekxp/boot/config

The following is how the MAINMENU is typically defined in the
system.launcher file.

MAINMENU
“Setup” f.exec “setup”
“Console” f.exec “console”
“HostMenu” f.menu HOSTMENU
“Host Connections” f.menu HOSTCONNECTIONS
“Window Managers” f.menu WMMENU
“Quit” f.exec “quit”

The following adds one line to the MAINMENU. This additional line will
allow the user to restart the local mwm client.
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MAINMENU
“Setup” f.exec “setup”
“Console” f.exec “console”
“HostMenu” f.menu HOSTMENU
“Host Connections” f.menu HOSTCONNECTIONS
“Window Managers” f.menu WMMENU
“Restart MWM” f.exec “termctrl –mwm”
“Quit” f.exec “quit”

Now when the user displays the local Launcher menu, the new selection
“Restart MWM” will be displayed on the menu. When the user selects this
menu item, the MWM borders surrounding all windows will disappear because
the local MWM client is being terminated. A few seconds later, the borders will
reappear on all windows and the user will be able to perform all MWM
functions. The application windows themselves will not disappear during this
action.
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Chapter 6
Troubleshooting

Solving Power Problems
If you press the power button(s) and nothing happens:

• Check the back of the network computer and separate logic module (if you
have one) to verify the power cord is firmly attached.

• Check the electrical outlet to make sure the power cord is firmly plugged in.

• Try a different electrical outlet, or try plugging something else into the outlet
to verify the outlet has power.

If keyboard lights flash or a bell sounds but nothing is displayed on the screen:

• On the network computer, check to see if the video cable is connected to the
video port.

• On the monitor, check to see if the video cable is connected to the correct
video inputs (video in).

Solving Boot Problems
If the network computer powers up, but the boot fails, there are various options
to try. After each option, try to boot the network computer from the BOOT>
prompt by typing b or boot and then pressing Enter.

• Verify that the network computer keyboard, mouse and network cables are
all firmly attached.

For advanced users who have access to the NCBridge Reference Manual, refer
to Chapter 4, Boot Monitor and do the following:

• Verify the boot method. It typically is TFTP or NFS for UNIX computers,
MOP for DEC computers, or ROM if you have an optional Flash or ROM
option.

• Verify host and gateway communications from the boot monitor with ping.
If ping does not find the host, verify the host and network computer subnet
masks are correctly set.



Chapter 6 Troubleshooting

6-2 NCBridge User Manual

• If an error message says the boot file is not found:

– Verify that the expected information was obtained from the network.

– Verify that the boot path is correct. It should contain both the path and the
boot file name.

– Verify that all the files have world read permissions.

• If the configuration files are not found:

– Verify the messages to determine which host is being polled for the files.

– Verify that the primary and secondary paths are correctly set.

– Verify the paths and read permissions on the files.

Solving Log in Problems
If your network computer boots, but you are unable to log in:

• If the mouse or keyboard does not respond, check the cables and then reboot.

• If an error message is generated saying that the log in failed:

– Retry entering your username and password.

– Verify you are connected to a host where you have a login account.

• If a message is displayed saying that a connection timed out, restart the
connection as detailed in the Logging In to the Network Computer topic on
page 2-3.

• Check the Console window for error messages. Refer to the next topic, The
Console Window on page 6-3.
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The Console Window
The Console window is a valuable tool for determining what is happening on
the network computer. It enables you to see messages the network computer
generates, such as a confirmation that a file was located or that a command
generated an error. You must explicitly open and close the Console window
through the Client Launcher.

Opening the Console Window
You can display the Console window at any time. To open the Console
window:

Select Console from the Client Launcher. If you need a refresher on the
terminology used in these procedures, refer back to the Mouse Operations
topic on page 1-5.

The Console window shown in Figure 6-1 appears on your screen.

Figure 6-1 Console Window

This window is updated each time the network computer receives a
confirmation or error message. You cannot delete or add to the information that
appears in the Console window. The network computer’s address and name (if
defined) appear on the title bar of this window.

Launcher

Console

Console: IP=134.62.64.14 (baldwin)

Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutRS12.snf   Found
Opening for NFS read:  /host/tekxp/boot/xbcast.10   Found
TekHostMenu:  TDEnet Not Setup;
VMS TDEnet and Cterm lists not available.
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutBI18.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutBI24.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/misc/6x13.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutBS12.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutRS12.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/misc/olgl12.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/system.launcher   Not Found
Opening for TFTP read:  /home/tekxp/boot/config/system.launcher on host 170.93.13
.43   Found
Using Automatic Configuration Data.
Opening for NFS read:  /host/tekxp/boot/tek220.10   Found
Opening for NFS read:  /host/tekxp/boot/app-defaults/Tekterm   Found
Opening for NFS read:  /host/tekxp/boot/telnet.10   Found
Opening for NFS read:  /host/tekxp/boot/LuV2RT12.pcf.z   Found

E

8049-146
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Using the Console Window
Often there is more information available than will fit in the Console window.
Since the Console window cannot be resized, use the methods listed below to
view additional information. You can also copy and paste information from the
Console to a command window.

• To display the previous screen of messages:

Position the mouse pointer in the scroll bar anywhere above the slider box
and click the Select (left) button.

• To display the next screen of messages:

Position the mouse pointer in the scroll bar anywhere below the slider box
and click the Select (left) button.

• To scroll through the messages one line at a time:

Position the mouse pointer on the up or down arrow (on the scroll bar) and
click the Select (left) button once for each line.

• To clear the contents of the Console window:

Click on the Erase icon. The Console scrolls to just below the last line of
information. Drag the slider box up to view the Console information.

• To copy information from the Console window and place it in the Console
buffer:

Position the mouse pointer on the first character to copy and click the Select
(left) button. Drag the mouse to the last character to copy. The selected text
is highlighted.

• To paste information from the Console buffer into a window:

Position the mouse pointer in the window where you want to paste the
information and click the Menu (middle) button. Information can be pasted
in Telnet, Cterm, Lat, and xterm windows.

Closing the Console Window
Select Console from the Client Launcher.

The Console Window will disappear from your screen.

Launcher
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Remote Diagnostics
NCBridge offers two different methods for a system administrator to
remotely troubleshoot a problem a user is having with a network computer.

In the first method, administrators use the Web-Based Administrator (see the
Web-Based Administrator topic on page 5-92) to view and change the
parameter settings of a remote NC.

The second method provides a way for administrators to display the remote
NC’s Setup Screen on their own X terminal device. The command in the
following example shows how to display the NC’s setup screen on another
NC:

xpsh -display 10.2.2.1:0 -xpenv “TEKSETUP_DISPLAY=10.2.2.3:0” setup

In this example, the -display device is the device where the setup client
is running. For the xpsh command to work, the X terminal must not be
already running the setup client.

The TEKSETUP_DISPLAY device is where the user wants the setup client to
be displayed. The device where setup is displayed must first be running an X
server and secondly, it must allow other devices to access its X server. (On
workstations, use the command xhost + to allow other devices to access the
X server.)
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Appendix A
Special Keyboard Characters

This appendix describes how to work with special characters on different
keyboards.

• Entering North American Special Characters from International Keyboards
tells how to enable data processing keys so that you can use the North
American character set on international keyboards.

• If you are using an LK401/VT200-style keyboard, refer to the Compose and
Diacritical Sequences topic on page A-22 for information on creating special
characters and symbols by using compose characters.
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Keyboard Charts
Figures A-1 through A-11 show examples of the standard types of keyboards
available with the network computers. Refer to Appendix B, Keyboards in the
NCBridge Reference Manual for information about the key codes (the numbers
below the keys in the following figures).

Figure A-1 101 with Pause North American Keyboard
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Figure A-2 101 with Setup North American Keyboard

Figure A-3 102 with Pause United Kingdom Keyboard

A S D F G H J K L

#

Esc

!
1 2 3 4 5

%
6

&
7 8

(
9

)

?

0 =

F1 F2 F3 F4 F5 F6 F7 F8

Q W E R T Y U I O P

*@

\

Caps
Lock

Z X C V B N M >

_
-

<
.,

Alt Alt Option

Insert Home
Page
up

EndDelete

F9 F10 F11 F12

Num
Lock -

+

Enter

DelIns

End

Home Pg Up

Pg Dn

987

4 5 6

321

Num
Lock

3 2 1

0 .

Line
Feed Break Setup

Page
Down

~ +

Shift Shift

Enter

/

'
"

;
:

[
{

]

}

$ ^

Ctrl

Tab

*

Caps
Lock

/

8051-10A

16 15 23 31 39 47 55 63 71 79 87 94 102 95 103 106

111 118 11911093867778706962544546383022

98

99928576756861525344372921

908483746759605143353628

8281736657585041423426 97

25 33 49 65 96

108 109 117

107

105 104 114

126 127 134 140

116 125 133

132

115 123 124

113 122 130

129

120 121

100

A S D F G H J K L
#

Esc

!
1 2

"
3 4 5

%
6

&
7

*
8

(
9

)

?

0 =

F1 F2 F3 F4 F5 F6 F7 F8

Q W E R T Y U I O P

~

Ctrl

>Z X C V B N M

:
;

<

Alt Alt Gr Ctrl

Insert Home
Page
Up

EndDelete

F9 F10 F11 F12

Num
-

+

Enter

DelIns

End

Home Pg Up

Pg Dn

987

4 5 6

321

0 .

Print
Screen

Setup
Pause

Page
Down

+
*/^$

`

|

-
_

{
[

}
]

@

/.,\

Num

8418-8

16 15 23 31 39 47 55 63 71 79 87 94 102 95 103 106

111 118 11911093867778706962544546383022

98

99928576756861525344372921

91908483746759605143353628

828173665758504142342726 97

25 33 49 65 96

108 109 117

107

105 104 114

126 127 134 140

116 125 133

132

115 123 124

113 122 130

129

120 121



Appendix A Special Keyboard Characters

A-4 NCBridge User Manual

Figure A-4 102 with Setup United Kingdom Keyboard

Figure A-5 VT200/LK401–Style North American Keyboard
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Figure A-6 UNIX Keyboard

Figure A-7 3270 Keyboard

Note: For details about the 3270 keyboard, see the 3270 User Manual.
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Figure A-8 Sun V Keyboard, KS 1

Figure A-9 105 Windows 95 Keyboard, Europe
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Figure A-10 104 Windows 95 Keyboard, North American

Figure A-11 Eurokey Keyboard
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Entering North American Special Characters 
from International Keyboards

Some data processing programs require entry of characters from the North
American keyboard that are not available on all international keyboards. The
characters needed but not always available are: { } [ ] \ @ # * $ |

To permit entry of the full North American character set from all keyboards,
some international keyboards have one or more keys with dual legends on them.
Legends on the left of LK401/VT200 keyboards are typewriter legends and
legends on the right are data processing (DP) legends. (Legends on the right of
102-key keyboards are alternate graphic legends.)

You can enable DP legends for the LK401/VT200 keyboards from the Main
Menu of Setup. The Main Menu displays a DP Mode item when you set
Keyboard Type to VT200 and Language to one of the international languages.
When you need these special symbols, enable the DP keys by clicking DP
Mode to On. Click this item to Off when you need the usual national characters
of the keyboard. If you want to run TekXpress compose, load the compose
sequences. For details, refer to the Compose and Diacritical Sequences topic on
page A-22 of this appendix.

If TekXpress compose is enabled, you can also access DP legends from the
keyboard (rather than through Setup) by using Compose sequences. To enter a
DP legend, press the Compose key and then the desired key. So that you can
enter all ASCII characters, several keyboards have compose sequences for DP
keys that do not have DP legends on the keycaps. These compose sequences
appear in the tables that follow. For more information about Compose
sequences, refer to the Compose and Diacritical Sequences topic on page A-22.

When DP mode is off, the two-key sequences for accessing DP characters
(Tables A-1 through A-9) supersede the three-key compose sequences
involving the Compose-DP keys.
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Tables A-1 through A-9 summarize the DP characters that are sent for each
LK401/VT200-style international keyboard. These tables show both the
Typewriter Mode and Data Processing Keys mode. As noted, some compose
sequences do not have DP legends. Keyboards not appearing in these tables do
not offer DP keys.

Table A-1 VT200/LK401 Danish Keyboard

Mode

VT200
Key
State

DP Keys Compose–DP Keys

§ @
3

Å [
]

Ø \
#

*
’

(
8

)
9

Typewriter Normal 3 å ø | { }

Shft § Å Ø

Data Processing
Keys

Normal 3 ] #

Shft @ [ \

LK401
Key
State

§ @
~

£ #
3

Æ [
{

Å ]
}

Ø \
|

*
’

(
8

)
9

Typewriter Normal ~ 3 æ å ø | { }

Shft § £ Æ Å Ø

Data Processing
Keys

Normal ~ 3 { } |

Shft @ # [ ] \
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Table A-2 VT200/LK401 French Keyboard

Mode

VT200

Key
State

DP Keys Compose–DP Keys

6
§ [

7
è ]

%
ù \

@
#

9
ç

0
à

Typewriter Normal § è ù | { }

Shft 6 7 %

Data Processing
Keys

Normal [ ] \

Shft 6 7 %

LK401
Key
State

6
§ [

7
è ]

%
ù \

2
è |

9
ç {

0
à }

@
#

9
ç

0
à

Typewriter Normal § è ù 2 9 0 | { à

Shft 6 7 %

Data Processing
Keys

Normal [ ] \ è ç à

Shft 6 7 % | { }
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Table A-3 VT200 German Keyboard

Mode

VT200
Key
State

DP Keys Compose–DP Keys

Ü \
@

Ä [
]

’
#

(
8

)
9

Typewriter Normal ü ä | { }

Shft Ü Ä

Data Processing
Keys

Normal @ ]

Shft \ [

Table A-4 LK401 German Keyboard

Key Cap

Typewriter
Data Processing

Keys
Compose–DP

Keys

Normal Shft Normal Shft

, # |

( 8 {

) 9 }

°
^ ¬

^ ° ¬ °

! ¡
1 1

1 ! 1 ¡

"
2 2

2 " 2 "

§ £
3 3

3 § 3 £
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$ ¤
4 1/4

1/4 ¤

%
5 1/2

% 1/2 %

&
6 3/4

6 & 3/4 &

/
7 {

7 / { /

(
8 [

8 ( [ (

) ±

9 ]

9 ) ] ±

= °
O }

O = } °

? ¿
β \

β ? \ ¿

`
´ ¸

´ ` ¸ `

Q
@

q Q @ Q

R 
¶

r  R ¶ 

Z ¥ z Z z ¦¥

O Ø o O Ø o

Table A-4 LK401 German Keyboard (continued)

Key Cap

Typewriter
Data Processing

Keys
Compose–DP

Keys

Normal Shft Normal Shft
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P ρ p P p ρ

Ü ° ü Ü ¨ °

* –
+

+ * ~ –

A Æ a A æ Æ

S §
 β

s S β §

D D
δ

d D δ D

F ª f F f ª

; X
,

, ; , X

K & k K k &

Ö
′ 

ö Ö ′ Ö

Ä
^

ä Ä ^ Ä

´¦
# `

# ´ ` ´

>
< 

< > 

Table A-4 LK401 German Keyboard (continued)

Key Cap

Typewriter
Data Processing

Keys
Compose–DP

Keys

Normal Shft Normal Shft
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Y <
y <<

y Y << <

X >
x >>

x X >> >

C 
¢

c C ¢ 

M º
µ

m M µ º

: ÷
. •

: • ÷

Table A-4 LK401 German Keyboard (continued)

Key Cap

Typewriter
Data Processing

Keys
Compose–DP

Keys

Normal Shft Normal Shft
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Table A-5 VT200/LK401 Italian Keyboard

Mode

VT200
Key
State

DP Keys Compose–DP Keys

1
£ @

2
é #

9
ç [

0
à ]

§ \
*

%
ù

=
`

§
$

Typewriter Normal £ é ç à * | { }

Shft 1 2 9 0 §

Data
Processing

Keys

Normal @ # [ ] *

Shft 1 2 9 0 \

LK401 Key
State

1
£ @

2
é #

9
ç [

0
à ]

§ \
*

%
ù {

=
; }

!
ò |

%
ù

=
`

§
$

Typewriter Normal £ é ç à * ù ; ò | { }

Shft 1 2 9 0 § % = !

Data
Processing

Keys

Normal @ # [ ] * { } |

Shft 1 2 9 0 \ % = !
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Table A-6 VT200/LK401 Norwegian Keyboard

Mode

VT200

Key
State

DP Keys Compose–DP Keys

§ @
3

Å [
]

Æ \
#

*
’

(
8

)
9

Typewriter Normal 3 å æ | { }

Shft § Å Æ

Data Processing
Keys

Normal 3 ] #

Shft @ [ \

LK401
Key
State Å ]

}
Æ [

{
Ø \

|
*
’

(
8

)
9

Typewriter Normal å æ Ø | { }

Shft Å Æ Ø

Data Processing
Keys

Normal } { |

Shft ] [ \
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Table A-7 VT200/LK401 Spanish Keyboard

Mode

VT200
Key

State

DP Keys
Compose–DP

Keys

¡ \
¿ @

ª [
º ]

~
ç

(
8

)
9

Typewriter Normal ¿ º | { }

Shft ¡ ª

Data Processing
Keys

Normal @ ]

Shft \ [

LK401
Key
State

¡ \
¿ @

ª [
º ]

Ñ }
{

~
ç |

~
ç

(
8

)
9

Typewriter Normal ¿ º ñ ç | { }

Shft ¡ ª Ñ ~

Data Processing
Keys

Normal @ ] { |

Shft \ [ } ç
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Table A-8 VT200/LK401 Swedish/Finnish Keyboard

Mode

VT200
Key

State

DP Keys Compose–DP Keys

§ @
3

¤ $
4

Å [
]

Ü \
#

Ä
(
8

)
9

Typewriter Normal 3 4 å ü { }

Shft § ¤ Å Ü |

Data
Processing

Keys

Normal 3 4 ] #

Shft @ $ [ \

LK401
Key
State

§ @
3

$
4

Å [
]

Ü \
#

Ö {
}

Ä |
Ä

(
8

)
9

Typewriter Normal 3 4 å ü Ö ä { }

Shft § $ Å Ü Ö Ä |

Data
Processing

Keys

Normal 3 4 ] # } ä

Shft @ $ [ \ { |
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Table A-9 VT200/LK401 Swiss/German Keyboard

Mode

VT200
Key

State

DP Keys Compose–DP Keys

ç @
4

è \
ü

é [
ö

à ]
ä

£ #
$

£ #
$

(
8

)
9

Typewriter Normal 4 ü ö ä $ | { }

Shift ç è é à £

Data Processing
Keys

Normal 4 ü ö ä $

Shift @ \ [ ]

LK401
Key
State

ç @
4

è \
ü |

é [
ö {

à ]
ä }

£ #
$

£ #
$

(
8

)
9

Typewriter Normal 4 ü ö ä $ | { }

Shift ç è é à £

Data Processing
Keys

Normal 4 | { } $

Shift @ \ [ ] #

Table A-10 VT200/LK401 United Kingdom Keyboard

Mode
Key
State

DP Key

£ #
3

Typewriter Normal 3

Shft £

Data Processing
Keys

Normal 3

Shft #
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Eurokey Support
NCBridge 4.1 includes two fonts (7x13 euro and 7x13 euroB) in the boot
directory. These fonts can be specified by an application so that the user can
display the Euro characters within an application. The EuroSign keysym value
is 0x00A4. Table A-11 lists the keystrokes used to display the Euro characters
within an application..

Example 1-3. Setting up the NC900 to use the Euro Key

This example demonstrates how to map the F12 function key to the Euro key
so that the Euro key may be displayed within an xterm window. The Euro
character is defined in the font file 7x13euro. The 7x13 euro file is located in:

<NCBridge install directory>/tekxp/boot

The F12 function key on the North American Windows 95 keyboard has a key
code of 102. To confirm the keycode for your keyboard, use the standard xev
application on a UNIX server.

Table A-11 EuroSign Character Support

Keyboard Country Keystroke

102 Setup & 102 Pause,
including support for
Windows 95 keyboards

Danish
French
Finnish
German
Italian
Norwegian
Spanish
Swedish
Swiss-German
United Kingdom

AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+4

3270 French
German
United Kingdom

AltGr+E
AltGr+E
AltGr+4

Sun V French
German
United Kingdom

AltGr+E
AltGr+E
AltGr+4
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The following command maps the Euro key to the F12 function key.

xmodmap -e “keycode 102 = 0x00a4”

The following command starts the xterm application and specifies the font file
7x13euro.

xterm -fn 7x13euro

Now when the focus is on the xterm window and you press F12, the Euro
character is displayed in the xterm window.
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Eurokey Keysym Not Displayed Correctly
The xmodmap and xev programs do not correctly display the name of the
Eurosign keysym. Instead, it is displayed as the following:

0x20ac (no name)

The keysym can still be accessed and the keyboard mapping modified, if
necessary, using the hexadecimal value 0x20ac. For more information about the
Eurokey keysym, see Appendix B, Keyboards in the NCBridge Reference
Manual.

Compose and Diacritical Sequences
On LK401/VT200-style keyboards you can use compose characters to type
special characters and symbols that are not available as single keystrokes.
These might be common characters, such as the cent sign (¢), or letter forms
particular to a certain language, for example, a lowercase “e” with an acute
accent.

Network computers directly support compose characters for all X11 clients
with LK401/VT200 keyboards, other than North American. DEC VMS and
ULTRIX X applications provide their own compose characters. Refer to your
DECWindows documentation for information about DEC compose characters.

To use DEC compose characters:

1. Select Setup from the Client Launcher. Select either VT200/LK401
ULTRIX (ESC) or VT200/LK401 VMS (F11) as the Keyboard Type.

2. Set the Compose Sequences option to No.

3. Use a DEC VMS or ULTRIX X application.

4. Begin a compose sequence by pressing the Compose key.

Launcher
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To use TekXpress compose characters:

1. Select Setup from the Client Launcher.

2. Select VT200/LK401 X (ESC-BS-LF) or VT200/LK401 X (F11-F13)
as the Keyboard Type.

3. Set the Compose Sequences option to Yes.

4. Select a Keyboard Nationality. (To use North American, use xmodmap
to clear the modifier by entering this command:

xmodmap –e "clear mod1")

There are two ways to compose TekXpress compose characters:

• Press a diacritical key (described in the Using the Diacritical Keys topic on
page A-24), and then the character to be combined with it (valid
combinations are shown in Table A-12 on page A-25).

• Press the Compose key (described in the Using the Compose Key topic on
page A-27), and then type the two composing characters (valid combinations
are shown in Table A-13 on page A-27).

Note: To enter a special character, your application must support
8-bit characters and select fonts. If you cannot enter special
characters, contact your system administrator.

Launcher
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Using the Diacritical Keys
There are from one to five diacritical keys on all international VT200-style
keyboards (except North American). These keys do not send characters when
you press them; rather, they combine with the next character you type to form
a special symbol.

For example, on keyboards for which tilde (~) is a diacritical mark, you
compose the ñ Spanish character by pressing the “~” key and then pressing the
“n” key.

To cancel a diacritical key sequence:

• Press the Delete key, or

• Press another diacritical key (if you want to start a new sequence).

If you type an invalid sequence: the entry is ignored, the bell on the network
computer rings, and the diacritical sequence terminates.

The Compose light turns OFF when you complete the compose sequence.

The acute accent (´) character is a special case: on the keyboard, it shares its
visual representation with the apostrophe (’). Depending on the keyboard
nationality, the keyboard character on the network computer represents an acute
accent (a diacritical mark) or an apostrophe (a character).
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Table A-12 shows the diacritical keys available on various keyboards.

a
Two single-quote symbols appear on the keyboard. The one on the top row of
keys is a diacritical mark and can be thought of as an acute accent (´). The other
one is not a diacritical mark and can be thought of as an apostrophe (’).

b
Two single-quote symbols appear on the keyboard. The one on the top row of keys is not a diacritical mark
and can be thought of as an apostrophe (’). The other one, next to the ñ key, is the diacritical mark.

Table A-12 Diacritical Keys

Keyboard Diacritical Keys

Danish/Norwegiana ` ´ ˆ ¨

French ˜ ` ˆ ¨

Germana ˜ ` ´ ˆ

Italian ˜ ` ˆ

North American none

Spanishb ˜ ` ´ ˆ ¨

Swedish ˜ ` ˆ

Swiss–German ˜ ` ˆ ¨

United Kingdom `
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Variations from DEC Compose Sequences

The following differences exist between the NCD network computer and the
DEC VT200 compose sequences:

• The sequence that generates a double quote on the VT200 generates an
umlaut on the NCD network computer.

• There is no difference on the VT200 between an apostrophe and an acute
accent. Depending on keyboard nationality, you can treat the acute accent on
the keyboard as a diacritical mark (an acute accent). You can access the
apostrophe symbol on the keyboard through a compose sequence.

• The NCD network computer provides compose sequences for dollar sign,
small and capital Icelandic eth, small and capital Icelandic thorn, small and
capital y with an acute accent, three-fourths fraction, division sign,
multiplication sign, acute accent, umlaut, overbar, cedilla, registered sign,
broken vertical bar, not sign, no-break space, and soft hyphen.

• You access TekXpress and DEC three-key compose characters by pressing
Compose, rather than holding the Compose key and pressing the spacebar
as described for DEC workstations.

• DEC compose sequences do not have the "Compose-DP" sequence.
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Using the Compose Key
The Compose key starts a three-key compose sequence for all LK401/
VT200-style international keyboards (except North American). For example, to
compose a cent sign, press the Compose key followed by the “c” and “|” keys.
When you press the Compose key, the Compose light turns ON to indicate that
you are composing a special character.

To cancel a compose sequence:

• Press the Delete key, or

• Press the Compose key (if you want to start a new sequence).

If you type an invalid sequence: the entry is ignored, the bell on the network
computer rings, and the compose sequence terminates.

The Compose light turns OFF when you complete the compose sequence.

Compose Sequences

Table A-13 lists all the compose characters and the two- or three-key sequences
used to form the characters. You can enter the last two keys of three-key
sequences in any order. The notes in the table refer to:

a To compose a character with a three-key sequence, press Compose Character
followed by the two keys shown in this column.

bTwo-key compose sequences are only available on national keyboards that
support the requisite diacritical marks.

c You can use either two apostrophes (’ ’ – available on all keyboards) or two
acute accents (´ ´ – available only on the German, Danish/Norwegian, and
Spanish keyboards) to compose an acute accent.

Table A-13 Compose Sequences for VT200-Style Keyboards

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb

[ Left bracket ( (

\ Backslash / /

/ <
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] Right bracket ) )

{ Left brace ( –

| Vertical bar ^ / ^ /

} Right brace ) –

# Pound sign + +

ˆ Circumflex ^ SP ^ SP

^ ^ ^ ^

˜ Tilde ~ SP ~ SP

~ ~ ~ ~

@ Commercial At sign A A

a a

$ Dollar sign S /

s /

S |

s |

á Apostrophe ’ SP

´ SP ´
SP

á Small a with acute accent ´ a ´ a

Á Capital A with acute accent ´ A ´ A

à Small a with grave accent ` a ` a

À Capital A with grave accent ` A ` A

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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â Small a with circumflex ^ a ^ a

Â Capital A with circumflex ^ A ^ A

ä Small a with umlaut a "

¨ a ¨ a

Ä Capital A with umlaut A "

¨ A ¨ A

ã Small a with tilde ~ a ~ a

Ã Capital A with tilde ~ A ~ A

å Small a with ring a *

× ° a

Å Capital A with ring A *

×° A

æ Small ae ligature a e

Æ Capital AE ligature A E

ç Small c with cedilla c ,

Ç Capital C with cedilla C ,

D Capital Icelandic Eth D –

Small Icelandic eth d –

é Small e with acute accent ´ e ´ e

É Capital E with acute accent ´ E ´ E

è Small e with grave accent ` e ` e

È Capital E with grave accent ` E ` E

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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ê Small e with circumflex ^ e ^ e

Ê Capital E with circumflex ^ E ^ E

í Small i with acute accent ´ i ´ i

Í Capital I with acute accent ´ I ´ I

ì Small i with grave accent ` i ` i

Ì Capital I with grave accent ` I ` I

î Small i with circumflex ^ i ^ i

Î Capital I with circumflex ^ I ^ I

ï Small i with diaeresis i "

¨ i ¨ i

Ï Capital I with diaeresis I "

¨ I ¨ I

ñ Small n with tilde ~ n ~ n

Ñ Capital N with tilde ~ N ~ N

ó Small o with acute accent ´ o ´ o

Ó Capital O with acute accent ´ O ´ O

ò Small o with grave accent ` o ` o

Ò Capital O with grave accent ` O ` O

ô Small o with circumflex ^ o ^ o

Ô Capital O with circumflex ^ O ^ O

ö Small o with umlaut o "

¨ o ¨ o

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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Ö Capital O with umlaut O "

¨ O ¨ O

õ Small o with tilde ~ o ~ o

Õ Capital O with tilde ~ O ~ O

ø Small o with slash o /

Ø Capital O with slash O /

ß Small German sharp s s s

p Small Icelandic thorn p p

P Capital Icelandic Thorn P P

ú Small u with acute accent ´ u ´ u

Ú Capital U with acute accent ´ U ´ U

ù Small u with grave accent ` u ` u

Ù Capital U with grave accent ` U ` U

û Small u with circumflex ^ u ^ u

Û Capital U with circumflex ^ U ^ U

ü Small u with umlaut u "

¨ u ¨ u

Ü Capital U with umlaut U "

¨ U ¨ U

´y Small y with acute accent ´ y ´ y

´Y Capital Y with acute accent ´ Y ´ Y

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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ÿ Small y with diaeresis y "

¨ y ¨ y

No-break space SP SP

1/4 Fraction one-fourth 1 4

1/2 Fraction one-half 1 2

3/4 Fraction three-fourths 3 4

1 Superscript 1 ^ 1 ^ 1

2 Superscript 2 ^ 2 ^ 2

3 Superscript 3 ^ 3 ^ 3

± Plus-or-minus sign + –

÷ Division sign – :

× Multiplication sign X X

x x

¤ Currency sign X 0

X O

x 0

x o

£ Pounds currency sign L –

L =

l –

l =

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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¢ Cent sign C /

C |

c /

c |

¥ Yen sign Y –

Y =

y –

y =

´ Acute accentc ’ ’

´ ´ ´ ´

` Grave accent ` SP ` SP

` ` ` `

¨ Diaeresis or umlaut " SP

" "

¨ SP ¨ SP

¨ ¨ ¨ ¨

— Macron or overbar _ _

¸ Cedilla , ,

– Soft hyphen – -

µ Small mu or micro sign / U

/ u

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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° Degree sign ^ 0 ^ 0

SP *

SP °

º Masculine ordinal indicator O _

o _

ª Feminine ordinal indicator A _

a _

§ Section sign S 0

s 0

S O

s o

¶ Paragraph or pilcrow P !

p !

⋅ Centered dot ^ . ^ .

 Copyright sign C 0

c 0

C O

c o

 Registered sign R 0

r 0

R O

r 0

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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¡ Inverted exclamation mark ! !

¿ Inverted question mark ? ?

« Angle quotation mark left < <

» Angle quotation mark right > >

| Broken vertical bar ! =

¬ Not sign – !

Table A-13 Compose Sequences for VT200-Style Keyboards (continued)

Symbol Description
Compose Sequence

Three-Keya
Two-Keyb
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French Canadian Keyboard
This topic presents three ways to set up a network computer to use a French
Canadian Windows 95 keyboard.

Boot Monitor Method

This method involves entering two commands at the Boot Monitor prompt:

1. Using the keyid command, set the LAYOUT to CUSTOM in the boot ROM.

2. Use the kfile command to set the custom keyboard mapping file name to
kb102frca0001. (You can also use the keyid command to do this.)

Remote Configuration File Method

This is an alternative to entering commands at the NC keyboard:

1. Put these commands in the xp.cnf remote configuration file:

keyboard_type CUSTOM

key_map_file kb102frca0001

Setup Method

Another alternative is to set up the NC for the French Canadian keyboard to use
local setup.

1. In setup, set the Keyboard Type to CUSTOM.

2. Set the Mapping File to kb102frca0001.

Note: You can optionally turn on or turn off the compose sequences
in the file using the compose_sequences YES | NO command
in xp.cnf. Another way to do this is to use the Compose
Sequences button in setup.
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Glossary

Active Window
The window where the input (focus) is directed.

Application Program
Programs such as word processors, transaction processors, and computer-aided 
drafting, that you run on your network computer. Also know as client. See Client.

Aspect Ratio
Aspect ratio refers to the proportion, or ratio, between a window’s width and
height. If you want to maintain the relative proportion between the window’s
width and height when you change the size of a window, set the aspect ratio
setting to ON. Then, when you change a window size, the aspect ratio is
automatically adjusted to preserve the aspect ratio. If this setting is OFF, you can
resize the window to any size and the aspect ratio is not maintained. Aspect ratio
is a window sizing attribute.

Button (on the display)
A small display box that has a raised appearance and contains text. Generally, 
clicking on a button activates a function or performs some action. See Clicking.

Button (on the mouse)
The three buttons on the top of the mouse. See Select, Menu, and Custom.

Clicking
Quickly pressing and releasing the Select mouse button without moving the 
pointer.

Client
An application program that connects to the server. A client program performs a 
variety of tasks, including window management.

Chroma
A term that describes the saturation or vividness of a color. A chroma of 0 
describes a neutral, gray color. Chroma ranges to the most vivid color a screen or 
printer generates for a specific hue and value. See Hue and Value.
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Colormap
Consists of a set of entries defining color values. A pixel value indexes into 
the colormap thereby producing intensities of red, green, and blue which are 
visible on a display.

Command-Line
The line that you type to invoke a program or initiate an action. A command-
line usually contains the name of an X client or application program, along 
with optional arguments known as command-line options.

Cterm
A user-level protocol which is part of the DECnet Protocol set. Cterm 
provides a Network Virtual Terminal, which allows you to log in to a remote 
host on the network as if you are using a terminal directly attached to the 
remote host.

Custom (mouse button)
The factory default defines this as the right mouse button.

Cursor
The visible shape of a pointer on the screen. Defining a cursor for a window 
controls the visible appearance when the pointer is in that window. See 
Pointer.

DAP
See Data Access Protocol.

Data Access Protocol (DAP)
A protocol that provides read and write support for font files, the color 
definition file, or remote configuration files.

Dialog Box
A box where you choose options and enter information. Use the mouse to 
move from field to field, click on buttons and position the text cursor. Enter 
information with the keyboard.
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Display
A device that receives video output from the logic module and displays the 
video output on a screen.

Dragging
Pressing and holding down the Select mouse button while moving the 
pointer.

Ethernet
An IEEE standard protocol used within various networks, including TCP/IP.

Ethernet Address
The factory-defined hardware address of the network computer. Network 
hardware uses the Ethernet address when communicating to the network. 
This address is on the serial number label on the back of the logic module. 
You can also display the Ethernet address by viewing the TCP/IP 
Configuration Summary Menu in Setup.

Event
In the X Window System, information sent by the X server to an X client, for 
example, notification to the client that you pressed a mouse button.

Factory Default
The value assigned to a parameter as delivered from the factory.

Firmware
Software instructions that are permanently stored in the memory of a 
computer and are not lost when you turn the power off. Also called NVRAM.

Hardcopy
A physical copy (typically printed on paper) of a file.

Host Computer
A computer device that controls the exchange of data between itself and 
another network computer. Network computers typically boot from a host.
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Hue
A term that describes a color family (for example, red or yellow). Hue is a 
polar coordinate—that is, it moves in a circular motion around the color 
spectrum—and ranges from 0° to 360°, with 0° being red. Hue is measured 
in degrees. See Chroma and Value.

Index Area
A box on the screen that lets you enter a color index—an integer used to label 
a particular color—from the keyboard.

Input Device
A device that allows you to send information to a window. Typical input 
devices include keyboards, mice, tablets, and trackballs. See Pointer and 
Pointing Device.

Interface
A common connection that is used for sending or accepting information and 
control between programs and machines.

Internet Address (IP Address)
A system administrator-assigned address for the network computer. This 
address is used under TCP/IP when the network software of the network 
computer generates messages to another host. The IP address is in the form 
nnn.nnn.nnn.nnn where nnn is a decimal number in the range 0 to 255. You 
can display the IP address by viewing the Network Configuration Summary 
Menu in Setup.

Internet Protocol (IP)
The network layer protocol for the Internet Protocol Suite. Internet Protocol 
is responsible for addressing and routing packets between hosts.

LAN
See Local Area Network.

LAT
See Local Area Transport.
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Local Area Network (LAN)
The linking together of terminals, network computers, and computers via 
cables and microwave links. This allows you to access more than one 
computer.

Local Area Transport (LAT)
A client which provides a connection to a host computer that supports LAT.

Local Clients
Programs running on the same host as the server.

Logic Module (Base Unit)
A device that gets data from a host, a keyboard, or a peripheral, and 
processes it for viewing on the display. The logic module runs the X server 
and local clients. It can be a separate unit or integrated into the base of the 
monitor.

Memory
A part of a network computer that stores data.

Menu
A list of commands or functions that you select with a pointer. A menu is 
normally displayed in a small window.

Menu (mouse button)
The factory default defines this as the middle mouse button.

Move
Change the location of the pointer on the screen by moving the mouse.

Mouse
An input device that, when moved across a flat surface, causes the pointer to 
move across a screen. The mouse usually has buttons that you press to send 
signals. These signals, in turn, accomplish certain functions. The 
representation of the mouse on the screen is called the pointer. See Pointer.



Glossary

Glossary-6 NCBridge User Manual

Network
The physical wires connecting two or more computers. These connections 
allow information to move electronically between computers.

Network Computer (NC)
A computer that displays information which usually resides on another 
computer. A network computer consists of a display, a keyboard, a mouse or 
other pointing device, a logic module, an X server, and local clients. See 
Display, Logic Module, Mouse, Pointer, and X Server.

Parameter
A variable that is given a specific value. This value is passed to a program 
before execution.

Peripheral Device
A device used to input or output data for the network computer. The XPT/A 
graphics tablet is a supported peripheral device for network computers.

Pixel
The smallest part of a screen surface that can be addressed.

Pointer
The pointer allows you to make selections in menus, to size and position 
windows and icons, and to select the window where you want to send the 
input. The window manager determines the shape of the pointer. See 
Pointing Device.

Pointing Device
Typically a mouse, tablet, or some other device with effective dimensional 
motion. The core protocol defines only one visible cursor, which tracks 
whatever pointing device is attached as the pointer. See Pointer.

Port
A physical connection (such as a multi-pin connector or coaxial connector) 
and its associated firmware, that permits one computing device to 
communicate data and control information with another computing device or 
peripheral device.
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Protocol
A set of rules that allows computers to transfer information across a network 
to other computers that speak different computer languages.

Read-Only Memory (ROM)
Special firmware in the network computer that allows it to boot without 
being connected to a host computer.

RGB
An additive method of combining percentages of red, green, and blue 
primary colors to form other colors.

ROM
See Read-Only Memory.

Root Weave
The window that fills the screen during an X session. All windows opened 
by clients appear on top of the root window. See Stipple Pattern.

RS-232-C
A standard communications interface defined by the Electronic Industries 
Association (EIA) to control data communications using standard voltages, 
signal lines, and device interactions.

Screen
The monitor. This is where text and graphical information is displayed for 
viewing. See Window.

Select (mouse button)
The factory default defines this as the left mouse button.

Setup Key
A special key on the keyboard, marked Setup. Pressing this key takes you to 
the Setup program.
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Serial Port
One or more optional physical connectors on your network computer. Attach 
a serial cable (RS 232) to communicate with a peripheral device such as a 
modem or printer.

Serial Port Session
A session started through one of the serial ports: either Serial Port 0 or Serial 
Port 1.

Server
The combination of graphics display, hardware, and server software that 
provides display services for clients. The server also handles keyboard and 
mouse input. See Client and X Server.

Setup
A local X client program used to configure the network computer.

Software
A set of instructions that tell the computer to perform a certain task in order 
to obtain a specific result. See Client.

Stipple Pattern
In the X Window System, the underlying pattern displayed (with the X 
cursor) when there are no other windows on the screen. If a window is 
created, the window appears on top of the stipple pattern. See Root Weave.

TCP
See Transmission Control Protocol.

TCP/IP
See Transmission Control Protocol/Internet Protocol.

Telnet
A user-level protocol which is part of the Internet Protocol set. Telnet 
provides a Network Virtual Terminal, which allows you to log in to a remote 
host on the network as if you are using a terminal directly attached to the 
remote host.
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HostMenu
A window showing a list of host computer names and network addresses. 
Use the mouse to select a computer where you have a login account.

Terminal
An interactive input/output device used in computer systems or networks.

Text Cursor
The I-shaped pointer which appears in a text input area. Clicking the mouse 
in a text input area causes the text cursor to appear in that area. Whatever 
information you type on the keyboard appears in the text input area 
displaying the text cursor.

TFTP
See Trivial File Transfer Protocol.

Transmission Control Protocol (TCP)
The Internet transport layer protocol which provides a reliable, bi-directional 
byte stream connection between two cooperating user-level processes.

Transmission Control Protocol/Internet Protocol (TCP/IP)
Using the TCP and IP protocols to obtain a reliable, bi-directional byte 
stream connection between two cooperating user-level processes. 
Commonly this refers to the entire Internet Protocol suite, including TCP, IP, 
UDP, ICMP, and other protocols.

Trivial File Transfer Protocol (TFTP)
A protocol used for downloading server images. It is also used for reading 
and writing font files, the color definition file, or remote configuration files.

UNIX
A host operating system.

Value
A term describing the lightness or darkness of a color. Value ranges from 0 
(black) to 100 (white). See Chroma and Hue.
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WinDD
A local ICA client that allows you to access Windows 2000 applications 
using your network computer with Microsoft’s Windows 2000 Terminal 
Server Edition and Citrix Metaframe server software.

Window
In the X Window System, typically a region on the screen of a display 
created by an X client for displaying data. (An X client can create more than 
one window.) For example, the xterm terminal emulator, xfd font displayer, 
and the bitmap graphics editor all create windows. You can use a window 
manager to manipulate windows on the screen. See Window Manager.

Window Manager
An X client that allows you to organize and rearrange windows. The window 
manager controls the size and placement of windows and can also control 
window attributes such as border size.

Xhost
A host X program that controls access to the server from the host program.

X Server
A program that runs locally on a network computer and lets you use the 
screen of the network computer. The X server processes a request (for 
example, a request to create a window), collects input data, and sends 
information (called an event) to clients. See Event.

Xterm
An X client that emulates an ANSI-style terminal for programs that do not 
use the capabilities of windows directly.

X Window System
A set of network protocols developed by MIT for workstations; also called X 
or X11.
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Numerics
16-bit true color support 5-87
24-bit true color support 5-88

A
Active window Gl-1
Adobe Reader

displaying PDF files using the local browser
4-17

Analog video player
about 5-44

Aspect ratio Gl-1
Audio file information 5-24
Audio mixer 5-25

saving level settings 5-27
starting 5-25

Audio player 5-3
audio accessories 5-19–5-20
audio file information 5-24
DAP access 5-14
external devices 5-17
file types 5-3
NFS access 5-12
opening and creating a file 5-9
playing an audio file 5-23
recording an audio file 5-21
starting 5-4
TFTP access 5-10

B
Boot process 2-2
Browser plug-ins 4-4

C
Chroma Gl-1
Client Gl-1
Client Launcher 2-5
Color hardcopy printing 5-62
Color support

16-bit 5-87
24-bit 5-88

Colormap Gl-2
Command-line Gl-2

Communication port, about 1-xi
Compose key on VT200 keyboard A-27
Configuring a kiosk browser 4-12
Console window, about 6-3
Creating an ICA file 4-9
Cterm 2-14, Gl-2

D
DAP Gl-2
Data Access Protocol Gl-2
Diacritical keys on VT200 keyboard A-24
Digital video player

about 5-28
DAP access 5-36
multicast 5-40
NFS access 5-34
opening a video file 5-32
playing a video file 5-38
starting 5-29
TFTP access 5-33

Display monitor, about 1-xi
Displaying windows in foreground 3-11
DP mode keys A-1
Dynamic microphone 5-18

E
Electret condenser microphone 5-18
Embedded plug-in 4-5

F
Features by model chart 5-2
Font caching

about 5-62
French Canadian keyboard A-36

H
Host Connections menu 4-11
HostMenu 2-7

I
ICA broadcast browsing 2-17
ICA file 4-5
ICA plug-in 4-2
Icon

Index
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moving 3-14
restoring 3-13

Iconifying a window 3-13
Internet address Gl-4
Internet protocol Gl-4
IP Gl-4
IP Address Gl-4

K
Key sequences 1-ix
Keyboard

about 1-xi
adjusting 1-xi

Keyboards
compose key A-27
compose sequences A-27
diacritical keys A-24
North American special characters A-8
special characters and symbols A-22

Kiosk browser 4-3
Kiosk mode, forcing 4-16

L
LAN Gl-5
LAT 2-24, Gl-5
LFM 3-18
Line-in jacks for microphones 5-18
Line-in/microphone jack 5-18
Line-out jacks 5-18
Local area network Gl-5
Local area transport Gl-5
Local browser kiosk 4-10
Local client

ssadvt 5-85
Local Floppy Manager 3-18
Locking a display and open windows 3-17
Logging in

Cterm 2-14, 2-16
HostMenu 2-7
LAT 2-24

login prompt 2-10
methods 2-3
root weave 2-4
Serial Port 2-22
Telnet 2-12
WinDD 2-16

Logic board, about 1-xi
Logic module Gl-5
Login prompt 2-10
Lowering a window 3-12

M
Maximizing a window 3-12
Microphone compatibility 5-18
Monitor

about 1-xi
adjusting 1-xi

Mouse operations, about 1-5
Mouse, about 1-xi
Moving

icons 3-14
windows 3-10

MPEG video file format 5-38
Multicast

about 5-40
channels 5-40

N
NCBridge terminal model features chart 5-2
NCD website 5-95
Netscape browser configuration files 4-13
Netscape NC Navigator browser 4-1
Network computer

boot process 2-2
memory 5-62

Network computer software, about 1-xi
Network Computing Devices website 5-95

P
PC99-type microphones 5-18
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PDF files, displaying 4-17
Power switch location 2-1
PPP

about 5-68, 5-77
authentication 5-75
configuing settings 5-72
configuring xp.cnf file for 5-77
connection 5-78, 5-80
devices that support 5-68
terminating 5-84

Printing
color hardcopies 5-62
from MWM pop-up menu item 5-63
from the command line 5-63
hardcopy of a window 5-63
hardcopy of the screen 5-63

R
Raising a window 3-11
Rebooting the network computer 3-3
Related manuals 1-xii
Resetting

network computer 3-3
X server 3-3

Resizing a window 3-10
Restoring a window 3-13
Restoring an icon 3-13
Root Depth 5-87
Root weave 2-4, Gl-7

S
Sample HTML Code 4-8
Sample ICA file 4-6
Screen saver support 5-85
Screen, about 1-xi
Selecting a server

command line selection 2-18
ICA broadcast browsing 2-17
via remote configuration 2-18

Self-biased microphone 5-18

Serial
communications 2-23
parameters 2-23
port session 2-22

Seriald
benefits of 5-94

Setup key 2-4, 2-23, 3-3, 3-7
Setup keys 1-ix
Simultiple Color 5-88
ssadvt local client 5-85
Starting new sessions

from Client Launcher 3-15

T
Telnet 2-12
termcntl client 5-96
TFTP Gl-9
ThinPATH Plus software 5-94
Trivial File Transfer Protocol Gl-9
Troubleshooting

boot problems 6-1
log in problems 6-2
power problems 6-1
remote 6-5

True color support
16-bit 5-87
24-bit 5-88

Typographical conventions 1-ix

U
UNIX browser setup file 4-4

V
VT200 Keyboards

compose sequences A-27
diacritical keys A-24

VT200 keyboards
compose key A-27
special characters and symbols A-22
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W
Web-based administration 6-5
Web-based Administrator dialog 5-93
WinDD Gl-10

about 5-52
configuring 5-57
help menu 5-61
local client 5-52
local client Options menu 5-59
log in 2-16
log in screen 2-20
logoff 2-21
selecting a server 2-17, 5-59
starting with xp.cnf 5-53
starting with xpsh 5-53

WinDD ICA client 4-2, 4-4
WinDD ICA client configuration GUI 4-7
WinDD plug-in 4-3
Window

iconifying 3-13
lowering 3-12
manipulations (actions) 3-9
maximizing 3-12
moving 3-10
raising 3-11
resizing 3-10
restoring 3-13

Window managers 3-5
www.ncd.com 5-95

X
X server 3-2
XDMCP_keepalive 5-95
xpsh command 4-10
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